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This guide explains how to get started with Pix4Dmapper. It shows the needed steps before using Pix4D to obtain good data to achieve the best results, how to
create a project and how to start processing it. It also shows how to get started with advanced features such as using Ground Control Points.

System Requirements
Software Download and Installation
Step 1.Before Starting a Project
1. Designing the Images Acquisition Plan
a. Selecting the Images Acquisition Plan Type
b. Computing the Flight Height for a Given GSD
c. Computing the Image Rate for a Given Frontal Overlap
2. Configuring the Camera Settings
3. Georeferencing the Images (optional but recommended)
4. Getting GCPs in the Field or Through Other Sources (optional)
Step 2.Creating a Project
1. Creating a New Project
2. Importing the Images
3. Configuring the Image Properties
a. Selecting Image Coordinate System (optional)
b. Importing Images Geolocation and Orientation (optional)
c. Editing Camera Model (optional)
Step 3.Quick On-site Rapid Check
Step 4.Analyzing the Rapid Check Quality Report
Step 5.Back in the Office: Before Processing (optional)
1. Selecting the Orthomosaic and/or Point Cloud Densification Area (optional)
2. Changing the Process Options (optional)
3. Adding GCPs (optional)
Step 6. Back in the Office: Full Processing
1. Initial Processing
2. Analyzing the Full Processing Quality Report
3. Point Cloud Densification
4. DSM and Orthomosaic Generation
Step 7.After Processing (optional)

Additionally, there are some recommended articles to consult in order to fulfill some specific actions with the software:

Navigating in the Support Site
Pix4Dmapper Product Editions - Comparison Table
Features Description

News and Updates
System Requirements

Using GCPs
Using the rayCloud
Using the Mosaic Editor
Using the Index Calculator
Using Pix4Dmapper Output Files in Other Software

Processing Large Datasets
Merging Projects
Uploading Project Files into Pix4D Cloud
Input Files
Quality Report Help
Output Files

Project Folder Structure
Pix4Dmapper Processes

Pix4Dmapper's Software Manual describes every feature in detail:

Pix4Dmapper Software Manual
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The following description shows the minimum and recommended Hardware and Software requirements:

Minimum:

Windows 7, 8, Server 2008, Server 2012,64 bits ( PC or Mac computers usingBoot Camp).
Any CPU (Intel i5/i7/Xeon recommended).
Any GPU that is compatible withOpenGL 3.2. (integratedgraphiccards Intel HD 4000 or above).
Small projects (under 100 images at 14 MP): 4 GB RAM, 10 GB HDD Free Space.
Medium projects (between 100 and 500 images at 14 MP): 8 GB RAM, 20 GB HDDFree Space.
Large projects (between 500 and 2000 images at 14 MP): 16 GB RAM, 40 GB HDDFree Space.
Very Large projects (over 2000 images at 14 MP): 16 GB RAM, 80 GB HDDFree Space.

Recommended:

Windows 7, 8 64 bits.
CPUquad-core or hexa-core Intel i7/Xeon.
GeForce GPUcompatible withOpenGL 3.2 and 2 GB RAM.
Hard disk: SSD.
Small projects (under 100 images at 14 MP): 8 GB RAM, 15 GB SSDFree Space.
Medium projects (between 100 and 500 images at 14 MP): 16GB RAM, 30 GB SSDFree Space.
Large projects (over 500 images at 14 MP): 32 GB RAM, 60 GB SSDFree Space.
Very Large projects (over 2000 images at 14 MP): 32 GB RAM, 120 GB SSDFree Space.

Information: 
Pix4Dmapper uses CPU for processing. A local SSD Hard drive can speed up the processing.
The graphic card may havea small improvementon the processing speed for step 1 and step 2 (if the graphic card is compatible with CUDA
(NVIDIAGraphic Cards)) and no influence over the processing speed for step 3, it affects considerably the visualizationof the rayCloud. For more
information about the use of the GPU:203405619.
For more information about Hardware components usage when processing with Pix4Dmapper: 202559519.
For recommendations for a Hardware and Software Configuration: 202559159.
For more information regarding: Mac / Windows XP / Linux / Remote Access - Virtual machine/ Distributed - Parallel processing:202556809.
For more information about the processing speed:204191535.
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Important: Internet connection is required to download and to install the software.

Download the software following:

1. Go to http://pix4d.com/download/
2. Click Download Pix4Dmapper Discovery.

 

Once the software has been downloaded, install it using the following steps:

1. Double click on the downloaded file. The Pix4Dmapper Setup wizard starts.
2. (optional): If the Open file - Security Warning pop-up appears, click Run.

 

3. On the Pix4Dmapper Setup pop-up, in the Welcome to the Pix4Dmapper Setup Wizard screen, click Next >.

 

4. Read the End-User License Agreement, select "I accept the terms in the License Agreement" and click Next >.

 

http://pix4d.com/download/


 

5. (Optional) Click Browse... to change the destination path for the installation.
6. Click Next >.

 

7. Click Install.



 

8. (optional) On the software information window: "Do you want to allow the following program to install software on this computer?", Click Yes.
9. Click Finish .

 

10. A shortcut is created on your desktop and the software opens automatically once the installation is completed.

11. The first time you open the software, the Pix4Dmapper Login window appears:

(If a proxy server is used to connect to internet, click Proxy... and follow these instructions: 202560089)

https://support.pix4d.com/hc/en-us/articles/202560089


  

12. If you already have an account, type your email and password and click Log In.

 

If you do not have an account:

1. Click Create New Account.
2. Complete the online form.
3. You will receive by email a confirmation email to activate the account, open the email and click Confirm my email.
4. Go back to the Pix4Dmapper Login window, type your email and password and click Log In.

 

Pix4Dmapper opens and you are now ready to start using the software!
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Warning: A dataset of insufficient quality will lead to poor results or may even lead to processing failure. This requires taking a new dataset in the field.

The dataset (compulsory: images, optional but recommended: images geolocation and GCPs "Ground Control Points") have to be obtained in the field before
using Pix4Dmapper. A good dataset is required in order to automatically produce results with high quality and accuracy. In order to take a good dataset, follow
the steps below:

1. Designing the Images Acquisition Plan: It is very important to design a good images acquisition plan considering:

Type of project (aerial, terrestrial, mixed).
Type of terrain / object.
Type of camera used.
Purpose of the project.
How often the images are taken.
At which distance and with which angle take the images.
Path(s) to follow to take the images.
etc.

For aerial projects, this also implies:

Selecting corridor path or regular grid and/or oblique grid.
If also terrestrial images will be used.
If more than one flight is needed to cover the full area: designing the area to cover with each flight.

2. Configuring the Camera Settings: The camera settings of the camera used to acquire the images need to be configured. Wrong configuration can produce
images with blur, noise, distortions, etc.

3. Georeferencing the Images (optional but recommended): The images can be georeferenced using a camera with built-in GPS or using external GPS
devices.

4. Getting GCPs in the Field or Through Other Sources (optional but recommended): Using GCPs (Ground Control Points) requires planning how many
GCPs have to be acquired, as well as where and how they have to be measured.
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In order to automatically get high accuracy results, a high overlap between the images is required. Therefore the images acquisition plan has to be carefully
designed in order to have enough overlap and the images acquisition plan depends on the GSD required by the project specifications and the terrain type / object
to be reconstructed. A bad images acquisition plan will lead to inaccurate results or processing failure, and will require to acquire images again.

When designing an images acquisition plan the following factors need to be taken into consideration:

Images acquisition plan type: The images acquisition plan type depends on the type of terrain / object to be reconstructed.
Ground Sampling Distance (GSD): The GSD defined by the project specifications will define the altitude at which the images have to be taken.
Overlap: The overlap will depend on the type of terrain that is mapped and will determine the rate at which the images have to be taken.

Nowadays, technologically advanced UAVs come with very good software that can design the images acquisition plan given some parameters (area of interest,
the percentage of overlap between the images, the desired GSD, etc). In this case, the images are taken automatically by the UAV according to the
selected images acquisition plan without any user intervention.

Important: Pix4Dmapper allows the user to run the Rapid Check processing while being in the field. This Rapid Check processing can be used as an
indicator of how good the dataset is.

If the Rapid Check processing does not yield to good results, then it means that the dataset is not adequate and that it is necessary to acquire images
again. In some cases, the Rapid Check may fail but the Full Processing works,  this usually indicates that the dataset is not optimal.

For more information about the differences between Rapid Check and Full Processing: 202558949.

The design of the images acquisition plan consists of 3 steps:

a. Selecting the Images Acquisition Plan Type
b. Computing the Flight Height for a Given GSD
c. Computing the Image Rate for a Given Frontal Overlap
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Pix4Dmapper is an image processing software that is based on automatically finding thousands ofcommon points between images. Each characteristic point
found in an image is called akeypoint.When two keypointson two different images are found to be the same, they arematched keypoints. Each group of
correctlymatched keypoints will generate one 3D point. When there is high overlap between two images, the common area captured is larger and more keypoints
can be matched together. The more keypoints there are, the more accurately 3D points can be computed. Thus the main rule is to maintain high overlap between
the images.

As the images acquisition plan has a high impact on the quality of the results, it is important to design it carefully.

Note:Pix4Dmapper allows the user to run theRapid Checkprocessing while being in the field. ThisRapid Checkprocessing can be used as an indicator of
how good the dataset is.

If theRapid Checkprocessing does not yield to good results, then it means that the dataset is not adequate and that it is necessary to acquire images
again. In some cases, the Rapid Check may fail but the Full Processing works, this usually indicates that the dataset is not optimal.

For more information about the differences between Rapid Check and Full Processing: 202558949.

Ideal images acquisition plan

The ideal images acquisition plan depends on the type of terrain / object to be reconstructed.:

General case: For projects that do not includeforests, snow, lakes, agricultural fields and/or other terrain that is difficult to reconstruct.
Forestand dense vegetation: For project with areas covered by forest or dense vegetation.
Flat terrain with agriculture fields:For flat terrain with homogeneous visual content such as agriculture fields.
Building reconstruction: For 3D modelling of buildings.
Special cases: For snow, sand, and water surfaces (oceans, lakes, rivers, etc).
Corridor mapping: For projects with lineararea of interest (roads, rivers, etc).
Multiple flights: For projects with images taken using multiple flights.
City reconstruction (visible facades): For 3D modelling of urban areas.
3D interior reconstruction: For any object or objects as urban areas, buildings, constructions, structures, etc.
Mixed reconstruction: For interior and/or exterior and/or aerial reconstruction.
Large Vertical Objects recontsruction: For 3D modelling of objects like power towers, wind turbines, etc.
Tunnel reconstruction: For 3D modelling of a tunnel.

Important:Below it is described the recommended different images acquisition paths and overlap for different cases, despite it may work with lower
overlap than the suggested ones, in order to obtain the best possible results, it is suggested to use the recommended overlaps.

General case

The recommended overlap for most cases is at least 75% frontal overlap (with respect to the flight direction) and at least 60% side overlap (between flying tracks).
It is recommended to take the images with a regular grid pattern (Figure 1). The camera should be maintained as much possible at a constant height over the
terrain / object to ensure the desired GSD.

Figure 1. Ideal Images Acquisition Plan - General case.

Forestanddense vegetation

Trees and dense vegetation often have a very different appearance between overlapping images due to their complex geometry (thousands of branches and
leaves). Therefore it is difficult to extract common characteristic points between the images. In order to achieve good results, it is recommended to use a grid
images acquisition plan as the one described in the General Casesection by applying the following changes:

https://support.pix4d.com/hc/en-us/articles/202558949


Increase the overlapbetween images to at least 85% frontal overlap and at least 70% side overlap.
Increase the flight height: At higher altitude, there is less perspective distortion (therefore causing less appearance problems) and the dense vegetation has
better visual properties. In other words, it is easier to detect visual similarities between overlapping images in such areas. The flight height in combination
with the image pixel resolution and the focal length determine the Ground Sampling Distance (spatial resolution) of the images.Best results are obtained with
aGSD higher than10cm/pixel.

For more information about how to improve the results of dense vegetation areas choosing the correct processing options:202560159.

Flat terrain with agriculture fields

In cases where the terrain is flat with homogeneous visual content such as agriculture fields, it is difficult to extract common characteristic points between the
images. In order to achieve good results, it is recommended to use a grid images acquisition plan as the one described in theGeneral Casesection by applying
the following changes:

Increase the overlapbetween imagesto at least 85% frontal overlap and at least 70% side overlap.
Fly lowerto improve the results as this increases the visual content.
Haveaccurateimage geolocation and set the project type to Alternative processing mode.For more information about theAlternative processing mode: 202557759.

Building reconstruction

Reconstructing 3D buildings requires a specific images acquisition plan (Figure 2):

Fly around the building a first time with a45 camera angle.
Fly a second and third time around the building increasingthe flightheightand decreasing thecamera angle with each round.

Note:For more information about oblique imagery: 202559859.

It is recommended to take one image every 5-10 degreesto ensure enough overlap, depending the size of the object and distance to it. Shorter distance and
larger objects require images every less degrees.

Note:
The flight height should not be increased more than two times between the flights, as different heights lead to different spatial resolution. For
moreinformation:202558979.
Pix4Dmapper generates a very good point cloud for oblique images of buildings. However for oblique images no orthomosaic is generated.

Important:Currently, Pix4Dmapper only generates orthomosaics that are parallel to the (X,Y) plane. Therefore, to generate mosaics of facades, some
workaround needs to be applied. For more information: 202559889.

Figure 2. Ideal Images Acquisition Plan - Building.

Note:It is possible to combine aerial nadir and/or aerial oblique (with angle between 45 and 80) and/or terrestrial images, any 2 or 3 out of the 3
mentioned types.

Each set of images should have enough overlap themselves and between sets, for such cases it is strongly recommended to use GCPs or Manual Tie
Points to properly adjust the different sets of images.

Special cases

This section presents some hints for terrain that is difficult to map such as terrains with snow, sand, lakes, etc.

Snow and sand
Snow and sand have little visual content due to large uniform areas. Therefore:

Use ahigh overlap: At least85%frontal overlap and at least 70%side overlap.
Set theexposure settingsaccordingly to get as muchcontrastas possible in each image.
Water

https://support.pix4d.com/hc/en-us/articles/202560159
https://support.pix4d.com/hc/en-us/articles/202559859
https://support.pix4d.com/hc/en-us/articles/202558979
https://support.pix4d.com/hc/en-us/articles/202559889


Water surfaces have almost no visual content due to large uniform areas. Sun reflection on the water and waves cannot be used for visual matching.

Oceansare impossible to reconstruct.
To reconstruct other water surfaces such asriversorlakes, each image needs to have land features. Flying higher may help to include more land features.

Corridor mapping

Mapping corridors such as railways, roads or rivers requires at least two flight lines (Figure 3).GCPsare not required, but arerecommendedto improve the
georeference and completeness of the reconstruction. For more information about number and distribution of GCPs in corridor mapping:202559299.

For a dual track it is recommended to use at least 85% frontal overlap and at least 60% side overlap.

It is possible to use nadir images or oblique images (with an angle between 0 and 45 pointing in both tracks to the center of the corridor). For flat terrain it is
recommended to use nadir images.

Figure 3. Dual track images acquisition plan for corridor mapping.

If a dual track images acquisition plan is not possible, then a single track images acquisition plan can be used if (Figure 4):

Overlap is high enough: At least85%frontal overlap.
Ground control points (GCPs) are defined along the flight line in zig zag.

Figure 4. Single track flight NOT RECOMMENDED.

Multiple flights

Pix4Dmapper can process images taken from multiple flights. When designing the different images acquisition plans, make sure that:

Each plan captures the images with enough overlap.
There is enough overlap between two images acquisition plans (Figures 5 and 6).
The different plans are taken as much as possible under the same conditions (sun direction, weather conditions, no new buildings, etc.).

Important: The flight height should not be too different between the flights, as different height leads to different spatial resolution. For more information:
202558979.

There is a special way to process datasets with multiple flight, for step by step instructions: 202558579.

Enough overlap between two flights Not enough overlap between two flights
Figure 5. Overlap between two flights.

https://support.pix4d.com/hc/en-us/articles/202559299
https://support.pix4d.com/hc/en-us/articles/202558979
https://support.pix4d.com/hc/en-us/articles/202558579


Figure 6. Recommended images acquisition plan for two flights.

City reconstruction (visible facades)

The 3D reconstruction of urban areas requires a double grid images acquisition plan, so that all the facades of the buildings (north,west,south,east) are visible on
the images.The overlap should be the same as in theGeneral Case.

Figure 7. Double grid images acquisition plan.

For the facades to be visible, the UAV/plane should fly with an angle (oblique imagery with angle between 10 and 35, for more information about the definition of
the angles:202559859) and not pointing to the nadir. If much detail is needed, then aerial and terrestrial images should be combined.

Note: It is possible to combine aerial nadir and/or aerial oblique (with angle between 10 and35, for more information about the definition of the
angles:202559859) and/or terrestrial images, any 2 or 3 out of the 3 metioned types.

Each set of images should have enought overlap themselves and between sets, for such cases it is strongly recommended to use GCPs or Manual Tie
Points to properly adjust the different sets of images.

3D Interior reconstruction

For interior reconstruction terrestrial images are used, it is needed 90% overlap, and recommended to have continuously overlap between images without any gap
and the use of fish eye cameras.

It is strongly recommended to use Manual Tie Points to properly adjust the model.

Mixed reconstruction

It is possible to combine aerial nadir and/or aerial oblique (with angle between 45 and 80) and/or exterior terrestrial images and/or interior terrestrial images, any 2,
3 or 4 out of the 4 mentioned types.

Each set of images should have enough overlap themselves and between sets, for such cases it is strongly recommended to use GCPs or Manual Tie Points to
properly adjust the different sets of images.

Large Vertical Objects reconstruction

The 3D reconstruction of objects like power towers, wind turbines etc requiresa specific images acquisition plan (figure 8):

https://support.pix4d.com/hc/en-us/articles/202559859
https://support.pix4d.com/hc/en-us/articles/202559859


Fly close to the structure.
Turn several times around the structureat several heights.
Images should be taken with high overlap: 90% of overlap between images taken at the same height and 60% of overlap between images taken at different
heights.
The optimal camera angle is 45 degrees. By pointing to the ground, the content of the images is easier to be matched andthe results are better.
The images shouldbe as focused as possible (both the main object and the background should be focused).
Having imagegeolocation is recommended. For more information about the image geolocation:202557499.

Power Tower Power Tower reconstructed in the rayCloud
Figure 8. Images Acquisition Plan - Power tower.

Example: Mapping and Inspecting a Power tower:Watch Video 

Tunnel reconstruction

Pix4Dmapper can reconstruct a tunnel. The biggest challenge for tunnel reconstructionis the lightening conditions. If the lightening is good either with natural light
(if the tunnel is not too long) or with technical light, then the reconstruction will be very good.

In case of very dark tunnels, a tripod is recommended.

Tip:It is recommended to: 
Use fisheye lens camera.
To shoot in more than one lines (avoid single track shooting).If a multipletrack images acquisition plan is not possible, then a single track could work but
GCPs are highly recommended in this case.

Figure 9. Automatic Tie Points of a tunnel.
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Tools: GSD Calculator available on: 202560249.

The Ground Sampling Distance (GSD. for more information: 202559809) defines the accuracy and quality of the final results as well as the details that are visible
in the final orthomosaic. 

 

The flight height H to obtain a given GSD depends on the camera focal length, camera sensor width (mm), and the image width (pixels).

Sw = real sensor width [mm]

FR = real focal length [mm]

H = flight height [m]

Dw = distance covered on the ground by one image in the width direction (footprint width) [m]

 

Most lens manufacturers give the focal length (F35) in a 35 mm equivalent. In order to find the real focal length FR:

FR [mm] = (F35 * SW) / 34.6     (1)

Where

F35 = focal length that corresponds to the 35 mm equivalent

FR = real focal length

Sw = the real sensor width

The flight height H is given by:

H / FR = DW / SW 

H = (DW * FR) / SW      (2)

The distance covered on the ground by one image in the width direction (footprint width) is given by the desired GSD and image width in pixels:

DW = (imW * GSD) / 100     (3)

Where: 

DW = distance covered on the ground by one image [m] in the width direction (footprint width)

imW = image width [pixel]

GSD = desired GSD [cm/pixel]

Combining equation (2) and (3), the flight height is given by:

H [m] = (imW * GSD * FR) / (SW * 100)     (4)

Note: The result is given in [m], considering that the GSD is in [cm/pixel].

Example: Computing the flight height to get a GSD of 5 [cm/pixel] using a camera with a real focal length of 5 [mm] and a real sensor width of 6.17
[mm]. The image width is 4000 [pixels]. Using equation (4) the flight height should be 162 [m].

H = (imW * GSD*  FR ) / (Sw * 100) = (4000 * 5 * 5) / (6.17 * 100) = 162.07 [m]
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The image shooting rate to get a given frontal overlap depends on the speed of the uav/plane, the GSD and the camera used (pixel resolution).

D = distance covered on the ground by one image in the flight direction [m]

overlap = percentage of desired frontal overlap between two images

od = overlapped distance between two images in the flight direction [m]

x = distance between two camera positions in the flight direction [m]  

v = flight speed [m/s]

t = elapsed time between two images (image rate) [s]

Figure 1.

From Figure 1, we can retrieve the following equations:

od = overlap * D      (1)

x = D - od                  (2)

t = x / v                      (3)

 

Two cases are possible:

Camera oriented with the sensor width (long dimension) perpendicular to the flight direction (usual case)
Camera oriented with the sensor width (long dimension) parallel to the flight direction

Camera oriented with the sensor width (long dimension) perpendicular to the flight direction (usual case)

D = Dh = (imH * GSD) / 100     (4)

Where: 

Dh = distance covered on the ground by one image in the height direction
(footprint height) [m]

imH = image height [pixel]

GSD = desired GSD [cm/pixel]

 

Note: The result is given in [m], considering that the GSD is in
[cm/pixel].

Combining equations (1) and (4) into the equation (2):

x = Dh - overlap * Dh

x = Dh * (1 - overlap)

x =  ((imH* GSD) / 100) * (1 - overlap)     (5)

Combining equations (3) and (5):

t = x / v = ((imH * GSD) / 100) * (1 - overlap) / v     (6)

 
Figure 2. Sensor width placed perpendicular to the flight direction.

Example: Computing the time between two images to get an overlap of 75% (overlap = 0.75) and a GSD of 5 [cm/pixel]. The image height is 4000
[pixels]. The speed of the uav/plane is 30 [km/h] = 8.33 [m/s]. Using equation (6), an image should be taken every 6 seconds.

t = ((imH * GSD) / 100) * (1 - overlap) / v = ((4000 * 5 ) / 100)  * (1 - 0.75) / 8.33 = 6 [s] 

 

Camera oriented with the sensor width (long dimension) parallel to the flight direction

If the camera is placed on the plane / UAV having the sensor width (long dimension) parallel to the flight direction:

 

 



D = DW = (imW * GSD) / 100     (7)

Where: 

DW = distance covered on the ground by one image in the width direction
(footprint width) [m]

imW = image width [pixel]

GSD = desired GSD [cm/pixel]

Note: The result is given in [m], considering that the GSD is in
[cm/pixel].

Combining equations (1) and (7) into the equation (2):

x = DW - overlap * DW

x = DW * (1 - overlap)

x =  ((imW * GSD) / 100) * (1 - overlap)     (8)

Combining equations (3) and (8):

t = x / v = ((imW * GSD) / 100) * (1 - overlap) / v     (9)
Figure 3. Sensor width placed parallel to the flight direction.
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Pix4Dmapper is able to process images taken from any camera:

Lightweight compact cameras
DSLR cameras
Large format cameras
Camera Rig

And using lens:

Perspective
Fisheye

The cameras can be loaded on any platform:

UAVs from the hobby world
Professional UAVs
Manned Aircrafts
Helicopters
Terrestrial vehicles
No platform, for terrestrial imagery (taken by hand)

Pix4Dmapper can process any images regardless of the spectral specifications of the camera:

RGB
NIR cameras
IR cameras
Thermal cameras, etc

Summary

Camera body and lens
Perspective and fisheye lens supported.
Dont change the zoom during shooting.
Fixed focal length improves the results.
Video camera not optimal due to rolling shutter effect and low resolution.

Camera settings
Stabilization settings should be off.
Shutter/aperture/ISO should be on automatic.
If images are blurry or noisy, manually set shutter/aperture/ISO

Camera Body

As a rule of thumb: Heavier cameras provide better results but require a flying platform with a higher payload.

Recommended Cameras

Camera Type Recommendation Tips
Compact Canon IXUS 220HS (135 g)

Sony RX 100 (240 g)
Leave parameters on Automatic (as the dynamic range is often limited on these cameras) and disable
image stabilization.

DSLR Sony Nex 5/7 (270 g - 350 g) Canon
5D mark ii (>800 g)

Use a fixed focal length lens to improve the results.

Video cameras are not recommended

Due to the large rolling shutter effect.Rolling shutterintroduces visual artifacts that are not totally compatible with Pix4Dmapper algorithms. Depending on the
speed of the rolling shutter and the movement of the camera, the images may not calibrate and will therefore not be used in processing. Cameras that do not have
a mechanical shutter may work but are notrecommended for accurate mapping.
They provide low resolution images and therefore low quality results or problems calibrating the images due to a low amount of keypoints found.

RecommendedCamera Focal Length

There is no limit in the focal length that can be used with Pix4Dmapper.

Applicationxxx Recommendation Why
Mapping: aerial project with a flight
height above 50 meters.

Perspective lens: between 22 mm and 80 mm focal length (in
35 mm equivalent).A standard 35mm sensor is 36mm wide by
24mm tall.

To ensure a good GSD that will lead to higher accuracy
results.

Indoor / close range reconstruction. Fisheye lens: very smallfocal length. Flexibility in data acquisition: Ensuring higher overlap.

Most lens manufacturers give the focal length (F35) that corresponds to 35 mmequivalent. In order to find the real focal length:



FR =(F35 * SwR) / 34.6 (mm)

where:

F35= focal lengththat corresponds to 35 mmequivalent
FR =real focal length
SwR = the real sensor width

For a given height, the wider the field of view (small focal length), the larger the GSD will be, and less images will beneeded to achieve sufficient overlap. This is
especially useful if a regular and dense flight plan cannot be setup. The GSD value, though, will be smaller leadingto less accurate results.

If the field of view is narrow (large focal length), more images will be required to ensure enough overlap when mapping the same area.The GSD value will be higher
in this case leading to moreaccurate results.

For more information about how to select camera focal length and flight altitude considering the desired Ground Sampling Distance and the terrain to
map:202558849.

Tip: Use a fixed focal length lens as it will usually result in sharper images with reduced noise.

Camera Settings

There is a tradeoff between the shutter-speed, the aperture, and the ISO sensibility. For processing, the images should be sharp and have the least amount of
noise. Such images can be obtained when the scene is well illuminated (scattered clouds should be avoided) and the parameters of the camera are well adjusted.
If the scene is not sufficiently illuminated, images will be more noisy and less sharp, thus lowering the accuracy of the results.

As a rule of thumb, the shutter speed should be fixed, the ISO needs to be set at a low value that does not produce noisy images, and the aperture should be set
to adjust for varying levels of brightness in the scene. If the tradeoff is not correct you may also obtain overexposed or underexposed images.

The shutter speed should be fixed and set to a medium speed (as an indication: between 1/300 second and 1/800 second), but fast enough so as to not produce
blurry images. If more than 5% of the images are subject to a directional blur, it is a good indication that the shutter speed should be slightly increased.

The ISO sensibility parameter should be set as low as possible (minimum 100). High ISO settings generally introduce noise into images and drastically reduce
the quality of processed results.

The aperture minimum and maximum values depend on the lens. High aperture is translated into low numbers, like for example f2.7 (which will capture a lot of
light). However, if you adjust both the shutter speed and ISO sensibility, it is best to leave the Aperture (f) settings of your camera on Automatic as it will then
adjust automatically to the highest aperture possible.

The electronic and mechanical stabilization should be disabled as it interferes with the algorithms.

Problems with images due to wrong parameters or inadequate equipment that interfere with the processing:

Blur due to slow shutter speed. Noise due to high ISO sensitivity. Overexposed
or
underexposed
due to low
dynamic
range.

Distortions
due
toelectronic
or
mechanical
image
stabilization.

Distortions
due to
rolling
shutter.
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>> Skip this step if no Georeferencing will be used for the images <<

Pix4Dmapper can process both images with and without geolocation. However, it is strongly recommended to know the position of the camera for at least 50% of
the images to get high quality and faster results. Pix4Dmapper does not require the IMU parameters (craft's velocity, orientation, and gravitational
forces). Orientation parameters are computed during the processing. IMU values are only used as information in the quality report to indicate the accuracy of the
input values and the optimized obtained values.

Warning: If less than 3 images are geolocated, lower precision results are expected.

Images without geolocation
Images with known position using a camera with built-in GPS tagging
Images with known position using an external GPS logger

 

Images without geolocation

Warning: When processing images with no geolocation, if no Ground Control Points are used, the final results have no scale, orientation and absolute
position information. Therefore they cannot be used for measurements, overlay and comparison with previous results. Besides, they may produce
an inverted 3D model in the rayCloud.

 

Images with known position using a camera with built-in GPS tagging

Most of the major manufacturers push their weight behind GPS tagging; Panasonic, Sony, and Canon are some well known camera manufacturers that have
released such cameras so far. Most of these cameras save the GPS coordinates in the images' EXIF data. Pix4Dmapper reads this information from the EXIF
data in order to automatically import the image geolocation into the software.

Warning: If the GPS refresh rate is lower than the shooting images rate, more than one image will have the same GPS position and the processing may
fail or may not calibrate correctly some of the images. Cameras with GPS will work if they have a very good GPS refresh rate.

 

Images with known position using an external GPS logger

GPS loggers are very light devices (easily placed on a UAV) that can collect position information for the images. They register latitude, longitude and altitude
values for each camera position while shooting. These values are saved to a file that can be imported directly into Pix4Dmapper if it has the correct file format.
Otherwise, the file requires some editing before being imported in order to comply with Pix4Dmapper's geolocation file format.

Figure 1. GPS logger

 

GPS Logger recommended

RTK GPS can capture accuracy of 2-4 cm and a very hight refresh rate, then no GCPs would be needed to obtain a great accuracy. For more information: RTK
GPS.

Information: Some loggers come with image geotagging software. If not, GPS data and images can be synchronized by using other software such as:
GPicSync (free)
Geosetter (free) 
RoboGeo (commercial) 

A list of available loggers is maintained by OpenStreetMap.

For more information about geolocation file formats supported by Pix4Dmapper 202558539.

For more information about how the onboard GPS affects the accuracy of a project: 202558909.

 

 

 

 

http://swiftnav.com/piksi.html
https://code.google.com/p/gpicsync/
https://code.google.com/p/gpicsync/
http://www.geosetter.de/en/
http://www.geosetter.de/en/
http://www.robogeo.com/home/
http://wiki.openstreetmap.org/wiki/GPS_Reviews
https://support.pix4d.com/hc/en-us/articles/202558539
https://support.pix4d.com/hc/en-us/articles/202558909
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>> Skip this step if no GCPs will be added <<

Warning: Using GCPs is HIGHLY RECOMMENDED when processing images with no geolocation.

If no Ground Control Points are used:

The final results have no scale, orientation, and absolute position information. Therefore they cannot be used for measurements, overlay, and comparison
with previous results.
They may produce an inverted 3D model in the rayCloud. 
The 3D reconstruction may not preserve the shape of the surveyed area. For more information: 202561199.

Ground Control Points (GCPs) are points from the area of interest with known coordinates. Their coordinates have been measured with traditional surveying
methods or have been obtained by other sources (LiDAR, older maps of the area, Web Map Service). They are not required for processing a project with
Pix4Dmapper, but they significantly increase the absolute accuracy of the project. GCPs can also be used as Check points to verify the accuracy of the results.
They can be used: 

In projects with geolocated images: GCPs increase the absolute accuracy of a project, placing the model at the exact position on the earth. They reduce the shift
due to GPS from meters to centimeters. For more information about the shift due to GPS: 202558909.
In projects with no geolocated images: GCPs are required if there is need for georeferenced outputs. In this case, the GCPs will give the scale, orientation and
position to the final results. Additionally, they are very useful for increasing the relative accuracy of the outputs, i.e. the reconstructed 3D model.

When using GCPs you need to take into consideration the following points:

Number and distribution of GCPs
GCP acquisition

 

Number and distribution of GCPs

The GCPs should be placed homogeneously in the area of interest. Imagine the area as a large table and the GCPs as the legs that will support it. If all the "legs"
are placed at the same location of the "table," then it will tilt. If the legs are homogeneously spread, then the "table" will be stable. Additionally, it is also
recommended to place one GCP in the center of the area in order to further increase the quality of the reconstruction (figure 1).

Important:
A minimum of 3 GCPs are required in order to take them into account in the reconstruction, and they should be clicked in at least 2 images each.
A minimum of 5 GCPs is recommended. 5 to 10 GCPs are usually enough, even for large projects. More GCPs do not contribute significantly to an
increase in accuracy.
We recommend to use at least 5 GCPs which are each identified in 5 images, as it minimizes the measurements inaccuracies and helps to detect
mistakes that may occur when inserting the GCPs.
In general 5 - 10 GCPs are usually enough, even for big projects. More GCPs do not contribute significantly the increase of the accuracy. In cases that
the topography of the area is steep and changes a lot, then more GCPs will, indeed, lead to better (more accurate) reconstruction.
The GCPs should be placed evenly on the landscape to minimize the error in Scale and Orientation.
Do not place the GCPs exactly at the edges of the area, as they will only be visible in few images.
The error around the GCPs is between 1 to 3 times the GSD resolution. If your project has a GSD of 5cm/pixel, the error will be between 5cm to 15cm at
most.
For corridors mapping: 202559299.

Figure 1. Distribution of the GCPs.

 

 

https://support.pix4d.com/hc/en-us/articles/202561199
https://support.pix4d.com/hc/en-us/articles/202558909
https://support.pix4d.com/hc/en-us/articles/202559299


 

GCP acquisition

The Ground Control Points can be: 

GCPs measured in the field
GCPs defined from other sources

GCPs measured in the field
Measuring GCPs in the field requires spending some time in the area and locating the position where the GCPs should be measured. This process requires the
terrain to be accessible. Before measuring the GCPs coordinates, the following items must be defined:
GCPs coordinate system
GCPs accuracy
Topographic equipment

GCPs coordinate system

A coordinate system is a set of numbers and parameters that is used in order to define the position of any object in the 2D or 3D space. The chosen GCPs
coordinate system depends on the needs of the end-user. Usually the coordinate systems can be:

Global coordinate systems: They are defined using 3D ellipsoid coordinates (latitude,longitude,altitude).
National coordinate systems: They are usually defined using a projection defined for a specific country (X,Y,altitude).
Local coordinate systems: They are defined using a projection. The user sets the origin and orientation where it is most convenient for him (X,Y,altitude).

Note: The altitude can be either geometric (using as reference the level of the ellipsoid) or orthometric (using as reference level the Mean Sea Level).

GCPs accuracy

In order to define the accuracy with which the GCPs have to be measured, the following factors must be taken into account:

Accuracy needed for the final results: The accuracy of the GCPs should correspond to the final absolute accuracy the user needs. For example for projects
for which an accuracy of some meters is acceptable (e.g. fast assessment tasks), then the accuracy of the GCPs is NOT required to be of some centimeters.
For projects for which the accuracy is very important (e.g. construction sites) then the GCPs should be measured with an accuracy of some centimeters in order
to comply with the project requirements. In general, the accuracy of the GCPs should be slightly better than the expected accuracy of the final results.
Ground Sampling Distance of the images: The GCPs should:
Be visible in the images. The GCP photogrammetric target (figure 2) should have about five to ten times the dimensions of the GSD. If the GCP is natural (a
characteristic point in the area that is not signed by a photogrammetric target), then the GCP can be even more difficult to identify and mark.

Figure 2. GCP photogrammetric target.

Not be more accurate than 1/10 of the GSD. If for example, the GSD is 10 cm, the GCP accuracy should not be below 1 cm, as they cannot be marked in the
images with such accuracy.

Important: The accuracy of the GCPs must be known in order to correctly set the GCP accuracy (Horizontal and Vertical). For more information about
the GCP accuracy: 202557919.

 

Topographic equipment

Total station accuracy: They can reach millimeters accuracy (depending on the distance of the measured points from the station).
GPS system accuracy: They can reach several centimeters accuracy (depending on the equipment, the area, and the country).

GCPs defined from other sources
If no GCPs have been measured in the field, they can be taken from other sources. The advantage of such GCPs is that they can be taken at any time while
being at the office. The disadvantage is that they give no control over the accuracy and that the coordinate system is the coordinate system of the GCP source.

GCPs can be taken from 2 type of sources:

GCPs taken from high accuracy sources: GCPs can be extracted from sources such as existing maps and laser scanning outputs of the same area. If these
sources are updated, then the GCPs can be very accurate. The coordinate system and the accuracy of these points depend on the source.
GCPs taken from Web Map Services: Web Map Services provide online georeferenced maps using a standard protocol called Web Map Service (WMS). Some
servers have their GIS databases publicly available and free of charge, whereas the databases from other servers are not free of charge. Well-known free WMS
servers are Google Maps and Bing Maps. They cover the whole planet but the accuracy of the map georeference may not be high enough. In addition, their data
is not available with the same accuracy for different parts of the world. It is recommend to use GCPs derived from such sources when:
The images are not geolocated and therefore the project has no georeference.
The desired output is a very good .kml file, which can align perfectly with Google Maps.

For more information about how to obtain the georeference using 2D or 3D GCPs taken from a Web Map Service server: 202560149.
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Creating a project requires following these steps:

1. Creating a New Project.
2. Importing the Images.
3. Configuring the Image Properties:

If the images have geolocation information:
Selecting/importing the coordinate system and the images geolocation information.
If the software cannot recognize the camera model or there is a need to use different calibration parameters by editing the camera model.

 

Index  Previous  |  Next  



Index > Step 2. Creating a Project  Previous  |  Next  

 

To create a new project:

1. Start Pix4Dmapper.
2. On the Menu bar, click Project > New Project... .

 

3. The New Project wizard opens.

 

4. In Name: Type a name for the project.

Warning: Ensure that:
The project name DOES NOT use special character(s).
The path where the project will be created DOES NOT use special character(s).
Project name and path together contain less than 128 characters.

 



 

5. (Optional) In Create in: Click Browse, and on the Select project location pop-up, navigate to the folder where the project and results will be stored and
click Select Folder.

Note: When the wizard is complete a folder with the project name typed in the Name field will be created within the selected folder and will store all
the results.

6. (Optional) Activate the check box Use As Default Project Location to save all new projects in the selected folder.

7. In Project type, ensure that Standard Project is selected.

Note: The option Project Merged from Existing Projects is used when a project is created by merging existing projects.

8. In Images, select the type of images:

Aerial Nadir (default): Recommended for images taken from the air and with the camera pointing to the nadir direction. Allows to generate Point Cloud, DSM, and
Orthomosaic.
Images with Low or Complex Texture and Very Accurate Geolocation (Alternative Processing Mode): Recommended for projects where the ground appears flat
and contains repetitive structures (crop fields, forests). Good image geolocation is required and the camera should point to the nadir direction.
Aerial Oblique or Terrestrial:  Recommended for oblique images taken from the air, as well as for images (oblique or nadir) taken from the ground. Allows to
generate the Point Cloud only.

Important: When the Aerial Oblique or Terrestrial type is selected, only the point cloud is generated (i.e. neither the DSM nor the orthomosaic are
generated).

For more information about the Images types: 202557759.

9. Click Next.
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On the Select Images window:

1. Click Add Images... to add the images.

Warning:
Images should not contain any symbols such as time and date stamps. Images that contain such symbols cannot be processed.
Images should not be edited manually, i.e. do not scale, rotate, etc. the images.
Do not use images taken during take-off or landing.

 

2. On the Select Images pop-up, navigate to select the folder where the images are stored, select the images to import (it is possible to select multiple
images), and click Open.

Note:
Images can be imported as *.jpg, *.jpeg, *.tif, or *.tiff. By default all supported image formats can be selected. To filter images according to their
format change the input format to JPEG images (*.jpg,*.jpeg) or to TIFF images (*.tif, *.tiff).
It is possible to select images stored in different folders. Once images are imported from one folder, click Add images again to add more images
from another folder.
The software consider the Date Taken field of the Exif to set up the order in which the images are taken.

 

4. (Optional) It is possible to remove images by selecting them on the images list (use Ctrl+click or Shift+click for multiple selection) and clicking Remove
Selected.
5. (Optional) It is possible to clear the list of images that have been added by clicking Clear List.
6. Click Next.
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The New Project wizard displays the Image Properties window which contains 4 sections:

Image Coordinate System: Selects thecoordinatesystem on which the images' geolocation is based.
Geolocationand Orientation: Imports/exports thecoordinates and, optionally, the orientation of the images and/or the accuracy of the coordinates.
Selected Camera Model: Selects the camera model of the images.
Images table: Displays the selected images, as well as each image's group,position, position accuracy, orientation, and if the image is enabled or not (an enabled
image will be taken into account for processing).

There are 3optional steps to follow before clicking Next:

a.(optional) Selecting Image Coordinate System

On Image Coordinate System, click Edit... if the images' geolocation is given in another coordinate system than WGS84 (default).

Formoreinformationand step by step instructions about how to select/change the Image Coordinate System:202560029.

b.(optional, recommended) Importing Images Geolocation and Orientation

Imports theGeolocation and Orientation of the images. If the geolocation (position) information is stored in the images' EXIF data, it will be automatically
loaded.

Formoreinformationand step by step instructions about how to select/change the ImageGeolocation and Orientation:202560019.

Note:
The software consider theDate Takenfield of the Exif to set up the order in which the images are taken.
The step 1 is faster for projects where the images are geolocated and in case of not sufficient overlap, helps calibrating the images.

https://support.pix4d.com/hc/en-us/articles/202560029
https://support.pix4d.com/hc/en-us/articles/202560029
https://support.pix4d.com/hc/en-us/articles/202560019
https://support.pix4d.com/hc/en-us/articles/202560019


c.(optional) Editing Selected Camera Model

A camera model needs to be defined for each imagein order to run a Pix4Dmapper project. The parameters of this model depend on the camera that
captures the image. Most cameras save the name of the camera in the metadata of the image in EXIF format. Camera models are identified by a name
taken from the image EXIF data, if it has EXIF data. This name is calledEXIF IDand is used to associate a given camera model to all the images with
the same EXIF ID.

TheCamera Modelsection, on the Image properties windowdisplays the selected camera model. The camera model can be:

Valid: A green check is displayed if the camera model is valid. A camera model is valid if it already exists in Pix4Dmapper's camera model database or if
there is sufficient information in the EXIF data of the images to create a new camera model that will be saved into the user camera model database. If the
camera model is retrieved from the EXIF data, it is recommended to check the camera model parameters and, if needed, to edit them.

Invalid: A red cross is displayed if the camera model is not valid. A camera model is invalid if it is not in Pix4Dmapper's camera model database and if

there is not enough information in the EXIF data of the images. In this case the camera model needs to be defined by editing it.

For more information and step by step instructions about how to edit the camera model:202560169.

Note: Grouping the images:
When the project contains images with different spectral signatures (RGB, NIRGB, etc) usually the images are grouped automatically, in case that they
are not grouped by default, group them manually following:202560509.
In this case different orthomosaics are generated, one orthomosaic per group that can be used for Index calculations.

Once the items above are configured:

1. ClickNext.
2. Click Finish to finish the wizard and start the project.
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Once the project is created, start with a Rapid Check local processing on site. Rapid Check is useful for a quick preview of the project reconstruction and for
assessing the quality of the dataset on-site right after its acquisition.

In order to run the Rapid Check:

1. On the Menu bar, click Process > Local Processing.

 

2. The Local Processing sidebar opens on the bottom of the screen.

 

3. On 1. Initial Processing, select Rapid Check, and unselect 2. Point Cloud Densification and 3. DSM and Orthomosaic Generation.

 

4. Click Start.

 

The Rapid Check reduces the resolution of the original images to 1 MP. Therefore it is faster, but it lowers the global accuracy and may lead to incomplete
results. Indeed, when the image size is lower, the number of keypoints extracted on each image is also lower, which leads to a lower number of matches between
the images. If the number of matches is lower, the quality of the reconstruction might be lower as well. Once the Initial Processing is finished, the automatically
generated quality report pops up.

Check the quality report after Initial Processing. If the reconstruction is not good enough or fails then the same may happen with Full Processing.

Note: 
If the Rapid Check succeeds, it is safe to assume that the results of Full Processing will be of high quality.
If the Rapid Check fails, it is an indication that this dataset is difficult and requires more overlap (for more information about how to design the flight
plan: 202557409). If so, it is advised to collect more images either by flying again and combining the projects together, or by changing the flight plan to
provide more overlap.
It is possible obtain results with the Full Processing even if the Rapid Check fails. However the results in that case may be of lower quality, consist of
less calibrated images or contain artifacts.
It is possible that the Rapid Check succeeds and the full processing fails. It is a rare case and usually happens with blurry or low textured images where
few keypoints can be computed in full pixel resolution. It is advised to collect new sharp (not blurry) images. The full processing can succeed setting the
image scale to Half image size or Quarter image size. For more information: 202557759.

 



Information: The initial processing step computes the location and orientation as well as the camera parameters of the original images using the
software's advanced Automatic Aerial Triangulation (AAT) and Bundle Block Adjustment (BBA). An initial cloud of 3D points is computed and a low
resolution DSM and orthomosaic are generated.
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Important:
For a detailed description about how to analyze the Quality Report: 202558689.
For a detailed description about any parameter described in the Quality Report: 202558679.
Example of a Quality Report available at the following link: Quality Report.

The Rapid Check reduces the resolution of the original images to 1MP. Therefore it is faster, but it lowers the global accuracy and may lead to incomplete results.
Indeed, when the image size is lower, the number of keypoints extracted on each images is also lower, which leads to a lower number of matches between the
images. If the number of matches is lower, the quality of the reconstruction might be lower as well. Once the Initial Processing is finished, the automatically
generated quality report pops up.

Check the Quality Report after Initial Processing. If the reconstruction is not good enough or fails then the same may happen with the Full Processing.

Main points to check:

Processing Failed: If the processing failed run the project in Full Processing mode and analyze the report. As the Rapid Check reduces the image size and thus
lowers the number of keypoints, an unsufficient number of keypoints could be a cause of failure.
Processing Finished:
Quality Check, Dataset: All the images that are calibrated when using the Rapid Check will be calibrated when running Full Processing. Therefore it is important
to verify that all or almost all the images are calibrated. If not, this may indicate an issue with the images acquisition plan (not enough overlap), or that the image
quality might not be good enough (e.g. blurry images).
Quality Check, Camera Optimization: The relative difference between the initial and optimized camera parameters should ideally be below 5%. If not, check that
the right camera model is used. If the right camera model is used, change the camera's initial values to the optimized values following 202560059 and reprocess.

 

 

https://support.pix4d.com/hc/en-us/articles/202558689
https://support.pix4d.com/hc/en-us/articles/202558679
https://support.pix4d.com/hc/en-us/articles/201540635
https://support.pix4d.com/hc/en-us/articles/202560059
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Once having verified that the dataset is good enough to produce good quality results (using the Quality Report obtained with the Rapid Check), there are some
more optional steps that can be followed before processing:

 

1. Selecting the Orthomosaic and/or Point Cloud Densification Area (optional) 

By default, the area selected to perform the point cloud densification and to create the orthomosaic corresponds to the entire area covered by all the images
that are calibrated. It is possible to modify this area but it is not compulsory. This option can be useful to create an orthomosaic only for the area of interest
or for performing the point cloud densification only on a specific area.

In order to change the Orthomosaic Area, follow: 202560209.
In order to change the Point Cloud Densification Area, follow: 202560179.

 

2. Changing the Process Options (optional)

Change the output results files (types and format), change some processing settings to improve the quality of the results when needed, or change some
processing settings for advanced use. For more information: 202560009.

Note: By default the following outputs are generated:

Step 1. Initial Processing:

Camera Internals and Externals, ATT, BBA. 
Automatic Tie points
Quality Report

Step 2. Point Cloud Densification:

Point Cloud
3D Textured Mesh
Quality Report

Step 3. DSM and Orthomosaic Generation:

Raster DSM
Orthomosaic

 

3. Adding GCPs (optional)

Add Ground Control Points (GCPs) to improve the global accuracy of the project (georeference). GCPs can be measured in the field using topographic
methods, taken from existing geospatial data, or from Web Map Service (WMS).

Warning: Using GCPs is HIGHLY RECOMMENDED when processing images with no geolocation.

If no Ground Control Points are used:

The final results have no scale, orientation, and absolute position information. Therefore they cannot be used for measurements, overlay, and
comparison with previous results.
They may produce an inverted 3D model in the rayCloud. 
The final 3D model may present some shift (this problem can be corrected using Manual Tie Points: 202560349).

For step by step instructions about how to include GCPs in the project: 202560239.
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Once the Rapid Check Initial Processing has been done and its Quality Report has been used to assess the quality of the dataset, the projet is ready to be
processed. Before starting the project processing, the processing parameters can be changed (optional) and GCPs can be added (optional). When processing a
project it is recommended to go through the following steps:

1. Initial Processing
2. Analyzing the Full Processing Quality Report
3. Point Cloud Densification
4. DSM and Orthomosaic Generation
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To start processing the project:

1. On the top left menu, click Process > Local Processing.

 

2.  The Local Processing menu opens on the bottom of the screen.

 

3. Ensure that 1. Initial Processing is enabled, Full Processing is selected and that 2. Point cloud densification and 3. DSM and Orthomosaic Generation
are unselected:

 

4. Click Start.

For more information about the outputs resulting from 1. Initial Processing: 202558519.
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Important:
For a detailed description about how to analyze the Quality Report: 202558689.
For a detailed description about any parameter described in the Quality Report: 202558679.
Example of a Quality Report available at the following link: Quality Report.

Once step 1. Initial Processing is completed, the Quality Report is automatically displayed. It is recommended to verify the following information:

 

1. Summary

Verify that:

(optional) If using GCPs, that the GCPs Coordinate System is correct.
(optional) If using images with geolocation, that the Image Coordinate System is correct.

 

 

2. Quality Check

Verify that:

All the checks are green.
All or almost all the images are calibrated in one block. 
The relative difference between initial and optimized camera parameters is below 5%.
(optional) If using GCPs, that the GCP error is below 3×GSD.

 

3. Preview

For projects where the images are nadir, verify that the orthomosaic preview:

Does not contain holes.

 

https://support.pix4d.com/hc/en-us/articles/202558689
https://support.pix4d.com/hc/en-us/articles/202558679
https://support.pix4d.com/hc/en-us/articles/201540635


Does not have distortions.
(optional) If GCPs or geolocation has been used, that has the correct orientation.

 

 

4. Computed Image/GCPs/Manual Tie Points Positions

Verify that :

(optional) If using images with geolocation, that The geolocation of the images is good.
(optional) If using GCPs, that The GCPs error is low.

 



 

5. 3D Points from 2D Keypoints Matches

Verify that:

Enough matches have been computed between the images.
The graph consists of one block.



 

6. Geolocation Details

(optional) If using GCPs, verify that:

All GCPs are taken into account (not displayed with red color on the Geolocation and Ground Control Points table).
All measured GCPs have been verified.
The green circle representing the reprojected GCP 3D point is inside the yellow circle representing the marked GCP.
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To process the Point Cloud Densification step:

1. Open the Local processing sidebar by clicking Process > Local Processing.
2. Ensure that 2. Point Cloud Densification is selected, and that 1. Initial Processing  and 3. DSM and Orthomosaic Generation are unselected.

Note: By default, only the Densified Point cloud is generated in .las format. In order to generate more outputs (Point Cloud Classification: Terrain
and Objects, 3D Textured Mesh) or the Densified Point cloud in more formats (.laz, .ply, .xyz), change the processing options for Point
Cloud: 202557799.

3. Click Start.

For more information about the outputs resulting from 2. Point Cloud Densification: 202558549.
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To process the DSM and Orthomosaic Generation step:

1. Open the Local processing sidebar by clicking Process > Local Processing.
2. Ensure that 3. DSM and Orthomosaic Generation is selected, and that 1. Initial Processing, and 2. Point Cloud Densification are unselected.
3. (optional) On the section 3. DSM and Orthomosaic Generation under the Resolution option change the DSM and orthomosaic resolution if needed. By
default, the mean Ground Sampling Distance (GSD) of the initial images (computed during Initial Processing) will be used.

Note: By default, only the Raster DSM (2.5D no color) in .tif format and a transparent Orthomosaic in .tif format are generated. In order to generate
more outputs (Grid DSM (2.5D), Google Maps Tiles and KML, Mapbox Tiles, Reflectance Map) or the not transparent Orthomosaic in .tif format,
change the processing options for DSM and Orthomosaic: 202557769.
  
By default the contour lines are not generated. In order to generate contour lines, select the desired output format files in the processing options for
Additional Outputs: 202558419.

4. Click Start.

For more information about the outputs resulting from 3. DSM and Orthomosaic Generation: 202558559.
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Once the project has been processed, it is possible to use the results:

Using the rayCloud
Using the Mosaic Editor
Using the Index Calculator
Uploading Project Files
Using output files with other software

 

Using the rayCloud

The use of the rayCloud is optional and it can be used to:

Visualize the different elements of the reconstruction (Camera Positions, Reprojections (rays), GCPs, Manual / Automatic Tie Points, Processing Area, Clipping
Box, Densified Point Cloud, Terrain / Objects / other classes of points, 3D Textured Mesh, Objects, Video Animation Trajectories) and their properties.
Visualize point clouds / 2.5 Triangle Meshes using point clouds created in other projects or with other software.
Verify / improve the accuracy of the reconstruction.
Assign points of the point cloud to different classes.
Improve the visual aspect.
Create objects and measure distances (Polylines), surfaces, and volumes (Stockpiles).
Create 3D Fly-trought animations (Video Animation Trajectories).
Export different elements (GCPs, Manual / Automatic Tie Points, Objects, Video Animation Trajectories).
Create point cloud files using points belonging to one or several classes.

For more information: 202558639.

 

 

Using the Mosaic Editor

The use of the Mosaic Editor is optional and it can be used to:

Visualize the DSM (raster GeoTIFF Digital Surface Model).
Improve the visual aspect of the mosaic.

For more information: 202558709.

https://support.pix4d.com/hc/en-us/articles/202558639
https://support.pix4d.com/hc/en-us/articles/202558709


 

 

Using the Index Calculator

The use of the Index Calculator is optional and it can be used to:

Generate an Index Map / Index Grid where the color of each pixel is computed using a formula that combines different bands of the Reflectance Map(s).
Visualize the Index Map as a Colored Index Map by applying a color mapping to it.
Provides information about the bands of the Reflectance Map(s) and Index Map.

For more information: 202558729.

https://support.pix4d.com/hc/en-us/articles/202558729


 

 

Uploading Project Files

The use of the Uploading Project Files feature is optional and it can be used to:

Upload Files to the Pix4D Cloud, in order to:
Store files into the Pix4D online account.
Process projects online.
Provide project information to the support team.
Upload files to Mapbox.

For a full description about the File Upload pop-up: 202557689.

For step by step instructions: 202558589.

Upload Files to the Pix4D Cloud Upload Files to Mapbox

 

Using output files into other software

Pix4Dmapper outputs are compatible with many software (GIS, CAD, etc.) and can be used for many different applications. For more information about how to

https://support.pix4d.com/hc/en-us/articles/202558589


use Pix4Dmapper output files with other software: 202558499.
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The software manual describes all the options that can be found in thePix4Dmappersoftware.The following links contain a detailed description of these options:

TableView Blocks View Index View

Interface
Menu bar Toolbar View toolbar Main view
Floating License
Shortcuts

Menu Bar
Menu Project Menu Process Menu View
New Project...
Open Project...
Recent Projects
Image Properties Editor...
Image Coordinate System
Geolocation and Orientation
Selected Camera Model
Edit Camera Model
Images Table
GCP/Manual Tie Point Manager...
GCP Coordinate System
GCP/Manual Tie Point Table
Import GCPs...
Add Point
Remove Points
Import/Export Marks...
GCP/Manual Tie Point Editor
rayCloud
Basic GCP/Manual Tie Point Editor
GCP/Manual Tie Point Table
Images
Preview

Select Output Coordinate System...
Save Project
Save Project As...
Split into Subprojects...
Exit

Upload Project Files...
Local Processing
Reoptimize
Rematch and Optimize
Quality Report...
Open Results Folder...
Generate Quality Report
Save Undistorted Images
Run Terrain/Object Point Cloud Classification (beta)
Generate 3D Textured Mesh
Generate DTM (beta)
Import Point Cloud for DSM Generation...
Generate Google Maps Tiles, KML and Mapbox Tiles
Generate Contour Lines
Options...
Initial Processing
Point Cloud
DSM and Orthomosaic
Additional Outputs
Index Calculator
Resources

Show View Toolbar
Show Sidebar
Welcome
Demo Project
Projects
Help
Map View
rayCloud 
Mosaic Editor
Index Calculator

Menu Help
Help Contents
Online Support
Personal Support
Settings...
About...

Views
Map View rayCloud Mosaic Editor Index Calculator
Menu bar entry
Point Cloud Densification Area
Orthomosaic Area
Toolbar extra buttons
2D View
Map View Sidebar
Project Summary
Layers
Status bar

Menu bar entry
Viewpoint
Perspective/ Orthographic
Allow Full 3D Rotation
Change Background
New Polyline
New Surface
New Volume
New Video Animation Trajectory
Toolbar extra buttons
Layers Sidebar
Cameras
Rays
Tie Points
Processing Areas
Point Clouds
Point Groups
Triangle Meshes
Objects
3D View
rayCloud Sidebar
Clipping Box
Cameras
GCPsandManual Tie Points
Automatic Tie Points
Processing Areas
Point Clouds
Objects

Status bar

Menu bar entry
View
Orthomosaic View [Group]
Elevation View
Show Seamlines
Show Mosaic Area
Show Mosaic Tiles
Pan and Zoom
Zoom In
Zoom Out
Image List
Tools
Reset Mosaic Mesh
Edit Mosaic
Blend Mosaic
DSM Color Map
Load Mosaic
Clear Mosaic
Save Mosaic
Auto Save Mosaic
Close

Toolbar extra buttons
Mosaic View
Mosaic Sidebar
Status bar

Menu bar entry
Index View
Index Calculator Sidebar
1. Reflectance Map
2. Regions
3. Index Map
Formulas Editor
Index List
4. Classes
5. Export
Status bar

Next

https://support.pix4d.com/hc/en-us/articles/202557989
https://support.pix4d.com/hc/en-us/articles/202558109


 

Index  Previous  |  Next  

 

When Pix4Dmapper opens, 4 sections appear:

Menu bar
Toolbar
View toolbar
Main view

Figure 1. Menu bar (yellow), toolbar (red), view toolbar (green) and main view (blue).

Menu bar

There are 4 items:

Project: This menu allows the user to create, open, or save a project. It also allows the user to view and define properties of the images, GCPs, and output
coordinate system.
Process: This menu gives access to all processing options and actions.
View: This menu gives access to the different views of the software. Depending on the selected view, a new item will appear on the Menu bar: Map, rayCloud,
Mosaic or Index Calculator. This extra menu bar item contains options specific for the selected view.
Help: This menu gives access to the manual, it also allows the user to set some settings of the software (proxy, camera model database), and it gives information
about the installed release.

The different options within the menu bar items may be active or inactive (grayed out) depending on the state of the project and the selected options.

 

Toolbar

The different buttons within the toolbar may be active or inactive (grayed out) depending on the state of the project and the selected options. When the software
starts and no project is open yet,  Zoom In and Zoom Out buttons are not displayed. Each button's action can also be accessed through the Menu bar and is
explained in more details in the next articles.



The toolbar buttons are: 

On the left:

Image Properties Editor...

GCP/Manual Tie Point Manager...

Local Processing

Reoptimize

Rematch and Optimize

Quality Report...

Open Results Folder: Opens a explorer window with the path where the project outputs and .p4d file are stored.

On the right:

 User Options: The following items can be selected:

Logged In as USERNAME: Displays the username.
Cloud Projects: Opens the user website account, displaying the Projects page, where the user can access to the uploaded projects
(https://mapper.pix4d.com/projects/).
Manage Licenses: Opens the user website account, displaying the Licenses page, where the user can access to the Licenses and Devices information
(https://mapper.pix4d.com/licenses/).
Log Out...: Option to deactivate the license in the installed computer.

Show / Hide the Sidebar: Shows /hide the sidebar relative to the selected view. The Welcome view does not have sidebar.

 

When activating the different views using the View menu bar item (Map View, rayCloud, Mosaic Editor and Index Calculator) some extra buttons appear. These
extra buttons are specific for the selected view (see Figures 2-5 below).

 

View toolbar

Appears on the left, it allows to select the view, depending the status of the project and depending on the state of the project and the selected options, the
different options may be active or inactive (grayed out), when starting the software, only the Welcome view is active.

The different views are:

Welcome

Map View

rayCloud

 Mosaic Editor

 Index Calculator

In order to show / hide the view toolbar, on the menu bar click View > Show View Toolbar.

 

Main view

When Pix4Dmapper opens, the Welcome view appears.

When opening a project the Map View is active by default and the 2D View is visible. When the rayCloud is active the 3D View is visible, when the Mosaic Editor
is active the Mosaic View is visible and when the Index Calculator is active the Index View is visible.

 



Figure 1. Menu bar, toolbar buttons, view toolbar and main view when starting the software.



Figure 2. Menu bar, toolbar buttons, view toolbar and main view when the Map View is selected.



Figure 3. Menu bar, toolbar buttons, view toolbar and main view when the rayCloud is selected.

Figure 4. Menu bar, toolbar buttons, view toolbar and main view when the Mosaic Editor is selected.



Figure 5. Menu bar, toolbar buttons, view toolbar and main view when the Index Calculator is selected.
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Access: On the Menu bar, click Project.

There are items that can be selected:

New Project... 
Open Project... 
Recent Projects 
Image Properties Editor...
GCP/Manual Tie Point Manager...
Select Output Coordinate System...
Save Project
Save Project As...
Split into Subprojects...
Exit

Depending if there is a project that is loaded/created or not, the different options will be enabled or grayed out:

Available options before a project is loaded or created. Available options once a project is loaded or created.

 

New Project...

Opens the wizard that will guide you to create a new project.

For step by step instructions about creating a new project: 202557309.

 

Open Project...

Opens an existing project. Opens a pop-up to navigate and select a .p4d project file (Pix4Dmapper project file format).

 

Recent Projects 

Displays a menu with the 10 last projects that have been opened. By clicking on one of them, the project will be opened.

 

Image Properties Editor...

Allows the user to change the properties of the project's images such as: images' coordinates system, images' geolocation, and orientation and the associated
camera models. For more information: 202557849.

 

GCP/Manual Tie Point Manager...

Allows the user to set up and edit the properties of the GCPs / Manual Tie Points / Check Points such as: Select the GCPs coordinate system, import GCPs,
add / remove points, import / export the marks, open the rayCloud or Basic Editor for marking. For more information: 202558329.

 

Select Output Coordinate System...

Allows the user to select the coordinates systems for the results. For more information: 202558099.

 



 

Save Project

Save the status/properties and configuration of the current project.

Important: This option saves any change made since the project was opened and was saved for last time. The .p4d project file will be updated with the
current information of the project. This saving has no effect on other files such as input files or output files. Output files will be modified/created when
processing.

 

Save Project As... 

Save the status/properties, configuration, and results of the current project into another location and/or with a different name.

Important: If a different project name or path is selected, this option will save a copy of the project in the new location using the new project name.

A new .p4d project file will be created and saved with the same information of the current project. Once this new project is created, any change made
and saved with the option Save Project will not be saved into the original project. Only the new project will include all the changes.

 

Split in Subprojects...

Allows the user to split automatically the project in subprojects by creating automatically different .p4d files.

Each .p4d file contains the images for the created subproject.

The different subprojects contain overlap, therefore, some images will appear in more than one subproject. 

Only aerial projects with geolocated images can be split.

Opens the Split the Project into Subprojects pop-up:

Which contains the following options:

Maximum Number of Images: Defines the area to be used to split the terrain into subprojects, when selecting for example 100, a subproject will cover the area
from 100 images plus some area and images from neightbourg subprojects so there will be overlap between them.
Suffix of the Subproject's Name: Text to use as suffix for the subprojects. Each subproject will be named as, projectname + Suffix + Number.

Important: All the Manual Tie Points, GCPs, check points and Objects created in the original project, will be copied into all the generated subprojects.

 

Exit

Close the project and exit the software.

Important: If changes have been made and the project was not saved, the following pop-up appears:

Click Save to save the changes and exit, Discard to exit without saving, and Cancel not to exit.
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Access:On the Menu bar, clickProject > Image Properties Editor...

Access via the New Project wizard:When creating a new project,after loading the images.

TheImage Properties Editor windowhas the following 4sections:

Image Coordinate System:Sectionto select thecoordinatesystem on which the images geolocation is based and to assign, if applicable, the vertical offset (in
meters).
Geolocation and Orientation:Section toImport/export thecoordinates of the images and, optionally, the orientation of the images and/or the accuracy of the
coordinates.
Selected Camera Model: Section to select thecamera model associated to the images.
Images Table: This tabledisplays the selected images and for each image its group,position, accuracy,orientation, and if it is enabled or not (an enabled image
will be taken into account for processing). If several camera models are used, the camera model associated to a given image is also displayed.

Index> Interface> Menu Project Previous|Next
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Access:On the Menu bar, clickProject > Image Properties Editor...

Access via the New Project wizard:When creating a new project, after loading the images.

The Image Coordinate Systemsection is usedto define thecoordinatesystem on which the images' geolocation is based.

Datum: Represents the selectedimages datum. By defaultthe selectedDatum is World Geodetic System 1984.
Coordinate System: Represents the selectedimages coordinate system. By default the selected Coordinate systemisWGS 84.
Geoid Height Above the Ellipsoid [m]:It is displayed in parenthesis, only if aGeoid Height Above the Ellipsoid is defined. It represents the geoid height above the
used ellipsoid that will be used to convert the images height from geoid to ellipsoidal. For more information about when to use this function:202559459.
Edit...: Opens theSelect Image Coordinate Systempop-up that allows the user tochange the selected coordinate system.
For more information:202558239.
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Access:On the Menu bar, clickProject > Image Properties Editor...

Access via the New Project wizard:When creating a new project, after loading the images.

This section is usedto import the images' geolocation and orientation.

Important:Pix4Dmapper can process images with or without geolocation. If less than 3 images are geolocated, lower precision results are expected.

The status indicator is represented with the left icon:

: If less than 3 images are geolocated, lower precision results are expected.

: More than 3 images are geolocated.

The number of geolocated images is displayed next to the status indicator icon.

There are 4 options available for this section:

Clear: Deletes the images' coordinates that are already chosen.
From EXIF: Imports theimage geolocation (coordinates) written in the EXIF data of the images if they are written in the data.
From File...: Imports from file thecoordinates of the images and, optionally, the orientation of the images and/or the accuracy of the coordinates using theSelect
Geolocation Filepop-up.
To file: Exports to file thecoordinates of the images and, optionally, the orientation of the images and/or the accuracy of the coordinates using the Export Image
Geolocation pop-up.

Select Geolocation File

The Select Geolocation File pop-up is used toimporttheimage geolocation (coordinates and orientation) from a file.

The File Format drop-down menu contains the list of supported file formats:

https://support.pix4d.com/hc/en-us/articles/204606405


Latitude, Longitude, Altitude
Longitude, Latitude, Altitude
X, Y, Z
Y, X, Z
3D Robotics Flight Log
CropCamFlight Log
QuestUAVFlight Log
TetracamFlight Log

For more information about the content and the format of these files:202558539.

There are also 4action buttons:

Browse: Selects the geolocation file.
OK:Confirms the changes.
Cancel:Does not save the changes.
Help:Opens the Pix4Dmapper help.

Latitude, Longitude, Altitude

Select this option to import a geolocation file with WGS84 (latitude, longitude, altitude) coordinates in Pix4D's file format. For more information about the format of
the geolocation file:202558539.

Longitude,Latitude, Altitude

Select this option to import a geolocation file with WGS84 (longitude, latitude,altitude) coordinates in Pix4D's file format. For more information about the format of
the geolocation file:202558539.

X, Y, Z

Select this option to import a geolocation file with (X,Y,Z) coordinates in Pix4D's file format. For more information about the format of the geolocation
file:202558539.

Y, X, Z

Select this option to import a geolocation file with (Y,X,Z) coordinates in Pix4D's file format. For more information about the format of the geolocation
file:202558539.

3D Robotics Flight Log

Select this option to import a log file delivered by 3D robotics UAVs.For more information about the format of the log file:202558539.

CropCamFlight Log

Select this option to import a log file delivered byCropCam UAVs. For more information about the format of the log file:202558539.

When this option is chosen, the Select Geolocation File pop-up displays additional options:

There are 2 options:

The Camera Servo section defines the servo on which the camera is mounted. By default the camera servo is Servo8. If the camera is mounted on another servo,
click on the drop down list and select the appropriate servo.
The Camera Trigger Value corresponds to the value that thecamera servotakes when an image is triggered. The default value is 32256. To change the value, click
on the text box and enter the new value.

Then, once geolocation file is selected, 3 status summaries are filled:

https://support.pix4d.com/hc/en-us/articles/202558539
https://support.pix4d.com/hc/en-us/articles/202558539
https://support.pix4d.com/hc/en-us/articles/202558539
https://support.pix4d.com/hc/en-us/articles/202558539
https://support.pix4d.com/hc/en-us/articles/202558539
https://support.pix4d.com/hc/en-us/articles/202558539
https://support.pix4d.com/hc/en-us/articles/202558539


First Image Date: Corresponds to the date and time the first image is taken.
First Geolocation Date: Corresponds to the date and time of the first geotag.
Image-Geolocation Offset [ms]: It is computed automatically once a File is selected. It uses the above two values,in order to correctly match a geotag with each
image.

QuestUAVFlight Log

Select this option to import a log file delivered byQuestUAV UAVs. For more information about the format of the log file:202558539.

TetracamFlight Log

Select this option to import a log file delivered by Tetracam's software PixelWrench2. For more information about the format of the log file:202558539.
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Access:On the Menu bar, clickProject > Image Properties Editor...

Access via the New Project wizard:When creating a new project, the Image Properties window appears after loading the images.

The SelectedCamera Model sectionis used to describe the selected camera model(s) associated with the images.

The status indicator is represented with the left icon:

: The camera model is valid, if it is retrieved from Pix4Dmapper's internal camera model database, from the user camera model database, from a project

file, or from the image EXIF data if enough information is in the data.

: The camera model is invalid if the camera model does not correspond to any model of the camera model databases and if the EXIF data of the images

does not sufficient information about the camera model.

On the right of the status indicator, there is an icon that describes the source of the camera model:

: Camera model taken from the internal camera model database.
: Camera model taken fromtheinternal camera model database with some user-edited values.
: Camera model taken from the user camera model database.
: Camera model taken fromthe image EXIF data when the camera model does not exist in the internal or the user database and there is valid information

inside the EXIF data.
: Camera model taken fromthe.p4d project filewhen a .p4d file is opened andits camera model does not exist in the internal or the user database.

Beside the status indicator appears the Exif ID (CameraModel_ FocalLength_ResolutionWidthxResolutionHeight) and the band configuration.

On the right of the SelectedCamera Model sectionthere are the following buttons:

Edit...: Opens the Edit Camera Model pop-up which allows the user to edit the corresponding camera model. For more information about theEdit Camera
Modelwindow:202558159.
Assign(optional): Appears if more than one camera model is detected (e.g. multiple flights with different cameras or merged projects). By clicking on it, the
corresponding camera model is assigned to the other detected camera models that have the same image width and height.

Index >Interface>Menu Project>Image Properties Editor... Previous|Next



Index > Interface > Menu Project  > Image Properties Editor... > Selected Camera Model  Previous  |  Next  

 

Access: On the Menu bar, click on Project > Image Properties Editor..., the Image Properties Editor window opens, in the Selected Camera
Model section, click Edit... 

Access via the New Project wizard: When creating a new project, the Image Properties window appears after loading the images, in
the Selected Camera Model section, click Edit...

The Edit Camera Model window is used to define or edit the camera model.

The camera model can have a perspective or fisheye lens. 

There are 3 sections:

Camera Model: Displays the current EXIF ID and the associated camera model. 
Camera Model Bands: Displays the configuration band selected for the camera model.
Camera Model Parameters: Describes the camera parameters for the selected camera model.

 and 3 action buttons:

OK: Confirms/applies the changes:
Uses the camera model selected in the Camera Model section if saved into the camera model database.
Uses the camera model name and parameters displayed in the Camera Model section if pressed while editing or creating a new camera model. The currently
displayed camera parameters are not saved into the camera model database but they are saved only in the project .p4d file.
Cancel: Does not save the changes.
Help: Opens the Pix4Dmapper help.

Camera Model

 

 



The following items are displayed:

EXIF ID: Displays the current EXIF ID  (CameraModel_ FocalLength_ResolutionWidthxResolutionHeight) of the camera. No user intervention is possible.
   
Camera Model Name: Displays the currently selected camera model. The corresponding drop-down list allows the user to select another known camera model
with the same image width and height.

Beside on the left of the selected camera model name, it appears an icon that describes the source of the camera model:

: Camera model taken from the internal camera model database.
: Camera model taken from the internal camera model database with some user-edited values.
: Camera model taken from the user camera model database.
: Camera model taken from the image EXIF data when the camera model does not exist in the internal or the user database and there is valid

information in the EXIF data.
: Camera model taken from the .p4d file when a .p4d file is created and its camera model does not exist in the internal or the user camera database.

Note: There are 2 camera databases: Internal camera database (with the cameras and values from Pix4Dmapper), and user camera database (with
the cameras added or modified by the user).
The internal camera database cannot be edited, modified or deleted.
The user camera database can be:
Edited and modified from Menu Project > Image Properties Editor... > Selected Camera Model > Edit Camera Model.
Cleared, imported or exported from Help > Settings..., selecting the tab Camera database.

Click the drop-down list to display the available camera models. The drop-down list only displays camera models with the same image width and height as
the detected EXIF ID. The drop-down list displays camera models using perspective lenses if Perspective lens (Camera Model Parameters section) is
selected and it displays camera models using fisheye lenses if Fisheye lens (Camera Model Parameters section) is selected.

Note: No information is displayed if no camera model exists with the same image width and height.

The following buttons are displayed:

Edit: Edit the Camera Model Bands and/or the Camera Model Parameters for the selected camera model. To edit the camera parameters: 202560169.
New: Create a new camera model. To create a new camera model: 202560169.
Restore: It is displayed only for camera models that exist in the internal camera database and have been edited by the user and stored in the user camera
database. It removes the camera model from the  user database and it restores the parameters from the  internal database.
Save to DB: Visible when clicking on Edit or New. Save the camera model in the user camera model database.

Note:
When editing , and saving to DB, change it to 
When editing , and saving to DB, creates
When editing , and saving to DB, creates
When editing , and saving to DB, creates
When editing or  or  or , and clicking in OK without saving to DB, creates
When creating new and Saving to DB, creates
When creating new and clicking in OK without saving to DB, creates 
Cancel edit: Visible when clicking on Edit or New. Cancel the editing or creating of new camera model.

 

Camera Model Bands

The section contains 2 items:

Bands: Displays the band configuration selected for the project. If the band configuration is in the EXIF, and it is one of the listed bands below, it is selected
automatically. Allow to change the band configuration when more types have been added to the camera model.

Edit...: Opens the Edit Band Configuration pop-up:

 

 

 

https://support.pix4d.com/hc/en-us/articles/202560169
https://support.pix4d.com/hc/en-us/articles/202560169


Access: It is enabled if Edit or New has been clicked in the Camera Model section.  

Allows to add/edit/remove Band configurations.

There is one section:

Band configurations table:

Each row displays information for one band configuration: 

Default: Displays which band configuration is selected by default when using the selected Camera Model.
Bands number: Number of bands for the band.
Name: Name of the band configuration, double click on the name to edit the name.

 and the action buttons:

Add..: Opens the pop-up band configuration window: To add a new band configuration.

By default appears the values of the RGB band configuration:

There is one section, bands. Each row displays information for one band and by double clicking on them, it is possible to edit the value:

Enabled: Displays if the band is enabled or not for the selected Band configuration.
Name: Name of the band for the Band configuration.
Central Wave Length [mm]: Representative (most influential) wave length for the band.
Band Width [mm]: Width of the distribution related the central wave length of the band.
Weight: How much value Pix4Dmapper gives to the selected band compare to other bands of the band configuration. These values affects only to the step 1.
Initial Processing and all the weight values for one band should sum 1.

And the action buttons:

Add...: Displays if the band is enabled or not for the selected Band configuration.
Remove: Name of the band for the Band configuration.
OK: Saves the new band configuration.



Cancel: Does not save the band configuration.
Help: Opens the Pix4Dmapper help.

Edit...: Opens the pop-up band configuration window: To edit an existing band in the configuration window:

By default appears the values of the RGB band configuration:

There is one section, bands. Each row displays information for one band and by double clicking on them, it is possible to edit the value:

Enabled: Displays if the band is enabled or not for the selected Band configuration.
Name: Name of the band for the Band configuration.
Central Wave Length [mm]: Representative (most influential) wave length for the band.
Band Width [mm]: Width of the distribution related the central wave length of the band.
Weight: How much value Pix4Dmapper gives to the selected band compare to other bands of the band configuration. These values affects only to the step 1.
Initial Processing and all the weight values for one band should sum 1.

And the action buttons:

Add...: Displays if the band is enabled or not for the selected Band configuration.
Remove: Name of the band for the Band configuration.
OK: Confirms/applies the changes.
Cancel: Does not save the changes.
Help: Opens the Pix4Dmapper help.

Remove: Delete the selected band from the Band configurations table. 
OK: Confirms/applies the changes.
Cancel: Does not save the changes.
Help: Opens the Pix4Dmapper help.

Example: Examples of Band configurations:
RGB: For images with 3 bands. The first band corresponds to Red, the second band corresponds to Green, and the third band corresponds to
Blue. 
Blue, Green, NIR: For images with 3 bands. The first band corresponds to Blue, the second band corresponds to Green, and the third band
corresponds to Near Infrared.
NIR, Green, Blue: For images with 3 bands. The first band corresponds to Near Infrared, the second band corresponds to Green, and the third band
corresponds to Blue.
NIR, Red, Green: For images with 3 bands. The first band corresponds to Near Infrared (or Infrared), the second band corresponds to Red, and the
third band corresponds to Green.
Red edge, Green, Blue: For images with 3 bands. The first band corresponds to Red edge, the second band corresponds to Green, and the third
band corresponds to Blue.
Red, Green, NIR: For images with 3 bands. The first band corresponds to Red, the second band corresponds to Green, and the third band
corresponds to Near Infrared.

 

Camera Model Parameters

The Camera Model Parameters section includes all camera parameters and is enabled for editing if the Edit or New button has been clicked in the Camera
Model section. It displays the camera parameters of the selected Camera Model Name in the Camera Model section. 

The Camera Model Parameters section has 3 action buttons (enabled if Edit or New has been clicked in the Camera Model section):

Clear: It clears all the fields except image width (pixel) and height (pixel).

 



Estimate from EXIF:  Estimates the parameters from the EXIF data if enough information about the camera model is found there.
Load Optimized Parameters: Enabled once at least step 1 has been completed, it changes the camera initial values to the optimized values.

The parameters can be defined or edited for a:

Perspective lens: When the camera model uses a perspective lens.
Fisheye lens: When the camera model uses a fisheye lens (ultra wide angle lens).

Perspective lens

To edit values in pixels, select the radio button on the left of the Image width [pixels] text box. To edit values in millimeters, select the radio button on the left of
the Sensor width [mm] text box.

 

Internal Camera Parameters for Perspective lens
Camera Model Name Name for the camera model.
Image Width [pixel] The image width in pixels. This value cannot be edited. It is read from the image file information.
Image Height [pixel] The image height in pixels. This value cannot be edited. It is read from the image file information.
Focal Length [pixel] The focal length in pixels.
Principal Point x [pixel] The x image coordinate of the principal point in pixels. The principal point is located around the center of the image. The

coordinate system has its origin as displayed here:

 

Principal Point y [pixel] The y image coordinate of the principal point in pixels. The principal point is located around the center of the image. The
coordinate system has its origin as displayed here:

Sensor Width [mm] The sensor width in millimeters. If the sensor width is estimated from the EXIF and no information is in the image EXIF data, the
sensor width corresponds to 36[mm].



Sensor Height [mm] The sensor height in millimeters. If the sensor height is estimated from the EXIF and no information is in the image EXIF data, the
sensor width is set to 36 [mm] and the sensor height is computed in such a way that the ratio sensor width / sensor height in
millimeters equals the ratio image width / image height in pixels.

Pixel Size [μm] The size of the pixel is read from the EXIF data if the information is available. If there is no information related to the pixel size,
then it is calculated in order to correspond to 36 x 24 mm sensor size.

Focal Length [mm] The focal length in millimeters.
Principal Point x [mm] The x image coordinate of the principal point in millimeters. The principal point is located around the center of the sensor. The

coordinate system has its origin as displayed here:

 

Principal Point y [mm] The y image coordinate of the principal point in millimeters. The principal point is located around the center of the sensor. The
coordinate system has its origin as displayed here:

 

Radial Distortion K1: Radial distortion of the K1 lens.
Radial Distortion K2: Radial distortion of the K2 lens.
Radial Distortion K3: Radial distortion of the K3 lens.
Tangential Distortion T1: Tangential distortion of the T1 lens.
Tangential Distortion T2: Tangential distortion of the T2 lens.

Tip: If the radial and tangential distortions of the lens are not known, it is recommended to set the values for K1, K2, K3, T1, T2 to 0.

 

Fisheye lens

To edit values in pixels, select the radio button on the left of the Image width [pixels] text box. To edit values in millimeters, select the radio button on the left of
the Sensor width [mm] text box.

 

 



Internal Camera Parameters for Fisheye lens
Camera Model Name Name for the camera model.
Image Width [pixel] The image width in pixels. This value cannot be edited. It is read from the image file information.
Image Height [pixel] The image height in pixels. This value cannot be edited. It is read from the image file information.
Principal Point x [pixel] The x image coordinate of the principal point in pixels. The principal point is located around the center of the image. The

coordinate system has its origin as displayed here:

 

Principal Point y [pixel] The y image coordinate of the principal point in pixels. The principal point is located around the center of the image. The
coordinate system has its origin as displayed here:

 

Sensor Width [mm] The sensor width in millimeters. If the sensor width is estimated from the EXIF and no information is in the image EXIF data, the
sensor width corresponds to 36[mm].

Sensor Height [mm] The sensor height in millimeters. If the sensor height is estimated from the EXIF and no information is in the image EXIF data, the
sensor width is set to 36 [mm] and the sensor height is computed in such a way that the ratio sensor width / sensor height
in millimeters equals the ratio image width / image height in pixels.

Pixel Size [μm] The size of the pixel is read from the EXIF data if the information is available. If there is no information related to the pixel size,
then it is calculated in order to correspond to 36 x 24 mm sensor size.

 Principal Point x [mm] The x image coordinate of the principal point in millimeters. The principal point is located around the center of the sensor. The
coordinate system has its origin as displayed here:

 

 Principal Point y [mm] The y image coordinate of the principal point in millimeters. The principal point is located around the center of the sensor. The
coordinate system has its origin as displayed here:

 

Polynomial Coefficients 3 or 4 polynomial coefficients. To select the number, click on the drop-down list. 

Note: When 3 polynomial coefficients are selected, the second polynomial is set to 1 by default and no user
intervention is possible.

Affine Transformation C Affine transformation C value.
Affine Transformation D Affine transformation D value.
Affine Transformation E Affine transformation E value.
Affine Transformation F Affine transformation F value.

Tip: If the polynomial coefficients and affine transformation values are not known, it is recommended to set the values as following:
Polynomial coefficients: 0, 1, 0, 0
Affine transformation C = image width in pixels
Affine transformation D = 0
Affine transformation E = 0
Affine transformation F = image width in pixels
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Access:On the Menu bar, clickProject > Image Properties Editor...

Access via the New Project wizard:When creating a new project, the Image Properties window appears after loading the images.

This table is used to describe and edit information and the status of the images used for the project.

The following actions can be performed on the table:

Sorting table
Selecting Images
Editing Values

The table has as many rows as images in the project. Each row displays information for one image:

Status of the image (Enabled)
Image
Group
Camera model (Multi-camera model projects)
First coordinate
Second coordinate
Third coordinate
Accuracy Horz
Accuracy Vert
Omega
Phi
Kappa

Actions on the table

Sorting table



By clicking on the column title to sort, the table will be ordered fromsmaller to higher values. By clicking again in a column title already used for sorting, the
sorting will switch fromsmaller to higherto fromhigher to smallerand vice versa.

A triangle indicates which column title is used for sorting and the type of sorting:

Smaller to higher values. Higher to smaller values.

Selecting images
Selecting an image

Left click on any of the images cells.The row corresponding to the selected image is displayed in blue.
Selecting multiple images

For images that are displayed one after the other:Press theShiftkey and left click on the first and last images to be selected. The rows corresponding to the
selected images are displayed in blue. Or left click on one image and while keeping the left button cliked, move the mouse up or down.

For images that are not displayed one after the other: Press theControlkey and left click on all the images to be selected.The rows corresponding to the selected
images are displayed in blue.
Editing values
Editing one image

ForEnabled:

1. Click the check box (the status switch between selected / unselected).

ForGroup:

1. Double click the cell.
2. Type the new value or click the left arrow to selectamongthe existing values.
3. Click Enter or click outside the cell.

For Latitude, Longitude, Altitude,AccuracyHorz or Accuracy Vert:

1. Double click the cell.
2. Type the new value.
3. Click Enter or click outside the cell.



Editing all the values for one column

ForEnabled:

1.Right click one cell from the column.
2. Click Enabled All Images or Disable All Images.

ForGroup:

1.Right click one cell from the column.
2. Click Edit All Groups.
3. Type the new value or click the left arrow to selectamongthe existing values.
4. Click Enter or click outside the cell.

For Altitude,AccuracyHorz or Accuracy Vert:

1.Right click one cell from the column.
2. ClickEdit All (Altitudes / Horz. Accuracies / Vert. Accuracies).
2. Type the new value.
3. Click Enter or click outside the cell.

Editing the selected rows values for one colum

Select multiple images and:

ForEnabled:

1.Right click one of the selected cells from the column.
2. ClickEnabledSelectedImagesorDisable Selected Images.

ForGroup:

1.Right click one of the selected cellsfrom the column.
2. ClickEdit Groups in Selected Rows.
3. Type the new value or click the left arrow to selectamongthe existing values.
4. Click Enter or click outside the cell.

For Altitude,AccuracyHorz or Accuracy Vert:

1.Right click one of the selected cellsfrom the column.
2. ClickEdit (Altitudes / Horz. Accuracies / Vert. Accuracies) in Selected Rows.
2. Type the new value.
3. Click Enter or click outside the cell.

Status of the Image (Enabled)

The status of the image is displayed in the Enabledcolumn. Itis defined by a check box that indicates if the image is used for the processing or not. If the
checkbox is selected, the image is enabled and is used for the processing.

To select or unselect an image: Left click on the box.

Note:The disabled images are not deleted from the project in case of further need to use them.

Image

This column displays the name of the images. It cannot be edited.

Group

When processing images that belong to different groups, all images are processed together, generating:

1point cloud of automatic tie pointsfor the whole project. The color of theautomatic tie points will be mixed: some points will take color from the RGB images and
others from the NIRGB images.
1 densified point cloud per group.
1 DSM for the whole project.
1 orthomosaic per group.

Important:Images taken by the same camera during different flights should not be grouped into different groups, unless there is need to generate different
orthomosaics for each data.

Tip:Use the groups to group images with different spectral signatures (RGB, NIRGB, etc). In this case different reflectance maps are generated that can
be used for Index calculations. For more information about Index calculations:202558289.The group of the images can be one of the following:
RGB:Use this group for RGB images.
NIR: Use this group for NIR images.
NIRGB: Use this group for NIRGB images.

By default the images that have the same number and type of bands as well as the images with the same pixel type (byte, float) will be grouped as group1.
Images with different bands and pixel type will be grouped as group2, group3, etc. To change the group of one image, double click on the corresponding cell and
edit the group. For more information about editing the group of multiple images:202557949.



Important:When having more than one group, the Google files (Google Maps tiles and kml) will only be generated if one of the groups is
namedRGB(capital letters). Then the Google files will be generated only for this group. For more information about how to generate Google
files:202558149.

Camera model(Multi-camera model projects)

For projects with more than one camera model, this column displays the camera model assigned to the corresponding images.

To change the camera model of one image, double click on the corresponding cell. Click on the arrow that appears and, from the drop-down list, choose the
desired camera model.

Note:The camera model can only be chosen among a list of detected camera models of the project.

First Coordinate

The first coordinate is:

Latitude [degree]: If the coordinate system of the images is the WGS84 geographic coordinate system.
X [m]: If the coordinate system of the images is in a coordinate system other than theWGS84 geographic coordinate system. The unit is given in meters.
X [feet]: If the coordinate system of the images is in a coordinate system other than theWGS84 geographic coordinate system. The unit is given in feet.
Local X [m]: If the coordinate system is defined by the user (local coordinate system). The unit is given in meters.

The coordinate columns are filled:

When importing the coordinates from the image EXIF data if the information is there.
When importing the coordinates from the image geolocation file.
When manually editing the table: double click on the corresponding cell and enter the coordinate.

Note:If no image geolocation has been imported then the value for the cells is zero (0).

Second coordinate

The second coordinate is:

Longitude [degree]: If the coordinate system of the images is the WGS84 geographic coordinate system.
Y [m]: If the coordinate system of the images is in a coordinate system other than theWGS84 geographic coordinate system. The unit is given in meters.
Y [feet]: If the coordinate system of the images is in a coordinate system other than theWGS84 geographic coordinate system. The unit is given in feet.
Local Y [m]: If the coordinate system is defined by the user (local coordinate system). The unit is given in meters.

The coordinate columns are filled:

When importing the coordinates from the image EXIF data if the information is there.
When importing the coordinates from the image geolocation file.
When manually editing the table: Double click on the corresponding cell and enter the coordinate.

Note:If no image geolocation has been imported then the value for the cells is zero (0).

Third Coordinate

The third coordinate is:

Altitude [m]: If the coordinate system of the images is the WGS84 geographic coordinate system.
Z [m]: If the coordinate system of the images is in a coordinate system other than theWGS84 geographic coordinate system. The unit is given in meters.
Z [feet]: If the coordinate system of the images is in a coordinate system other than theWGS84 geographic coordinate system. The unit is given in feet.
Local Z [m]: If the coordinate system is defined by the user (local coordinate system). The unit is given in meters.

The coordinate columns are filled:

When importing the coordinates from the image EXIF data if the information is there.
When importing the coordinates from the image geolocation file.
When manually editing the table: Double click on the corresponding cell and enter the coordinate.

Note:If no image geolocation has been imported then the value for the cells is zero (0).

Warning:
The Z coordinate must be given in the same unit as the (X,Y) coordinates (meters or feet).
All image geolocation has to be given in the same coordinate system.

Accuracy Horz

Defines the horizontal accuracy value(Accuracy Horz). The horizontal accuracy refers to the first and second coordinates (latitude, longitude, or X,Y) of the



images.

Very accurate image geolocation (latitude, longitude, or X,Y)coordinates: Low accuracy value.
Non accurate image geolocation (latitude, longitude, or X,Y) coordinates: High accuracyvalue.

The higher the accuracyvalue, the less influence the images coordinates will havein theInitial Processing,compared to other images or GCPs with lower
accuracyvalues.The accuracyis a value between 0.001 and 10'000.

Warning:The horizontal accuracymust be given in meters or feet according to the selected coordinate system.

To edit the horizontal accuracyof one image, double click on the corresponding cell and enter the new value.For more information about editing the horizontal
accuracyof multiple images, seeActions on the table.

Accuracy Vert

Defines the vertical accuracyvalue(AccuracyVert). The vertical accuracy refers to the third coordinate (altitude or Z) of the images.

Very accurate image geolocation (altitude or Z)coordinate: Low accuracyvalue.
Non accurate image geolocation (altitude or Z) coordinate: High accuracyvalue.

The higher the accuracyvalue, the less influence the images coordinate will have in theInitial Processing,compared to other images or GCPs with lower
accuracyvalues. The accuracyis a value between 0.001 and 10'000.

Warning:The vertical accuracymust be given in meters or feet according to the selected coordinate system.

To edit the vertical accuracyof one image, double click on the corresponding cell and enter the new value.For more information about editing the vertical
accuracyof multiple images, seeActions on the table.

Omega

Omega () is the rotation about the -axis. It is given in degrees.

The rotation columns are filled:

When importing the angles from the image geolocation file.
When manually editing the table: Double click on the corresponding cell and enter the angle.

This value is optional as Pix4Dmapper does NOT require the orientation of the camera in order to process the projects.
For more information about how Pix4Dmapper defines the Omega - Phi - Kappa angles:202558969.

Phi

Phi () is the rotation about the Y-axis. It is given in degrees.

The rotation columns are filled:

When importing the angles from the image geolocation file.
When manually editing the table: Double click on the corresponding cell and enter the angle.

This value is optional as Pix4Dmapper does NOT require the orientation of the camera in order to process the projects.
For more information about how Pix4Dmapper defines the Omega - Phi - Kappa angles:202558969.

Kappa

Kappa () is the rotation about the Z-axis. It is given in degrees.

The rotation columns are filled:

When importing the angles from the image geolocation file.
When manually editing the table: Double click on the corresponding cell and enter the angle.

This value is optional as Pix4Dmapper does NOT require the orientation of the camera in order to process the projects.
For more information about how Pix4Dmapper defines the Omega - Phi - Kappa angles:202558969.
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Access:On the Menu bar, click Project >GCP/Manual Tie Point Manager...

TheGCP/Manual Tie Point Managerpop up window has the following 3 sections:

GCP Coordinate System: Sectionto select thecoordinatesystem on which the GCPs/Manual Tie Points/Check Points position are based.
GCP/Manual Tie Point Table: Section to:
Import, edit, add and remove GCPs/Manual Tie Points/Check Points
Export GCPs/Check Pointscoordinatesand, optionally for GCPs, the accuracy of the coordinates.
Import or exporta file with the image coordinates of theGCPs/Manual Tie Points/Check Points and on which images have been marked, in which position and with
which zoom level.
GCP/Manual Tie Point Editor: Section to mark theGCPs/Manual Tie Points/Check Points on images.

And the action buttons:

OK:Confirms the changes.
Cancel:Does not save the changes.
Help:Opens the Pix4Dmapper help.

Index >Interface>Menu Project Previous|Next
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Access:On the Menu bar, click Project >GCP/Manual Tie Point Manager...

TheGCP Coordinate Systemsection is usedto define thecoordinatesystem on which the GCPs/Manual Tie Points/Check Points position are based.

Datum: Represents the selectedimages datum. By defaultthe selectedDatumis World Geodetic System 1984.
Coordinate system: Represents the selectedimages coordinate system. By default the selectedCoordinate systemisWGS 84.
Edit...: Opens theSelect GCP Coordinate Systempop up window that allows the user tochange the selected coordinate system.
For a full description about theSelectGCPCoordinate Systempop up window:202558239.
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Access:On the Menu bar, click Project >GCP/Manual Tie Point Manager...

This section contains aGCP/Manual Tie Pointtablewhich displays all theGCPs/Manual Tie Points/Check Pointsof the projects together with their properties, and5
action buttons:

Import GCPs...:Import a file with GCPs/Check points.
Export GCPs...: Export GCPs/Check Pointscoordinatesand, optionally for GCPs, the accuracy of the coordinates.
Add Point: Manually add one by one GCPs/Manual Tie Points/Check Points.
Remove Points:Remove the selected GCPs/Manual Tie Points/Check Points.
Import Marks...: Importa file with the image coordinates of theGCPs/Manual Tie Points/Check Points and on which images have been marked, in which position
and with which zoom level.
Export Marks...:Exporta file with the image coordinates of theGCPs/Manual Tie Points/Check Points and on which images have been marked, in which position
and with which zoom level.

In the bottom left side, a status text appears indicating how many GCPs are implemented in the project and marked in at least 2images.
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Access:On the Menu bar, clickProject >GCP/Manual Tie Point Manager...,onGCP/Manual Tie Point Table, click Import GCPs...

Pix4Dmapper can import a file with the image coordinates of the GCPs. For more information about the file format:202558539.

Warning:The zoom level at which GCPs are marked has an influence on the GCP error obtained in theQuality Report. Usually the higher the zoom level
is, the more precisely the GCP is marked. These GCPs will have more influence on the reconstructed model than GCPs marked with a low zoom level
and lower error values are expected for these GCPs. For example, when GCPs are marked without zooming into the images, the GCP error can be 10
times higher than when GCPs are marked by zooming into the images. The Bingo file format does not save the zoom level at which GCPs have been
marked.

When clickingImport GCPs..., theImport Ground Control Pointspop-up appears:

It contains the following sections:

Coordinates Order:Allows to selected the coordinates order of the file to be imported. Two possibilities : Latitude, Longitude, Altitude or Longitude, Latitude,
Altitude.
File: Displays the name of the selected file to be imported.

And the action buttons:

Browse: Opens the Select GCPs File, a navigation window used to search for and select the file to be imported.

Open: Imports the selected file.
Cancel: Does not import the fileand exits the pop-up.
Help:Opens the Pix4Dmapper help.
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Access:On the Menu bar, click Project >GCP/Manual Tie Point Manager..., onGCP/Manual Tie Point Table, click Add Point.

This button is used to manually add GCPs/Manual Tie Points/Check Pointsone by one.

Note:Before adding the points, their coordinate system needs to be defined. For more information:202557749.

Warning:All GCPs/Manual Tie Points/Check Pointsneed to be defined in the same coordinate system.

When clickingAdd Pointa new point is added to the GCP/Manual Tie Point Table. This point type is by default set to Manual Tie Point. The label is automatically
generated and starts by "mtp" followed by a numberthat increases with the number of points added (e.g. mtp1, mtp2, mtp3, etc.). The labels are automatically
generated when adding a point in the GCP/Manual Tie Point Managerby pressing theAdd Pointbutton or when adding a point or an object in the rayClou. The point
type can be changed by double clicking on the Type cell and selecting the desired type.

For more information about theGCP/Manual Tie Point Tableproperties:202557919.

Index >Interface>Menu Project>GCP/Manual Tie Point Manager...>GCP/Manual Tie Point Table Previous|Next

https://support.pix4d.com/hc/en-us/articles/202557919


Index >Interface>Menu Project>GCP/Manual Tie Point Manager...>GCP/Manual Tie Point Table Previous|Next

Access:On the Menu bar, clickProject >GCP/Manual Tie Point Manager...,onGCP/Manual Tie Point Table, clickRemove Points.

The Remove Points buttonallows the user to remove already imported GCPs/Manual Tie Points/Check Pointsthat are displayed on the GCP/Manual Tie Point
Table: select one or multiple points to be removed on theGCP/Manual Tie Point Tableand clickRemove Points. For more information about how to select point on
theGCP/Manual Tie Point Table:202557919.

The removed points are removed from the project.
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Access:On the Menu bar, click Project >GCP/Manual Tie Point Manager..., onGCP/Manual Tie Point Table, click Import / Export Marks...

Import Marks...

Pix4Dmapper can import a file with the image coordinates of the GCPs. For more information about the file format:202558539.

Warning:The zoom level at which GCPs are marked has an influence on the GCP error obtained in theQuality Report. Usually the higher the zoom level
is, the more precisely the GCP is marked. These GCPs will have more influence on the reconstructed model than GCPs marked with a low zoom level
and lower error values are expected for these GCPs. For example, when GCPs are marked without zooming into the images, the GCP error can be 10
times higher than when GCPs are marked by zooming into the images. The Bingo file format does not save the zoom level at which GCPs have been
marked.

When clickingImport Marks..., theImport Image Marks from File pop-up appears:

It contains the following sections:

File Format:The only option that can be selected is Bingo Text File.
Sensor Width [mm]: Allows the user to enter the sensor width of the camera.If the bingo file that is going to be imported has the image coordinates of the GCPs
in mm, then the default values that describe the sensor width in mm should be maintained. If the image coordinates are in pixels, then the sensor width should be
given in pixels.
Sensor Height [mm]:Allows the user to enter the sensor height of the camera.If the bingo file that is going to be imported has the image coordinates of the GCPs
in mm, then the default values that describe the sensor height in mm should be maintained. If the image coordinates are in pixels, then the sensor width should
be given in pixels.

https://support.pix4d.com/hc/en-us/articles/202558539


File:Displays the name of the selected file.

And the action buttons:

Browse...: Opens the Select Images Marks File pop-up that allows the user to navigate, select, and import the file.
OK:Confirms the changes.
Cancel:Does not save the changesand exits the pop-up..
Help:Opens the Pix4Dmapper help.

Export Marks

Once the GCPs are marked on the images, Pix4Dmapper can export the image coordinates of the GCPs. This optionallows the user to use the same GCPs with
the same images the next time the project has to be processed (e.g. merging with another project, adding new images to the current project) without having to
manually mark again the GCPs.

Warning:The zoom level at which GCPs are marked has an influence on the GCP error obtained in theQuality Report. Usually the higher the zoom level
is, the more precisely the GCP is marked. These GCPs will have more influence on the reconstructed model than GCPs marked with a low zoom level
and lower error values are expected for these GCPs. For example, when GCPs are marked without zooming into the images, the GCP error can be 10
times higher than when GCPs are marked by zooming into the images.The Bingo file format does not save the zoom level at which GCPs have been
marked.

When clickingExport Marks..., the Select Image Marks File pop-up appears:

Navigation menu, to select the location to store the file.
OnFile name,type the name of the file.
The Save as type displays the file format used to save the file. Only theBingo format text file (*.txt) format can be selected.
Save:Saves the file.
Cancel: Doesnot save the file and exits the pop-up.

A Bingo format text file (.txt) file will be created.For more information about this file:204689545.

Index >Interface>Menu Project>GCP/Manual Tie Point Manager...>GCP/Manual Tie Point Table Previous|Next

https://support.pix4d.com/hc/en-us/articles/204689545
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Access:On the Menu bar, click Project >GCP/Manual Tie Point Manager...

Allows to mark /edit the marks of the GCPs/Manual Tie Points/Check Points in the initial images.There are 2 options:

rayCloud Editor...: Enabled if at least step 1 has been completed, opens the rayCloud.
Basic Editor...: Enabled even if no steps has been completed, opens the Basic GCP/Manual Tie Points Editor.

Index >Interface>Menu Project>GCP/Manual Tie Point Manager... Previous|Next
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Access: On the Menu bar, click Project > GCP/Manual Tie Point Manager..., the GCP/Manual Tie Point Manager window opens, in the GCP/Manual Tie
Point Editor section, click Basic Editor...

The Basic GCP/Manual Tie Point Editor pop-up has the following 3 sections:

GCP/Manual Tie Point Table: Section that allows the user to edit the GCPs/Manual Tie Points/Check Points values and status.
Images: A list with all the images.
Preview: Section where the GCPs/Manual Tie Points/Check Points are marked on the image.

And the action buttons:

GCP/Manual Tie Point Manager: Closes the Basic GCP / Manual Tie Point Editor and goes back to the GCP/Manual Tie Point Manager.
OK: Confirms the changes.
Cancel: Does not save the changes and exits the pop-up.
Help: Opens the Pix4Dmapper help.
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Access: On the Menu bar, click Project > GCP/Manual Tie Point Manager..., the GCP/Manual Tie Point Manager window opens, in the GCP/Manual Tie
Point Editor section, click Basic Editor...

This section allows the user to edit the GCPs/Manual Tie Points/Check Points, values and status.

 

Next to the section title Ground Control Points, the coordinate system of the GCPs is displayed.

This section contains a Ground Control Points table which displays all the GCPs of the projects together with their properties.
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https://support.pix4d.com/hc/en-us/articles/202557919
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Access: On the Menu bar, click Project > GCP/Manual Tie Point Manager..., the GCP/Manual Tie Point Manager pop-up opens, in the GCP/Manual Tie
Point Editor section, click Basic Editor...

This section displays a list of all the project images. 

For each selected point on the Ground Control Points section, the Images section shows with:

Green color: The images on which the point has been marked.
Black color: The images on which the point has not been marked.

 

The images can be sorted according to three different criteria by clicking on the corresponding buttons:

 Sort images by name.
 Sort images by the distance to GCP.
 Sort images by the distance to the clicked images.

There is one context menu for the Images section that can be accessed by right clicking on one image. The context menu gives access to the following action:

Remove Mark: Deletes the marked point that appears on this image.

 

Sort images by name

The images are sorted alphabetically by name.  

 



 
Sort images by the distance to GCP

The images are sorted by distance to the GCP (closest image to the GCP is displayed first).  This sorting is selected by default when 2D GCPs, 3D GCPs or
Check points have been imported into the project. This sorting is recommended to easily find images on which GCPs or Check points may appear.

Note: Non geolocated images are displayed at the bottom of the list.

 

Sort images by distance to the clicked images

The images are sorted by distance to the clicked images (closest image to the clicked images is displayed first). This sorting is recommended to easily find
images on which Manual Tie Points appear. It can be used after having marked the tie point on at least one image.

Note: Non geolocated images are displayed at the bottom of the list.
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Access: On the Menu bar, click Project > GCP/Manual Tie Point Manager..., the GCP/Manual Tie Point Manager pop-up opens, in the GCP/Manual Tie
Point Editor section, click Basic Editor...

This section is used to mark the GCPs/Manual Tie Points/Check Points on the images.

Important: To be taken into account in the project, each point needs to be marked on at least 2 images, it is recommended to mark each point in at least
4-5 images.

Important: The zoom level at which GCPs are marked has an influence on the GCP error obtained in the Quality Report. Usually the higher the zoom
level is, the more precisely the GCP is marked. These GCPs will have more influence on the reconstructed model than GCPs marked with a low zoom
level and lower error values are expected for those GCPs. For example, when GCPs are marked without zooming into the images, the GCP error can be
10 times higher than when GCPs are marked by zooming into the images.

 

When the Basic GCP/Manual Tie Point Editor is opened the first time, no image is displayed in the Preview section. Once points are imported from a file or once
a new point has been added, the first image is displayed in the Preview section. 

The following actions are available:

Zoom in: Move the mouse scroll wheel forwards.
Zoom out: Move the mouse scroll wheel backwards.
Pan: Press the left mouse button and move the mouse.
Zoom in quickly to a specific point: With the mouse click on the point of interest and press the Alt key.
Zoom out instantly to zero zoom level: Press the Shift key.
Mark a point: Left click on the point on the image.

 

 

 



 

In the right part of the Preview section there is a control panel to navigate in the image:

Left arrow button: Moves to the left part of the image (when the image is zoomed in).

Right arrow button: Moves to the right part of the image (when the image is zoomed in).

Up arrow button: Moves to the top part of the image (when the image is zoomed in).

Down arrow button: Moves to the bottom part of the image (when the image is zoomed in).

Reset view button:  Zooms out to zero zoom level.

Zoom in button: Zooms in.

Zoom slider: Zooms in or out.
In: Move the slider up.
Out: Move the slider down.

Zoom out button: Zooms out.

Remove button: Removes the marked point (if any) from the image that is currently displayed in the Preview section. 
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Access: On the Menu bar, click Project > Select Output Coordinate System...

Important: The output coordinate system does not need to be the same as the images coordinate system or as the GCPs coordinate system. By default
the output coordinate system is the same as for the GCPs if GCPs are used, otherwise it is the same as for the images. If the coordinates system is
WGS84, the output is given in UTM.

If less than 3 images are geolocated and less than 3 GCPs are defined, then the output coordinates system is always "Local".

The Select Output Coordinate System pop-up allows the user to choose the coordinate system of the outputs.

 

For a full description about the Select Output Coordinate System pop-up: 202558239.
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Access: On the Menu bar, click Process.

The Process menu has seventeen items that can be selected:

Upload Project Files: Displays the Files Upload pop-up.
Local Processing: Displays the Local Processing menu in the Main window .
Reoptimize: Reoptimizes the camera positions using information from GCPs/ Manual tie points that are added after step.1 Initial Processing.
Rematch and Optimize: Computes more matches between the images (and therefore more Automatic Tie Points) and reoptimizes the internal and external
camera parameters.
Quality Report...: Opens the Quality Report in a new window.
Open Results Folder: Opens an explorer window with the path where the project outputs and .p4d file are stored.
Generate Quality Report: Generates a new Quality Report that refers to the new reconstruction obtained after applying changes to the project after step.1 Initial
Processing.
Save Undistorted Images: Generates and saves an undistorted copy of each original image using the optimized distortion camera parameters.
Run Terrain/Object Point Cloud Classification (beta): Generates a DTM point cloud (terrain Point Cloud) and an Objects Point Cloud.
Generate 3D Textured Mesh: Generates a 3D Textured Mesh based on triangles using a a simplified Densified Point Cloud.
Generate DTM (beta): Generates a DTM using the points from the Terrain class.
Import Point Cloud for DSM Generation...: Allows the user to import a point cloud that will be used to generate the DSM and orthomosaic.
Generate Google Maps Tiles, KML and Mapbox Tiles: Generates Google Maps tiles, a Google Earth KML file and Mapbox tiles for the orthomosaic.
Generate Contour Lines: Generates the contour lines specified in the Processing Options using the raster DSM.
Options...: Opens a pop-up that allows the user to set processing options.
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Access:On the Menu bar, click Process > Upload Project Files...(active once a project hasbeenloaded or created).

The File Uploadpop-upappears,which allows the user to:

Upload and process a project to Pix4D's servers.
Upload Files toMapbox.

Upload and process a project toPix4D's servers
TheUpload Projectwindow contains 2 sections:

Upload Files
Progress

and the action buttons:

Close:Closes the window.
Help: Opens the Pix4Dmapper help.

Upload Files

The Upload Filessection contains the following check boxes:

Project and Images Files: To upload the .p4d file and the images of the project.
Start Processing: To start processing onPix4D's servers. It is enable when the Project and Images Files has been selected. For more informationand step by
step instructions:202558589.

Note: When sending a project to Pix4Dmapper Support Team, there is no need to Start Processing.

Log File (.log):To upload the log file of the project.
Quality Report (.pdf): To upload the quality report of the project.
Google Maps and KML Files: To upload the Google Maps and kml files of the project.
DSM Files (.tif): To upload the DSM files of the project.
Point Cloud Files (las): To upload the point cloud filesof the project.
Reflectance Map Files (.tif): To upload the reflectance map fileof the project.

Note: The check boxes are enabled if the corresponding files have been generated.

Progress

The Progress section contains:

Progress bar:Displays the upload status in percentage.
Upload:Allows the user to upload the selected files to the cloud.
Cancel:Cancels the upload.

Note:When the project is uploading,the following information is displayed:
MB already uploaded.
Total MB to be uploaded for the project.
Estimatedtime remaining.
Uploading speed.

Upload Files toMapbox

https://support.pix4d.com/hc/en-us/articles/202558589


Note:In order to Upgrade a Mapbox Account with a Pix4D Coupon Code:202560709.

TheUpload Projectwindow contains 2 sections:

Account
Progress

and the action buttons:

Close:Closes the window.
Help:Opens the Pix4Dmapper help.

Account

It displays:

A new authorization will be requested: If no Mapbox account is logged in.
Upload to "USER" Mapbox account: If a Mapbox account is already logged in Pix4Dmapper.

And the buttonChange: Allows to log out in Pix4Dmapper the associated Mapbox account.

Progress

The Progress section contains:

Progress bar:Displays the upload status in percentage.
Upload:Allows the user to upload the selected files to the cloud.
Cancel:Cancels the upload.

Note:When the project is uploading,the following information is displayed:
MB already uploaded.
Total MB to be uploaded for the project.
Estimatedtime remaining.
Uploading speed.

Index>Interface> Menu Process Previous|Next

https://support.pix4d.com/hc/en-us/articles/202560709
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Access: On the Menu bar, click Process > Local Processing (enabled once a project has been loaded or created). The Local Processing Sidebar is
displayed on the bottom of the Main window.

For information about the sidebar's display possibilities: 202558389.

This opens the Local Processing sidebar at the bottom of the Main window which allows the user to process a project on the user's computer.

The Local Processing menu contains 2 sections:

Processing
Progress

 

Processing

The Processing section contains 3 sub-sections:

1. Initial Processing: Automatically extracts keypoints from the images to compute the true location and parameters of the original images using the software's
advanced Automatic Aerial Triangulation (AAT) and Bundle Block Adjustment (BBA). An initial cloud of 3D points is computed and a low resolution DSM and
orthomosaic are generated and displayed in the Quality Report. For more information about the files generated during initial processing: 202558519.

Warning: When reprocessing this step for a project, the existing outputs from this step are deleted and overwritten and outputs from steps 2 and 3
(if previously completed) are deleted.

2 options are available:

Full Processing: Provides the highest accuracy.
Rapid Check: Only recommended for use in the field to ensure the quality of the dataset.

The Rapid Check processing reduces the resolution of the input images to 1024 x 768 pixels on which the keypoints / features are extracted. Therefore it is
faster, but it lowers the global accuracy and may lead to incomplete results.

Rapid Processing does not re-match images for optimization. For more information: 202557759.
2. Point Cloud Densification: Densifies and filters the initial 3D point cloud. For more information about the files generated during the Point Cloud Densification
step: 202558549.

Warning: When reprocessing this step for a project, the existing outputs from this step are deleted and overwritten and outputs from step 3 (if
previously completed) are deleted.

3. DSM and Orthomosaic Generation: Generates the DSM and Orthomosaic. For more information: 202558559.

Warning: When reprocessing this step for a project, the existing outputs from this step are deleted and overwritten.

The following option is available:

Resolution [cm/pixel]: The text box contains the spatial resolution used to generate the DSM and Orthomosaic.

Note: If auto is typed in, the mean resolution computed during Initial Processing is used.

The Processing section contains the buttons:

Start: Starts to process the selected steps.
Options...: Opens the Processing Options pop-up.

Warning: DO NOT modify the processing options unless you have read the following section: Menu Process > Options.

 

 

 

 

 

 

https://support.pix4d.com/hc/en-us/articles/202558389
https://support.pix4d.com/hc/en-us/articles/202558519
https://support.pix4d.com/hc/en-us/articles/202558549
https://support.pix4d.com/hc/en-us/articles/202558559


Help: Opens the Pix4Dmapper help.

 

Progess

The Progress section contains the following elements:

Progress bar: Displays the processing status of each sub-step as percentage.
Cancel: Cancels the processing. The button is enabled when the project is processing.

Note: When the project is processing, the step that is currently processed is displayed on the left of the progress bar. On the right of the Cancel button
information about the step that is currently running is displayed.

 

Index > Interface > Menu Process  Previous  |  Next  

 



Index > Interface > Menu Process  Previous  |  Next  

 

Access: On the Menu bar, click Process > Reoptimize (enabled once step 1. Initial Processing has been completed).

 

This feature reoptimizes the camera positions and the internal camera parameters. It should be used when changes have been applied to the project after
step 1. Initial Processing has been completed. Such changes can be:

Adding GCPs.
Adding Manual Tie points.
Adding Check points.
Changing coordinate systems.
Enabling/disabling images.

Important: Cameras not calibrated will not be taken into account: Images that were discarded are not used, and therefore, these images will not be
calibrated, in order to calibrate uncalibrated cameras: 202560189.

Warning: 
Results generated from step 1. Initial Processing are overwritten.
The Quality Report is deleted. To generate a new Quality Report: 202558319. 
If step 2. Point Cloud Densification and step 3. DSM and Orthomosaic Generation have been done as well, their results are removed. These results need
to be saved by the user in order not to lose them.
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Access: On the Menu bar, click Process > Rematch and Optimize (enabled once step 1. Initial Processing has been completed).

 

This feature computes more matches between the images (and therefore more Automatic Tie Points) and reoptimizes the internal and external camera
parameters. It is recommend to use it:

After manually calibrating cameras that were not initially calibrated.
For difficult projects where few matches were initially found.
To merge individual projects that do not share common images.
To optimize the step 1. Initial Processing by re-matching images. For projects with more than 500 images, this option is unselected and disabled in the
processing options. 

Note: For large projects (more than 500 images), the Rematch and Optimize feature significantly increases the processing time.

Important: Cameras not calibrated will not be taken into account: Images that were discarded are not used, and therefore, these images will not be
calibrated, in order to calibrate uncalibrated cameras: 202560189.

Warning: 
Results generated from step 1. Initial Processing are overwritten.
The Quality Report is deleted. To generate a new Quality Report: 202558319.
If step 2. Point Cloud Densification and step 3. DSM and Orthomosaic Generation have been done as well, their results are removed. These results need
to be saved by the user in order not to lose them.
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Access: On the Menu bar, click Process > Quality Report... (active once step 1. Initial Processing has been completed). It opens the Quality Report in a
pop up window.

Important: 
For a detailed description about how to analyze the Quality Report: 202558689.
For a detailed description about any parameter described in the report: 202558679.
For a description about how to analyze the Rapid Check Quality Report: 202557509.
For a description about how to analyze the Full Processing Quality Report: 202557339.
Example of a Quality Report available at the following link: Quality Report.

 

 

https://support.pix4d.com/hc/en-us/articles/202558689
https://support.pix4d.com/hc/en-us/articles/202558679
https://support.pix4d.com/hc/en-us/articles/201540635
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Access: On the Menu bar, click Process > Generate Quality Report (enabled once step 1. Initial Processing has been completed).

 

This feature generates a new Quality Report that refers to the new reconstruction obtained after applying changes to the project once step 1. Initial
Processing has been completed. Such changes can be:

Adding GCPs.
Adding Manual Tie points.
Adding Check points.
Changing coordinate systems.
Enabling/disabling images.
Running the Rematch and Optimize option.

Important: When adding GCPs, Manual Tie points, Check points, changing coordinate systems or enabling/disabling images, the Reoptimize option has
to be applied before generating the new Quality Report.
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Access: On the Menu bar, click Process > Save Undistorted Images (active once step 1. Initial Processing has been completed).

This feature generates an undistorted copy of each original image using the optimized distortion parameters of the selected camera model.

Important: 
This feature is available only when processing images using a perspective lens camera model.
The undistorted images will only be generated for the calibrated images..

It is possible to configure the processing options to automatically generate the undistorted images at the end of the step 1. Initial Processing:

1. On the Menu bar, click Process > Options... and select the Initial Processing tab.
2. On the section Output, activate the checkbox Undistorted Images and click OK.

Information: For more information about the camera distortion: 202559069.

  

Original image: The square grid is distorted because of the lens of the camera. Undistorted image: The square grid is now perfectly aligned.

Figure 1.
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Access: On the Menu bar, click Process > Run Terrain/Object Point Cloud Classification (beta) (active once step 2. Point Cloud Densification has been
completed).

Important: By default it is not computed when processing the step 2. Point Cloud Densification. But it is possible to compute the classification
while processing the step 2. Point Cloud Densification. For step by step instructions: 203186589

This feature computes a Point Cloud Classification using the unclassified points and not using the deleted points of the Densified Point Cloud, classifying each
point into a Terrain / Objects Class.

Terrain Class: It consists of terrain points. 
Objects Class: It consists of object points.

It is possible to set up classification parameters, available on the processing options: 202557799.

For step by step instructions about how to compute the Point cloud Classification: 203186589. 

Important: It is possible to edit the computed terrain / objects classification and move points from one class to another, delete them, move them into a
new class, etc, for step by step instructions: 202560499.

Note: Once a Terrain Point Class exist, it is possible to generate a DTM (beta), for step by step instructions: 203204259.
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https://support.pix4d.com/hc/en-us/articles/203186589
https://support.pix4d.com/hc/en-us/articles/203186589
https://support.pix4d.com/hc/en-us/articles/202560499
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Access: On the Menu bar, click Process > Generate 3D Textured Mesh (active once step 2. Point Cloud Densification has been completed).

Important: The 3D Textured Mesh cannot be generated when selecting Use Semi Global Global Matching (beta). This option is available on the Menu
bar, by clicking Process > Options... and selecting the tab Point Cloud. For more information: 202557799.

 

This feature generates a 3D Textured Mesh based on triangles using a a simplified Densified Point Cloud. 

Important: By default, while processing the step 2. Point Cloud Densification,  the following 3D Textured Mesh files are generated: 
Only readable in the rayCloud (and always generated):
projectname\2_densification\project_data\projectname_3d_mesh.p4b
In .obj format (can be disabled in the processing options)
projectname\2_densification\3d_mesh\projectname_simplified_3d_mesh.obj

By clicking Process > Generate 3D Textured Mesh, by default it will be generated a 3D Textured Mesh in .p4b and .obj format.

In order to do not generate the .obj file and/or generate other outputs (.ply, .pdf) before processing step 2. Point Cloud Densification, or
before clicking Process > Generate 3D Textured Mesh, change the processing options and click OK. For more information: 202557799.

For step by step instructions: 202560669

Important: The 3D Textured Mesh will be generated using the Densified point cloud. If any point cloud densification area and/or image annotations are
defined, and if the corresponding options are selected in the Point Cloud Filters options, they will also be used to generate the 3D Textured Mesh. 

These options are available on the Menu bar, by clicking Process > Options... and selecting the tab Point Cloud. For more information: 202557799.

 

 

 

 

https://support.pix4d.com/hc/en-us/articles/202560669


3D Textured Mesh
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Access: On the Menu bar, click Process > Generate DTM (beta) (active once step 2. Point Cloud Densification has been completed) and the class
Terrain exist and contains points.

Note: The class terrain can be generated automatically by using Compute Point Cloud Classification (beta). For step by step instructions: 203186589.

This feature generates a DTM using the points from the Terrain class.

DTM

 

 

https://support.pix4d.com/hc/en-us/articles/203186589
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Access: On the Menu bar, click Process > Import Point Cloud for DSM Generation... (active once step 1. Initial Processing has been completed).

 

This feature allows the use to import a point cloud to visualize in the rayCloud and/or to generate the DSM and orthomosaic.

Once the point cloud has been imported, step 3. DSM and Orthomosaic Generation has to be started to generate the DSM and orthomosaic.

It opens the Select Point Cloud pop-up, which allows to navigate to the path where the point cloud to import is stored and select it.

The accepted formats are: 

.xyz

.las

.laz

Contains the action buttons:

OPEN: Confirms the importation of the selected file.
Cancel: Does not import any file and close the pop-up.

Warning: 
The external point cloud needs to be in the same coordinate system as the output coordinate system.
If step 3. DSM and Orthomosaic Generation has already been completed for this project, existing results are overwritten when running the step again.
The existing results need to be saved by the user in order not to lose them.

Important: 
If step 2. Point Cloud Densification has been completed, its results are not used for the DSM and Orthomosaic generation.
The imported Point Cloud will be used to generate the DSM.
The original images are projected into the DSM in order to obtain the Orthomosaic.
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Access: On the Menu bar, click Process > Generate Google Maps Tiles, KML and Mapbox Tiles (active once step 3. DSM and Orthomosaic Generation
has been completed).

 

This feature generates the Google Maps tiles and KML files for the orthomosaic.

Important: 
When images are grouped in more than one group, the Google Maps Tiles and KML will only be generated if one of the groups is named RGB (in capital
letters). Then the Google Maps Tiles and KML will be generated only for this group. For more information about the image groups: 202557949.
The Google Maps Tiles and KML are only generated for 3 band with 8 bit per band images.
The Google Maps tiles and KML will only be generated for projects with georeference (image geolocation or GCPs).

For more information about where the Google Maps tiles and the KML Google Earth are stored, and how to use them: 202558499.

It is possible to configure the processing options to automatically generate the Google Maps tiles and KML files and / or the Mapbox tiles for the orthomosaic when
executing step 3. DSM and Orthomosaic Generation, following:

1. On the Menu bar, click Process > Options... and select the tab DSM and Orthomosaic Generation.
2. In the Orthomosaic section, activate the checkbox Google Maps tiles and KML and click OK.

 

 

https://support.pix4d.com/hc/en-us/articles/202558499


 



Figure 1. KML into Google Earth

Figure 2. Google Maps Tiles
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Access: On the Menu bar, click Process > Generate Contour Lines (active once step 3. DSM and Orthomosaic Generation has been completed and if
any Contour Lines format is selected in the processing options. For step by step instructions: 202560639.

This option generates contour lines using the Raster DSM. For more information about contour lines: 202559879.

Note: 
If contour lines with the same Elevation Interval are already generated, they will be overwritten.
If the Contour Lines processing options have been configured when executing step 3. DSM and Orthomosaic Generation, the Contour Lines will be
generated automatically when running step 3.

Contour lines
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Access:On the Menu bar, clickProcess >Options...,a pop-up with 6 tabs appears.

Initial Processing Point Cloud DSM and Orthomosaic Additional Outputs Index Calculator Resources

This tab allows the user to change the processing options and desired outputs for step1. Initial Processing.It contains4 sections:

Processing: Allows the user to define the type of project to be processed.
Feature Extraction:Allowsthe userto set the image scale at which features are computed.
Optimization: Allowsthe userto set some parameters for the optimization procedure.
Output: Allows the userto select the desired outputs.

And 5actions:

OK:Confirms the changes.
Cancel:Does not save the changes.
Help:Opens the Pix4Dmapper help.
Set as Default Options:Saves the current settings of all Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and Orthomosaic Generation,
Additional Outputs, Resources), except the options of the sectionProcessingin theInitial Processingtab (Aerial nadir,Alternative processing mode,Aerial oblique or
terrestrial), as default options for future projects.
ToSet as default options: Select the check box.
Reset Options:Resets to the Pix4Dmapper default options for all the Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and
Orthomosaic Generation, Additional Outputs,Resources).

Processing

This section allows the user to define which type of project is going to be processed. The chosen project type has an influence on the initial processing as well as
on the results that are generated. The following project types are available:

Aerial Nadir(default):Recommended for images taken from the air and with the camera pointing to the nadir direction. The images can be taken by UAV, manned
aircraft, balloon, etc. Pointing to the nadir means that the camera axis (in the direction of the lens) is perpendicular to the ground.A point cloud as well as a DSM



and orthomosaic will be generated at step2. Point Cloud Densification and step3. DSM and Orthomosaic Generation.
Alternative Processing Mode:Recommended for processing aerial nadir images of projects where the ground is essentially flat. It is recommended for farming and
forestry applications with repetitive structures (crop fields). This option requires good image geolocation.

Example:The Alternative Processing Mode type can be used when the objects look essentially flat. For example, it can also be used for forests/trees if
the images are taken from a high altitude in such a way that small differences between the trees heights do not affect the Alternative processing mode.
Other cases for which this type of project is recommended:
Uniform grass
Sand
Ice

Aerial Oblique or Terrestrial: Recommended for oblique images taken from the air, as well as for images (oblique or nadir) taken from the ground.Oblique images
are the images that are taken with the camera axis not perpendicular to the ground. Only the point cloud will be generated at step2. Point Cloud Densification.

Important:When theAerial Oblique or Terrestrialtypeis selected, neither the DSM nor the orthomosaic are generated. The step 3.DSM and Orthomosaic
Generation cannot be selected and processed. To generate the DSM and the orthomosaic, it is recommended to process using the Aerial nadir mode.

Feature Extraction

The Feature Extractionsectionallows the user to set the image scale at which features are computed.It is possible to select:

1 (Original image size, default): This is the recommended image scale value.
2 (Double image size):For small images (e.g. 640x320 pixels), a scale of 2 (double size images) should be used. More features will be extracted and it will
have a positive influence on the accuracy of results.
1/2 (Half image size): For large projects with high overlap, half size images can be used to speed up processing (note that this will usually result in a slightly
reduced accuracy as less features will be extracted). This scale is also recommended for blurry or low textured images. It usually results in better outputs
than the default scale for such images.
1/4 (Quarter image size):For very large projects with high overlap, quarter size images can be used to speed up processing (note that this will usually result
in a slightly reduced accuracy as less features will be extracted).This scale is also recommended for very blurry or very low textured images. It usually
results in better outputs than the default scale for such images.

Optimization

The optimization step consists in running the Automatic Aerial Triangulation (AAT), Bundle Block Adjustment (BBA), and camera self-calibration steps multiple
times, until an optimal reconstruction is found. Two parameters can be set for the optimization step:

Optimize Parameters: This parameter defines which camera parameters are optimized.
Rematch Images: This parameter allowsthe user to compute more matches between the images.

Optimize Parameters

TheOptimize parametersprocessing optiondefines which camera parameter are optimized. There are two type of camera
parameters:

Internal camera parameters: The parameters of the camera model.
External camera parameters: The position and orientation of the cameras.

The optimization procedure starts from initial values in order to compute the optimized values. The following initial values are used:

Internal camera parameters: The values are taken from the camera model that has been chosen.
External camera parameters:The values are taken from the Automatic Aerial Triangulation (AAT) during Step1. Initial Processing.

After step1. Initial Processinghas been done, the optimized values for the internal and external parameters are saved to file. For more
information about the output files generated after step 1. Initial Processing:202558519.

Note:The initial and optimized values for the internal camera parameters are also displayed in theQuality Report.

TheOptimize parametersdrop-down list allows the user to select which camera parameters are optimized:

Optimize Externals and All Internals(default): Optimizes the external camera parameters and all internal parameters. Small
cameras such as those used with UAVs, are much more sensitive to temperature or vibrations, which influences the camera
calibration. Therefore it is recommended to select this option when processing images taken by such cameras.
Optimize Externals Only: Optimizes only the external camera parameters. This is recommended when using large cameras that are
already calibrated and when these calibration parameters should be used.
Optimize Externals and Leading Internals:Optimizes the external parameters and the most important internal parameters. The
leading parameters are:
Perspective lens camera models: The focal length and the first two radial distortion parameters.
Fisheye lens camera models: The polynomial coefficients.

This option is useful to process certain cameras such as cameras with a slow rolling shutter speed.

https://support.pix4d.com/hc/en-us/articles/202558519


Rematch Images

This option adds more matches after the first part of the initial processing, which usually improves the quality of the reconstruction. It is
recommended to use this option for projects with vegetation and forestry.

Note:For large projects of more than 500 images, this option is unselected and disabled. To rematch the images, the
Rematch and optimize tool has to be used:202558309.

Output

This section allows the user to select the desired outputs. It is possible to generate:

Camera Internals and Externals, AAT, BBA: When this option is selected, the results of the AAT, BBA, and optimized internal and external camera
parameters are saved into files.
Undistorted Images: This feature generates an undistorted copy of eachoriginalimage using the optimized distortion parameters of the selected camera
model.

Important:This feature is available only when processing images using a perspective lens camera model.

If step1. Initial Processinghas already been done, it is possible to generate undistorted images without running step 1 again. For more
information:202557929.

Information:For more information about the camera distortion:202559069.

Low Resolution (8 GSD) Orthomosaic: This feature generates a low spatial resolution DSM and orthomosaic (in GeoTIFFformat). A merged file as well as tiles are
generated for both outputs. This DSM and orthomosaic have a GSD that is equal to 8 times the GSD of the original images.

Example:If the original images have an average GSD of 5 cm, then the low resolution DSM and orthomosaic will have a GSD of 40 cm.

The low resolution DSM is generated using the Automatic Tie Points. The low resolution orthomosaic is generated using an algorithm similar to the
orthomosaic algorithm of step 3. DSM and Orthomosaic Generation (Process > Options... > DSM and Orthomosaic Generation > Orthomosaic). For more
information about the available options / algorithms:202559429.

Note:When processing images that belong to different groups, all images are processed together, generating only one DSM for the whole project,
but generating one orthomosaic per group using the images associated to that group. For more information about the image groups:202557949.
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Access:On the Menu bar, clickProcess >Options...,a pop-up with 6 tabs appears.

Initial Processing Point Cloud DSM and Orthomosaic Additional Outputs Index Calculator Resources

This tab allows the user to change the processing options and desired outputs for step 2. Point Cloud Densification. This stepincreases the density of 3D points
of the 3D model computed in step 1. Initial Processing, which leads to a higher accuracy for both the DSM and orthomosaic. After densification, the point cloud is
filtered. This tab contains3 sections:

Point Cloud Densification: Allows the user to define parameters for the point cloud densification.
Point Cloud Filters: Allows the user to consider manual image annotations or the point cloud densification area (if exists).
Point Cloud Classification:Allows the user to run the Terrain/Object Point Cloud Classification while processing the 2. Point Cloud Densificationand allows to set
up parameters used when computing the Point Cloud Classification. The Point Cloud Classification classifies the Filtered Point Cloud into two point clouds, the
Terrain Point Cloud and the Objects Point Cloud. The Terrain Point Cloud can be used to generate a DTM.
3D Textured Mesh Generation:Allows the user to generate the 3D Textured Meshwhile processing step2. Point Cloud Densificationand allows to set up the
parameters to use for the generation.
Output: Allows the user to select the desired output formats for the densified point cloud and 3D TexturedMesh.

And 5actions:

Set as Default Options:Saves the current settings of all Processing Options tabs(Initial Processing, Point Cloud, DSM and Orthomosaic, Additional
Outputs,Resources), except the options of the section Processing in theInitial Processingtab (Aerial nadir, Alternative processing mode, Aerial oblique or
terrestrial), as default options for future projects.
To Set as default options: Select the check box.
Reset Options:Resets to the Pix4Dmapper default options for all the Processing Options tabs(Initial Processing, Point Cloud, DSM and Orthomosaic, Additional
Outputs,Resources).
OK:Confirms the changes.
Cancel:Does not save the changes.
Help:Opens the Pix4Dmapper help.



Point Cloud Densification

This section allows the user to set parameters for the point cloud densification. It contains the following options:

Image Scale: The image scale defines the scale of the image on which additional 3D points are computed. From the drop-down list, it is possible to select:
1/2 (Half image size, Default): Half size images are used to compute additional 3D points. It is the recommended image scale.
1 (Original image size, Slow):The original image size is used to compute additional 3D points. More points are computed than with half image scale, especially in
areas where features can be easily matched (e.g. cities, rocks, etc.). This option may require four times more RAM and time than when choosing the default
value 1/2 (half image size), and usually does not significantlyimprove the results.
1/4 (Quarter image size, Fast):Quarter size imagesare used to compute additional 3D points. Less points are computed than with the half image scale. However,
more points are computed in areas with features that cannot easily be matched such as vegetation areas. This scale is recommended for projects with vegetation.
1/8 (Eighth image size, Tolerant):Eighthsize imagesare used to compute additional 3D points. Less points are computed than with the half or quarter image scale.
However, more points are computed in areas with features that cannot easily be matched such as vegetation areas. This scale is recommended for projects with
vegetation.

Multiscale(default): When this option is activated, additional 3D points are computed on multiple image scales, starting with the chosen scale from the
Image scale drop down list and going to the1/8scale(eighth image size, tolerant). For example, if 1/2 (half image size, default) is selected, the
additional 3D points are computed on images with half, quarter, and eighth image size. This is useful for computing additional 3D points on vegetation
areas as well as keeping details about areas without vegetation.

Note: The Image Scale has an influence on the number of 3D points generated. For more information:203269885.

Point Density: This parameter defines the density of the densified point cloud. The point density can be chosen from the following options.
Optimal(Default): A3D point is computed for every 4/ Image scalepixel. For example, if the Image scaleis set to 1/2 (half image size), one 3D point is computed
every 4/(0.5) = 8 pixels of the original image.This is the recommended point cloud density.
High (Slow): A 3D point is computed for every Image scalepixel. The result will be an oversampled point cloud that requires up to 4 times more time and RAM
than optimal density. This point cloud usually does not improve significantly the results.
Low (Fast): A 3D point is computed for every 16/Image scale pixel. For example, if theImage scaleis set to1/2 (half image size), one 3D point is computed every
16/(0.5) = 32 pixels of the original image.The final point cloud is computed up to 4 times faster and uses up to 4 times less RAM than optimal density.

Note:The Point Densityhas an influence on the number of 3D points generated. For more information:203269885.

Minimum Number of Matches:The minimum number of matches per 3D point represents the minimum number of valid re-projections of this 3D point in the
images. The minimum number of matches per 3D point can be:
3(default): Each 3D point has to be correctly re-projected in at least 3 images.
2: Each 3D point has to be correctly re-projected in at least 2 images. This option is recommended for projects with small overlap, but it produces a point cloud
with more noise and artifacts.
4: Each 3D point has to be correctly re-projected in at least 4 images. This option reduces the noise and improves the quality of the point cloud, but it might
compute less 3D points in the final point cloud.
5: Each 3D point has to be correctly re-projected in at least 5 images.This option reduces the noise and improves the quality of the point cloud, but it might
compute less 3D points in the final point cloud. It is recommended for oblique imagery projects that have high overlap.
6:Each 3D point has to be correctly re-projected in at least 6 images.This option reduces the noise and improves the quality of the point cloud, but it might
compute less 3D points in the final point cloud. It is recommended for oblique imagery projects that have very high overlap.
Use Semi-Global Matching (payable add-on):This option uses the Semi-Global Matching algorithm for the point cloud densification. It is a payable add-on feature.
It may give better results for projects with low / uniform texture images (roads, walls, roofs). Another possible use is when the expected output is a good
orthomosaic of an urban area. In this last case, the Optimize for 2.5D DSM option (see below) has to be selected. The Semi-Global Matching is optimized for
large frames images (larger than 40MP).

Important:
TheUse Semi-Global Matching (payable add-on)option DOES NOT allow to generate the 3D Textured Mesh.
TheUse Semi-Global Matching (payable add-on) optionisgrayed out when a Fisheye Lens camera has been used. For more information:202558159.

Optimize for 2.5D DSM: It generates a 2.5D densified point cloud instead of a full 3D densified point cloud. It should be used when the expected output is a good
orthomosaic.
Overlap Scenario (forward - sideward): This option is displayed only for projects using large frame images (larger than 40MP). It allows to define the overlap
between the images. If the correct overlap is given the results will be better.

Important:
When theOptimize for 2.5D DSM optionis selected a 2.5D densified point cloud is generated.
TheOptimize for 2.5D DSMoptionis not recommendedfor oblique projects because the result will be a 2.5D densified point cloud.

Note:The Semi-Global Matchingoption will use the selected options of the Point Cloud Densification section(Image Scale, Point Density, Minimum
Number of Matches). The Multiscale option is always used when Semi Global Matching has been selected.

Point Cloud Filters

This section allows the user to consider manual image annotations or the point cloud densification area (if exists). The following options are available:

Use Densification Area: If a Point Cloud Densification Area has been drawn, use it to generate the outputsand to apply and visualize in the rayCloud Editor only
the selected areain the 3D View.For more information:202558439.

https://support.pix4d.com/hc/en-us/articles/203269885
https://support.pix4d.com/hc/en-us/articles/203269885


Use Annotations: If Image Annotations have been created, use them to generate the outputs. For more information and step by step instructions:202560549.

Point Cloud Classification

This section allows the user to run the Terrain/Object Point Cloud Classification while processing the 2. Point Cloud Densificationand allows to set up parameters
used when computing the Point Cloud Classification.

It usesthe unclassified points but notthe deleted points of the densifiedPoint Cloud, classifying each point into a Terrain / Objects Class.

Terrain class: Itconsists of points considered as being terrain points.It can be used to generate a DTM.
Objects class: Itconsists of points considered as being object points.

Note: 
During Point Cloud Classification a first process classifies the Filtered Point Cloud, generating a Terrain Point Cloud and an Objects Point Cloud.
During a second process, the Point Cloud Classification uses the user defined geometric constraints (parameters) to validate if the points of the Objects
Point Cloud can still be considered as belonging to an object, or if they should be moved to the Terrain Point Cloud.
Once a Terrain Point Class exist, it is possible to generate a DTM (beta), for step by step instructions: 202560579.

Important:

At the end of the classification, points might not be classified correctly. Points might have been classified as belonging to an object whereas they belong
to the terrain and vice versa.

It is possible to edit the computed terrain / objects classification and move points from one class to another, delete them, move them into a new class,
etc.

The available parameters are:

Minimum Object Length [units]:Minimum expected lengthof the objects.
Maximum Object Length [units]:Maximum expected lengthof the objects.
Minimum Object Height [units]: Minimum expected heightof the objects.

These parameters define geometric constraints that a group of points of the Objects Point Cloud should have in order to be verified as being an object.

Example:

Minimum Object Length = 0.1 [m]
Maximum Object Length = 100 [m]
Minimum Object Height = 0.1 [m]

The Objects Point Cloud will contain only objects with length between 0.1 and 100 meters and higher than 0.1 meter.

For step by step instructions about how to compute the Point Cloud Classification and generate a DTM:202560579.

3D Textured Mesh Generation

This section allows the user to generate the 3D Textured Meshwhile processing step2. Point Cloud Densificationand allows to set up the parameters to use for
the generation.

Important: 
The densified point cloud is used to generate a surface composed by triangles, it uses the points to minimize the distance between the points and the
surface that they define but even the vertices of the triangles are not necessarily an exact point of the densified point cloud.
Since the model based in triangles is 3D, it is unfolded into a 2D plane in order to define the resolution (pixel size) and which part of each triangle they
represent, then the 3D position of the pixel is reprojected into the original images to obtain the color. Using blending instead of stitching.
The3D Textured Meshwill be generated using the Densifiedpoint cloud. If any point cloud densification area and/or image annotations are defined, and if
the corresponding options are selected in the Point Cloud Filters options, they will also be used to generate the 3D Textured Mesh.

The available parameters are:

Maximum Number of Triangles: Parameter used to define the resolution of the geometry of the model, affecting the amount and size of the triangles.

Note:For not very large projects, it may be that the resulting number of triangles is lower than the maximum set up in the options, the maximum will only
be reached if the project is large and could create a model with more triangles.

The potential maximum number of triangles is lower than the amount of points found in the densified point cloud.

Texture Size:Parameter used to define the resolution of the texture of the model, affecting thepixel size.

Important:The higher the parameters above the longer time will take the processing, using high definition parameters have more visual impact when
zooming in and visualizingthe model from close, so allows to identifybetter details in the model.

https://support.pix4d.com/hc/en-us/articles/202560549
https://support.pix4d.com/hc/en-us/articles/202560579
https://support.pix4d.com/hc/en-us/articles/202560579


For step by step instructions about how to generate the 3D Textured Mesh:202560669.

Output

This section allows the userto select the desired output formats for the densified point cloud and 3D TexturedMesh.

The following formats can be chosen:

Point Cloud

Note: It is possible to select more than one format in order to save the Densified Point Cloudin multiple formats. When no output is selected, only a .p4b
file is generated.Always a .p4b file is generated which can only be opened in the rayCloud.

PLY: PLY file with X,Y,Zposition and color information for each point of the point cloud.
XYZ: ASCII text file with the X,Y,Z position of each point of the point cloud. This point cloud does not have color information.
Delimiter: Defines the delimiter character of the file, used to separate the values. The drop down list has the following options:
Space
Tab
Comma
Semicolon
LAS (default): LiDAR LAS filewith X,Y,Zposition and color information for each point of the point cloud.
LAZ: Compressed LiDAR LAS filewith X,Y,Zposition and color information for each point of the point cloud.

For more information about the file formats and the software with which these files can be opened:202558499.

3DTextured Mesh

Note: It is possible to select more than one format in order to save the 3D Textured Meshin multiple formats. When no output is selected, only a .p4b file
is generated.Always a .p4b file is generated which can only be opened in the rayCloud.

PLY: PLY file with X,Y,Zposition and color information for each vertex of the 3D Textured Mesh.
OBJ (default): OBJ file withX,Y,Zpositionfor each vertex of the 3D Textured Mesh.
Zipped OBJ: ZIP file containing anOBJ file with X,Y,Zpositionfor each vertex of the 3D Textured Mesh, JPEG file with the texture.

Important:The 3D Textured Meshfile is not georeferenced. It has coordinates on a local coordinate system centered around the project. Tovisualize
the 3D Textured Mesh with georeference:204606535.

3D PDF:PDF file containing a 3D model of the 3D Textured Mesh. The texture size of the 3D Textured Mesh that is displayed in the 3D PDF is 2000*2000 pixels.
Logo: Selectsalogo (.jpg or .tif) that will be displayed on the 3D pdf.

Warning: 
For .ply and .obj format, the texture is generated in a .jpg file, which contains a 2D planar RGB image of the values for each pixel of the triangles that
forms the 3D Textured Mesh.
In order to use the 3D Textured Mesh in other software, use both files, having them in the same folder and without renaming the texture .jpg file.
The .jpg texture file is associated to the .ply / .obj / .p4b generated while generating the attached .jpg file.
If a new .ply / .obj / .p4b files are generated, they cannot use a .jpg file generated previously even if it is for the same project and same parameters
values.
If having problems visualizing the 3D textured Mesh in the rayCloud or external software due to lack of hardware resources, it is possible to resize the
.jpg file (reducing the same percentage for the width and hight) using any image editor and less memory will be used.

For step by step instructions about how to generate the 3D Textured Mesh:202560669.

For more information about the file formats and the software with which these files can be opened:202558499.
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Access:On the Menu bar, clickProcess >Options...,a pop-up with 6 tabs appears.

Initial Processing Point Cloud DSM and Orthomosaic Additional Outputs Index Calculator Resources

This tab allows the user to change the processing options and desired outputs for step3.DSM and Orthomosaic Generation. Itcontains 4 sections:

Filters:Allows the user to define parameters to filter and smooth the points of the densified point cloud used to obtain the DTM.
Raster DSM: Allows the user to select the output file format for the raster DSM.
Grid DSM: Allows the user to select the output file format for the vector DSM.
Orthomosaic: Allows the user to select the output file format for the orthomosaic as well as different options relatedto the orthomosaic generation.

And 5 actions:

OK:Confirms the changes.
Cancel:Does not save the changes.
Help:Opens the Pix4Dmapper help.
Set as Default Options:Saves the current settings of all Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and Orthomosaic Generation,
Additional Outputs,Resources) except the options of the sectionProcessingin theInitial Processingtab (Aerial nadir,Alternative processing mode,Aerial oblique or
terrestrial)as default options for future projects.
ToSet as default options: Select the check box.
Reset Options:Resets to the Pix4Dmapper default options for all the Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and
Orthomosaic Generation, Additional Outputs,Resources).

Filters

This section allows the user to define parameters to filter and smooth the points of the densified point cloud used to obtain the DTM.

Important:The filtering and smoothing will not have any impact in the densified point cloud.



The following options are available:

Use Noise Filtering:The generation of the densified point cloud can lead to noisy and erroneous points. The noise filtering corrects the altitude of these points with
the median altitude of the neighboring points.
Use Surface Smoothing:Once the noise filter has been applied, a surface is generated from the obtained points. This surface can contain areas with erroneous
small bumps. The surface smoothing corrects these areas by flattening them.This section allows the user to set the following parameter:
Type: 3smoothing types can be selected:
Sharp (default):Tries to preserve the orientation of the surface and to keep sharp features such as corners and edges of buildings. Therefore only quasi-planar
areas are flattened.
Smooth: Tries to smooth areas, assuming that sharp features exist because of noise and that they should be removed. Areas that are not very planar are
smoothed and become planar.
Medium: Is a compromise between the two other types. It tries to preserve sharp features while flattening roughly planar areas.

Raster DSM

This section allows the user to save the DSM in the following format:

GeoTIFF(activated by default): Saves the DSM into a GeoTIFF file. The resolution of the DSM is selected in theLocal Processingmenu of the main window. For
more information:2202557389.For most of the projects the DSM is split into several tiles and one GeoTIFF file is generated per tile.
Merge Tiles(activated by default): Generates a single DSM GeoTIFF file by merging the individual tiles. When this option is deactivated, the merged DSM file is
not generated.

Grid DSM

This section allows the user to select the desired file format for the vector DSM:

XYZ: ASCII text file with the X,Y,Z position of each point of the point cloud.This point cloud does not have color information.
Delimiter: It defines the delimiter character of the file, used to separate the values. The drop down list has the following options:
Space
Tab
Comma
Semicolon
LAS:LiDAR LAS filewith X,Y,Zposition and color information for each point of the point cloud.
LAZ:Compressed LiDAR LAS filewith X,Y,Zposition and color information for each point of the point cloud.
Spacing [cm]: The spacing defines the distance between two 3D points in the DSM and is given in centimeters. For example: a grid spacing of 100 centimeters
will generate one 3D point every 100 centimeters. The default value is100 centimeters. One DSM with the selected spacing is generated in addition to a DSM
generated using the resolution selected in theLocal Processingmenu of the main window.

For more information about the file formats and the software with which these files can be opened:202558499.

Note:It is possible to select more than one format in order to save the point clouds in multiple formats.

Note:The Grid DSM is restricted to 256 million points. If the chosen grid spacing or resolution generates more than 256 million points, then the grid
sampling or resolution distance is doubled until the number of generated points does not exceed 256 million.

Orthomosaic

This section allows the user to select the output file format for the orthomosaic as well as different parametersrelatedto the orthomosaic generation:

GeoTIFF(activated by default): Saves the orthomosaic into a GeoTIFF file. The resolution of the orthomosaic is selected in theLocal Processingmenu of the main
window. For more information:2202557389.For most projects, the orthomosaic is split into several tiles and one GeoTIFF file is generated per tile.
Use Visibility (activated by default):The DSM is used to determine if a pixel of the orthomosaic is visible from a camera or not. When coloring that pixel / point,
only images on which the point is visible are taken into considerationwith a specific weight. This option is useful for obtaining orthomosaics with less artifacts
when dealing with sharp transition objects such as buildings.
Use Color Balancing
Merge Tiles(activated by default):Generates a single orthomosaic GeoTIFF file containing the whole of the selected area by merging the individual tiles. When this
option is deactivated, the merged orthomosaic file is not generated.
GeoTIFF Without Transparency: Generates aGeoTIFF file withouttransparency. For more information:202558809.

Information:For more information about the Orthomosaic algorithms:202559429.

Google Maps Tiles and KML: This option allows the user to generate the Google Maps and Google Earth files for the orthomosaic.
Mapbox Tiles:This option allows the user to generate the Mapbox Tiles for the orthomosaic.

Ifstep3. DSM and Orthomosaic Generationhas already been processed, it is possible to generate the Google Maps, KML and Mapbox Tiles without running
step 3 again. For more information:202558149.

Important:
When having images grouped in more than one group, theGoogle Maps TilesandKMLwill only be generated if one of the groups is
namedRGB(capital letters). Then theGoogle Maps tilesandKMLwill be generated only for this group. For more information about the image
groups:202557949.
TheGoogle Maps TilesandKML are only generated for 3 band with 8 bit per band images.

https://support.pix4d.com/hc/en-us/articles/202558499
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Important:
When having images grouped in more than one group, the MapBox Tileswill only be generated if one of the groups is namedRGB(capital letters).
Then theMapBox Tileswillbe generated only for this group. For more information about the image groups:202557949.
The Mapbox Tilesare only generated for 3 band with 8 bit per band images.

Important:When having images grouped in more than one group, one orthomosaic per groupis generated. For more information about the image
groups:202557949.
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Access:On the Menu bar, clickProcess >Options..., a pop-up with 6 tabs appears.

Initial Processing Point Cloud DSM and Orthomosaic Additional Outputs Index Calculator Resources

This tab allows the user to change the selected processing options and desired additional outputs to be generated while certain steps are being processed
without the need of generating them manually via the menu bar Process. Itcontains 1 section:

Contour Lines:Allows the user to generate theContour Linesusing the Raster DSMwhile processing step3.DSM and Orthomosaic Generation.

And 5 actions:

OK:Confirms the changes.
Cancel:Does not save the changes.
Help:Opens the Pix4Dmapper help.
Set as Default Options:Saves the current settings of all Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and Orthomosaic Generation,
Additional Outputs,Resources) except the options of the sectionProcessingin theInitial Processingtab (Aerial nadir,Alternative processing mode,Aerial oblique or
terrestrial)as default options for future projects.
ToSet as default options: Select the check box.
Reset Options:Resets to the Pix4Dmapper default options for all the Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and
Orthomosaic Generation, Additional Outputs,Resources).

Contour Lines

Allows the user to generate contour lines using the Raster DSM.For more information about the concept of contour lines:202559879.

SHP:When this option is selected, the contour lines file is generated in .shp format.
PDF:When this option is selected, the contour lines are saved in a.pdf format.
DXF:When this option is selected, the contour lines file is generatedin .dxf format.
Contour Base [units]: It defines the relative altitude which is used as a contour line base. It can be in meters or in feet according to the coordinate system used.

https://support.pix4d.com/hc/en-us/articles/202559879


Example:For a project with minimum altitude 315 meters,Contour Base= 30 meters, means that the first contour line (the base) will be at 345
meters (315+30).

Elevation Interval [units]: It defines the contour lines elevation interval. It can be in meters or in feet according to the used coordinate system.It can be any positive
value.

Warning:TheElevation Intervalmustbe smaller than the (Maximum - Minimum) altitude of the DSM. For more information about the DSM
altitudes:2202557619.

Example:For a project with Minimum altitude 400 meters and Maximum altitude 650 meters andContour Base= 0 meters,Interval= 50 meters
means that that contour lines will be generated at 400, 450, 500, 550, 600, and 650 meters.

Note:The smaller theIntervalvalue, the larger the size of the contour lines file and more time will be needed for its generation.

Resolution [units]: It defines the horizontal distance for which an altitude value is registered. The higher the Resolution value, the smoother the contour lines.

Example:If the Resolution is set to 100 cm, an altitude value will be registered every 100 cm (horizontally).

Minimum Line Size [points]: It defines the minimum number of vertices that a contour line can have. Lines with less vertices will be deleted and less noise will be
produced.

Example:If the Minimum Line Size [points] is set to 20, all contour lines that have less than 20 vertices will be deleted.

Note:
It is possible to select more than one format in order to save the contour lines in multiple formats.
If the step3. DSM and Orthomosaic Generationhas already been completed, it is possible to generate the Contour Lineswithout running step 3 again. For
more information:202558469.
For step by step instructions about how to generate contour lines:202560639.
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Access:On the Menu bar, clickProcess >Options...,a pop-up with 6 tabs appears.

Initial Processing Point Cloud DSM and Orthomosaic Additional Outputs Index Calculator Resources

This tab allows the user to change the processing options and outputs related tothe Index Calculator. 
These settings will be applied during step3.DSM and Orthomosaic Generation is in processing:

Output and Resolution of the Reflectance Map(s)
Selection of indices
Index Map Grid Resolution
Classes Resolution
Radiometric Calibration

These settings come in3 sections:

Reflectance Map:Allows users to set up the Resolution and to decide whether the Reflectance Map(s) will be generated while processing step3.DSM and
Orthomosaic Generation, ifColor balancing is used or not and if the Tiles are merged or not.

Indices: Shows the list of indices either from the database or created by the users. Allows to select which indices are generatedwhile processing step3.DSM and
Orthomosaic Generation. For the selected indices, the Index Map is saved as GeoTIFF, the Index Map Grid as .shp file and the Classes as .shp and the
Classeswith color representation as .jpg.

Radiometric Calibration:The camera used is displayed. Users can calibrate the sensor to perform an illumination adjustment in order to get more accurate
reflectance values.

And 5 actions:

OK:Confirms the changes.
Cancel:Does not save the changes.
Help:Opens the Pix4Dmapper help.
Set as Default Options:Saves the current settings of all Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and Orthomosaic Generation,
Additional Outputs,Resources) except the options of the sectionProcessingin theInitial Processingtab (Aerial nadir,Alternative processing mode,Aerial oblique or
terrestrial)as default options for future projects.
ToSet as default options: Select the check box.
Reset Options:Resets to the Pix4Dmapper default options for all the Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and
Orthomosaic Generation, Additional Outputs,Resources).



Reflectance Map

This section allows users to generate and save the Reflectance Map in GeoTIFF format with the settings selected.

GeoTIFF: The Reflectance Map is saved in GeoTIFF format duringstep 3. DSM and Orthomosaic is done. 

Use Color Balancing: Bydefault this option is unchecked. Itis also not recommended for most data set, especially when the users will perform the afterward
process in Index Calculator.
This option will only be used for the case that, users need to obtainbetter visuals for the Reflectance Maps while using 3-band (RGB) images with 8 bits per band.

Merge Tiles: For most projects, the Reflectance Map is split into tiles where every tile is inGeoTIFF format. This option is checked by default. It generates a single
Reflectance Map file by merging all the individual tiles. 

When this option is unchecked, the merged Reflectance Map file is not generated, and users will only find the small tiles in the result folder.

The resolution of the orthomosaic is selected in theLocal Processingmenu of the main window. For more information:202559429.

Information:For more information about the Reflectance Map algorithm:202559429.

Indices

Allows to select which indices are generatedwhile processing step3.DSM and Orthomosaic Generation (If in the section ReflectanceMap, Geotiff is selected),
andgenerates theIndex Map Grid and the Classes for the seleted indices.

Indices Box: All indices are displayed in the gray box with icons:

For indices from the database.

For indices created and defined by the user.

https://support.pix4d.com/hc/en-us/articles/202559429
https://support.pix4d.com/hc/en-us/articles/202559429


Exported Index Map Grid Resolution:The text box enables the user to change the resolution of the Index Map Grid. By defaultit is 100 [cm/pixel].

Classes Resolution:The text box enables the user to change the resolution of the Classes. By defaultit is 400 [cm/pixel].

Radiometric Calibration

This section allows users to calibrate and correct the image reflectance, taking the illumination and sensor influence into consideration.

After pressing the Calibrate button, the following pop-up:



After selecting the right image, users have to draw the region of the target and enter the Albedo values for all detected bands (information may be requested from
the entities who produce the target equipment).
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Access:On the Menu bar, click Process >Options...,a pop-up with 6 tabs appears.

Initial Processing Point Cloud DSM and Orthomosaic Additional Outputs Index Calculator Resources

This tab contains one section:Maximum Resources Available for Processing, whichallows the user to select the usage of the hardware resources. This can be
useful when running multiple projects on the same computer or when the computer is needed for tasks other than processing:

RAM [GB]: By default the amount of RAM memory used is the maximum available.It is possible to reduce the amount of RAM assigned to process the project by
moving the slider to a lower value.
CPU threads: By default all the CPU threads are used. It is possible to reduce the amount of CPU threads assigned to process the project by moving the slider to
a lower value.

Note:ONLY when using NVIDIA Graphic card(s) compatible with CUDA, it is possible to activate / deactivate the use of the Graphic card(s) for some
parts of the step 1.

The processing speed is increased and have more impact for large projects. 

Under NVIDIA CUDA capable devices list, appears the list of GPUs, all of them are selected by default. 

There are also5 actions:

OK:Confirms the changes.
Cancel:Does not save the changes.
Help:Opens the Pix4Dmapper help.
Set as default options:Saves the current settings of all Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and Orthomosaic Generation,
Resources), except the options of the sectionProcessingin theInitial Processingtab (Aerial nadir,Alternative processing mode,Aerial oblique or terrestrial), as
default options for future projects.



ToSet as default options: Select the check box.
Reset options:Resets to the Pix4Dmapper default options for all the Processing Options tabs(Initial Processing, Point Cloud Densification, DSM and Orthomosaic
Generation, Resources).

Tip:When processing several projects of a given size at the same time, the first project starting step2. Point Cloud Densification will use as much RAM
as possible. When another project starts step 2 as well, less RAM will be available and processing might be slower.

Therefore, reducing the amount of RAM to be used so that the resources are shared between the projects running at the same time helps to increase the
processing time.

For example on a 64GB RAM computer, when running 2 projects, set the amount of RAM to 32GB for each project.
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Access: On the Menu bar, click View.

There are 2 items that can be selected / unselected:

Show View Toolbar: Show / hide the View Toolbar. For more information: 202557839.
Show Sidebar: Show / hide the Sidebar. For more information: 202558389.

 

And 5 items that can be chosen:

Welcome: Opens the Welcome view interface.
Map View: Opens the Map View interface, available when a project is opened.
rayCloud: Opens the rayCloud Editor interface, available when a project is opened.
Mosaic Editor: Opens the Mosaic Editor interface, available once step 3. DSM and Orthomosaic Generation has been completed.
Index Calculator: Opens the Index Calculator interface, available once step 2. Point Cloud Densification has been completed.
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Contains 3 sections:

Demo Project
Projects
Help

Demo Project

Contains the items:

Automatically loads a demo project, ready to be processed and open in a browser window A tutorial (video and step by step instructions) on how to process the
project, how to navigate for the different sections and what can be done with Pix4Dmapper.
Tips
Displays information about the use of the Software, it opens the Knowledge base article containing a detailed description.

Map View with the demo_project loaded Demo Projectvideo in Pix4D Support page

Projects

Contains the items:

New Project...
Opens the wizard that will guide you to create a new project.
For step by step instructions about creating a new project:202557309.
Open Project...



Opens an existing project. Opens a pop-up windows to navigate and select a .p4d project file (Pix4Dmapper project file format).
Recent Projects
Displays a menu with the 4 last projects that have been opened. By clicking on one of them, the project will be opened.
Tips
Displays information about the use of the Software, it opens the Knowledge base article containing a detailed description..

Help

Contains the items:

Getting Started
Opens the Support site, displaying the Getting Started index. This guide explains how to get started with Pix4Dmapper. It shows the needed steps before using
Pix4D to obtain good data to achieve the best results, how to create a project and how to start processing it. It also shows how to get started with advanced
features such as using Ground Control Points.
Pix4Dmapper Manual
Opens the Support site, displaying the Manual index.
Quick Links
Opens the Support site, displaying the Quick Linksindex.
Video Tutorials
Opens the Support site, displaying the Video Tutorials index.
Webinars
Opens the Support site, displaying the Webinars index.
Support Website
Opens the Support site.
Tips
Displays information about the use of the Software, it opens the Knowledge base article containing a detailed description.
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Access: On the Menu bar, click View > Map View.

 

By selecting the Map View the following elements are displayed on the main window:

Menu bar entry: Displayed on the Menu bar.
Toolbar extra buttons: Displayed on the right part of the Toolbar.
2D View: Displayed in the Main window. By default the Satellite view is displayed.
Map View Sidebar: Displayed on the right of the 2D Map. It contains two sections: Project Summary and Layers.
Status bar: Displayed on the bottom right of the Map View.  Display the coordinates when passing the mouse over the Satelite, Map or Orthomosaic.

Important: The 2D Map displays the earth if the images are not geotagged.

 

Menu bar entry

On the Menu bar, when clicking Map View, the following options are displayed:

 

 



Point Cloud Densification Area: Indicates the area of the project for which the densified and filtered point cloud will be generated.
Orthomosaic Area: Indicates the area of the project for which the orthomosaic will be generated.

Toolbar extra buttons

A drop-down list that changes the 2D View type displayed on the Main window. It has the following options:

Satellite (default): Displays a satellite view of the project's location. If none of the images are geolocated, the whole earth is displayed.
Maps: Displays a map view of the project's location. If none of the images are geolocated, the whole earth is displayed. The background map displays the
standard OpenStreetMap map.
Orthomosaic: This option is available only if the Google Maps tiles and KML have been generated. It displays the orthomosaic that Pix4Dmapper generates in
step 3.DSM and Orthomosaic Generation 

Note: To generate the Google Maps tiles and KML: 202558149.

Information: The data displayed by OpenStreetMap is available under the Open Database License, the cartography is licensed as CC BY-SA.

Figure 1. Satellite view

 

 

http://www.openstreetmap.org/copyright


Figure 2. Maps view



Figure 3. Orthomosaic View

 

2D View 

Section which displays the location of the project on earth and the project elements (images, GCPs, etc.).

 

Map View Sidebar

Project Summary: Section with a small summary of the project parameters and the processing progress.
Layers: Section with the project elements (images, GCPs and processing areas) that are visible in the 2D View.

For information about the sidebar's display possibilities: 202558389.

https://support.pix4d.com/hc/en-us/articles/202558389


 

 

Status bar

The coordinates of the current mouse position on the 2D View are displayed at the bottom of the map. Two types of coordinates are displayed:

Geographical WGS84 coordinates
Latitude and longitude coordinates are displayed.
Selected Coordinate System



The X and Y coordinates are displayed.

Important: It is used the geographic (ellipsoid) projection coordinates in meters / feet, instead of geographic (ellipsoid) coordinates in degrees,
considering the output coordinate system selected.

By default the output coordinate system is the same as for the GCPs if GCPs are used, otherwise it is the same as for the images. If the coordinates
system is WGS84, the output is given in UTM.

If less than 3 images are geolocated and less than 3 GCPs are defined, then the output coordinates system is always "Local".

Note: If the project has no georeference or if its georeference is in a local coordinate system defined by the user, then only the geographical WGS84
coordinates are displayed.
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Access: On the Menu bar, click Map View and select Point Cloud Densification Area.

Note: Only one Point Coud Densification Area can been used.

Warning: 
It is not recommended to include areas not covered by the images: the results in those zones will not be accurate and may affect the results of the
covered area.
When the Point Cloud Densification Area is defined after step 2. Point Cloud Densification has been completed, it only affects the densified point clouds
visualized in the 3D View of the rayCloud and not the results saved on disk. In order to save the changes on disk:
On Process > Options.. > Point Cloud, on the Point Cloud Filters section, select the Use Densification Area check box and process Step 2. Point Cloud
Densification. The densified point clouds is generated taking into account the Point Cloud Densification Area. This action will overwrite previously
generated files of Step 2. Point Cloud Densification.
The Point Cloud Densification area affects the Automatic Tie Points only in the 3D View of the rayCloud. It doesn't affect the results of step 1. Initial
Processing.

The Point Cloud Densification Area indicates the area of the project for which the point cloud densification will be generated. It affects the densified point cloud as
well as the DSM and the orthomosaic. The area can only be defined in the Map View if the project's geolocation is known.

If a Point Cloud Densification Area is not defined, the densification will be done for the entire project's area.

 

The Point Cloud Densification Area menu contains 5 options:

Draw 
Import...
Copy from Orthomosaic Area
Edit...
Remove

For step by step instructions about how to select/change the Point Cloud Densification Area: 202560179.

 

Draw

By clicking Draw, the information i0012 pop-up appears with instructions about how to draw the area:

Right click inserts the last vertex of the point cloud densification area and stops the drawing.

 

 

 

https://support.pix4d.com/hc/en-us/articles/202560179


 

 

Import...

By clicking Import..., the Select file pop-up appears which allows the user to load the area from a vector file (.shp, .kml or .dxf):

Navigation window: Used to search for and select the vector file.
Open: Loads the file.
Cancel: Does not save the changes and closes the pop-up.



Note: The Vector file (.shp, .kml or .dxf) has to be a polygon file (not lines) and can be given in any coordinate system from Pix4Dmapper's coordinate
system database.

 

Copy from Orthomosaic Area

When clicking on this option, the Point Cloud Densification Area is set with the same area as the Orthomosaic Area previously drawn or loaded. If no
Orthomosaic Area has been defined, then this option is disabled.  

 

Edit...

By clicking Edit..., the Edit Area pop-up appears. It contains a table with the following columns:

Vertex: Each vertex of the area drawn or loaded.
Latitude: The latitude of each vertex.
Longitude: The longitude of each vertex.

 

To edit the area, change the Latitude and/or Longitude values by double-clicking on the corresponding cells in the table.

The Edit Area pop-up also has 3 action buttons:

OK: Confirms the changes.
Cancel: Does not save the changes and closes the pop-up.
Help: Opens the Pix4Dmapper help.

 

Remove

By clicking Remove, the previously drawn or loaded area is deleted.
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Access: On the Menu bar, click Map View and select Orthomosaic Area.

Note: Only one Orthomosaic Area can been used.

Warning: 
It is not recommended to include areas not covered by the initial images: the results in those zones will not be accurate and may affect the results of the
covered area.
It is not recommended to include zones that are not included in the Point Cloud Densification Area (if created), as this may lead to low accuracy results.
The Orthomosaic Area affects the DSM and Orthomosaic generated at step 3. DSM and Orthomosaic Generation.

The Orthomosaic Area indicates the area of the project for which the DSM and the orthomosaic will be generated. The area can only be defined if the image
geolocation is known. 

If an Orthomosaic Area is not defined, the creation of the orthomosaic will be done for the entire project area.

 

It contains five options:

Draw
Import...
Copy from Point Cloud Densification Area
Edit...
Remove

 

 

 



 

For step by step instructions about how to select/change the Orthomosaic Area: 202560209.

 

Draw

By clicking Draw, the information i0012 pop-up appears with instructions about how to draw the area:

Right click insert the last vertex of the point cloud densification area and stop the drawing.

 

 

Import...

By clicking Import..., the Select file pop-up appears which allows the user to load the area from a vector file (.shp, .kml or .dxf):

https://support.pix4d.com/hc/en-us/articles/202560209


Navigation window: Used to search for and select the vector file.
Open: Loads the file.
Cancel: Does not save the changes.

Note: The Vector file (.shp, .kml or .dxf) has to be a polygon file (not lines) and can be given in any coordinate system from Pix4Dmapper's coordinate
system database.

 

Copy from Point Cloud Densification Area

When clicking on this option, the Orthomosaic Area is set with the same area as the Point Cloud Densification Area previously drawn or loaded. If no Point Cloud
Densification Area has been defined, then this option is disabled.  

 

 

Edit

By clicking Edit, the Edit Area pop-up appears. It contains a table with the following columns:

Vertex: Each vertex of the area drawn or loaded.
Latitude: The latitude of each vertex.
Longitude: The longitude of each vertex.

 



 

To edit the area, change the Latitude and/or Longitude values by double-clicking on the corresponding cells in the table.

The Edit Area pop-up has also 3 action buttons:

OK: Confirms the changes.
Cancel: Does not save the changes.
Help: Opens the Pix4Dmapper help.

 

Remove

By clicking Remove, the previously drawn or loaded area is deleted.
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Access: On the Menu bar, click View > Map View. The 2D View is displayed on the Main window.

The 2D View has 2 components:

Background map
Displayed elements

 

Background Map

On the top of the background map there is a drop-down list indicating the type of the background map that has been selected.

Note: While loading a map, the drop-down list with the available maps is disabled.

 

By default when a project is loaded, the Satellite type is chosen. To navigate the map:

Zoom in: Move the mouse scroll wheel forwards.
Zoom out: Use the mouse scroll wheel backwards.
Pan: Left click and move the mouse.

Click on the background drop down list to select a different type of map. The following background maps are available:

Maps
Satellite
Orthomosaic

Maps

 

 



The background map displays the standard OpenStreetMap map.

Note: The Maps background is loaded only if there is internet connection.

Information: The data displayed by OpenStreetMap is available under the Open Database License, the cartography is licensed as CC BY-SA.

 

Satellite

 

 

http://www.openstreetmap.org/copyright


The background map displays a satellite map.

Note: The Satellite background is loaded only if there is internet connection.

 

 



Orthomosaic
The background map displays the orthomosaic that is generated in step 3. DSM and Orthomosaic Generation.

Note: This background map is available only if the Google Maps tiles and KML have been generated. To generate the Google Maps
tiles and KML: 202558149.

 

 

Displayed elements

The elements of the project are displayed on the map using their coordinates. The elements that are displayed are the following:

Images
Flight plan
GCPs
Processing Areas
Point Cloud Densification Area
Orthomosaic Area

Images

 



The images of the project that are geolocated with a known coordinate system are displayed as dots on the map. The first image is displayed as a larger dot. The
color of the dot indicates the phase of the processing:

Red: When a project is loaded before processing has started.
Gridded red: For the images that are disabled (not taken into account for processing).
Dark green: For images that have been calibrated after Initial Processing.
Dark blue: During Point Cloud Densification, images that are loaded are in blue.
Luminus green: After Point Cloud Densification.

When hovering over the image dots, the image name is displayed at the bottom part of the 2D View. When double clicking on an image dot, a pop-up appears
that displays the corresponding image.

Important: If the project has no georeference or if its georeference is in a local coordinate system defined by the user, then the images are not
displayed on the 2D View. The 2D View displays the whole earth.

 

The Images Layer has a sub-layer:

Flight plan: It displays the flight plan that was used to take the images as a green line starting from the larger dot (first image).  

GCPs

 



The GCPs of the project, if there are any, are displayed as crosses on the map:

Blue cross: GCPs that are marked in at least two images. 
Red cross: GCPs that are marked in less than two images.

When hovering over the GCP cross, the GCP name is displayed at the bottom of the 2D View. When double-clicking on a GCP cross, the GCP/Manual Tie Point
Manager window opens and the corresponding GCP is selected.

Important: If the project has no georeference or if its georeference is in a local coordinate system defined by the user, then the images are not
displayed on the 2D View. The 2D View displays the whole earth.

 

Processing Areas

 



The Orthomosaic Area or Point Cloud Densification Area, if defined, are displayed on the 2D View as transparent polygons with a red border.
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Access: On the Menu bar, click View > Map View to open the Map View. The Project Summary is displayed on the right of the Main window. For
information about the sidebar's display possibilities: 202558389.

On the left part of the Project Summary, there is an arrow that allows the user to show/hide the summary by clicking on it.

: By default the Project Summary is visible.
 : The Project Summary is not visible.

There are 4 sections in the Project Summary:

Project
Local processing
Images
Ground Control Points

 

 

Project

This section displays general information about the project:

Name: The name of the project.
Type: The type of the project (Aerial nadir, Alternative processing mode, Aerial oblique or terrestrial).
Workspace: The path to the folder where the .p4d project file is located and where the output folder is saved.
Output Datum: The datum of the outputs.
Output Coordinate System: The coordinate system of the outputs.

Note: If no georeference is given to the project (non geolocated images and no GCPs, or non geolocated images and GCPs in Local coordinate
system), then the output coordinate system is set to Local and no datum is displayed: 
Output coordinate system: Local

 

 

 

https://support.pix4d.com/hc/en-us/articles/202558389


Local Processing

This section describes the progress of each of the 3 steps of the local processing:

Step (1): Initial Processing
Initial Processing Done: 
no: If the initial processing has not been done.
rapid: If the Rapid Check Initial Processing has been done.
full: If the Full Processing Initial Processing has been done.
Mean Ground Resolution [cm/pixel]:
- : If the initial processing has not been done.
"Number": Where "Number" is the mean ground resolution of the images, if the initial processing has been done.
Parameter Files Generated: The parameter files contain the results of the AAT, BBA, and optimized internal and external camera parameters:
no: If if the parameter files have not been generated.
yes: If the parameter files have been generated.
Step (2): Point Cloud Densification
Point Cloud Densification Done: 
no: If the Point Cloud Densification has not been done.
yes: If the Point Cloud Densification has been done.
Image Scale: Scale of the image with which additional 3D points are computed:
- : If the Point Cloud Densification has not been done. 
1/2 (half image size, default): Half size images are used to compute additional 3D points. 
1 (original image size, slow): The original image size is used to compute additional 3D points.
1/4 (quarter image size, fast): Quarter size images are used to compute additional 3D points.
1/8 (eighth image size, tolerant): Eighth size images are used to compute additional 3D points.
Point Density:
Optimal: Compute with an optimal point density.
High: Compute with a high point density. Processing time will increase.
Low: Compute with a low point density. Processing time will decrease.
Step (3): DSM and Orthomosaic Generation
DSM and Orthomosaic Generation Done:
no: If if the DSM and Orthomosaic Generation step has not been done. 
yes: If the DSM and Orthomosaic Generation step has been done. 
Resolution [cm/pixel]:
-: If the DSM and Orthomosaic Generation step has not been done.
"Number": Where "Number" is the ground resolution of the DSM and of the Orthomosaic if the DSM and Orthomosaic generation has been done.
Raster DSM Generated:
no: If the Raster DSM GeoTIFF file has not been generated.
yes: If the Raster DSM GeoTIFF file has been generated.
Grid DSM Generated:
no: If the Grid DSM GeoTIFF file has not been generated.
yes: If the Grid DSM GeoTIFF file has been generated.
Orthomosaic Generated:
no: If the orthomosaic GeoTIFF file has not been generated.
yes: If the orthomosaic GeoTIFF file has been generated.
Google Maps Tiles and KML generated:
no: If the Google Maps tiles and KML files for the orthomosaic have not been generated.
yes: If the Google Maps tiles and KML files for the orthomosaic have been generated.

 

Images

This section displays information about the images of the project:

Enabled Images: The number of images that are going to be used for initial processing.
Geolocated Images: The number of images that have been geolocated.
Datum: The datum of the image' geolocation.
Coordinate System: The coordinate system of the image' geolocation.

Note: If the images are not geolocated or are given in a Local coordinate system, then the coordinate system is set to Local and no datum is
displayed: 
Coordinate System: Local

 

Ground Control Points

This section displays information about the GCPs of the project and is shown only if GCPs are defined.

Number of GCPs With Enough Image Marks: The number of GCPs that are marked on at  least 2 images and the total number of GCPs.
Datum: The datum of the GCPs.
Coordinate System: The coordinate system of the GCPs.

Note: If the images are not geolocated or are given in a Local coordinate system, then the coordinate system is set to Local and no datum is
displayed: 
Coordinate System: Local

 

 



Important: If there are less than 3 GCPs with enough image points, the following warning message appears in red color:

"At least 3 GCPs must have enough image points to be taken into account during processing."
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Access: On the Menu bar, click View > Map View to open the Map View. The Layers is displayed on the left of the Main window. For information about
the sidebar's display possibilities: 202558389.

On the left part of the Layers, there is an arrow that allows the user to show/hide the layers by clicking on it.

 (default): The Layers section is visible.
: The Layers section is not visible.

Each layer corresponds to one element type that appears on the 2D Map in the main window. There are three main layers:

Images
GCPs
Processing Areas

Note: Each layer objects can be shown/hidden on the 2D map by checking/unchecking the box next to the layer name.

 

Images

Displays the images of the project on the 2D Map as dots. The first image is displayed as a larger dot. By default the images are displayed. Uncheck the Images
box to hide the images.

A context menu is available when right clicking on the Images layer. The following option is available:

Image Properties Editor: Opens the Image Properties Editor that allows the user to edit the image properties. For more information about the Image Properties
Editor: 202557849.

The Images Layer has a sub-layer:

Flight plan: Displays the flight plan that was used to take the images as a green line starting from the larger dot (first image) and then following the images in
time. By default the flight plan is displayed. Uncheck the Images box  or the Flight plan Box to hide the flight plan.

 

GCPs

Displays the Ground Control Points (GCPs) of the project on the 2D Map. By default, if the project has GCPs, the GCPs are displayed. Uncheck the GCPs box
to hide the GCPs.

A context menu is available when right clicking on the GCPs layer. The following option is available:

GCP Manager: Opens the GCP/Manual Tie Point Manager that allows the user to add or edit GCPs. For more information about the GCP/Manual Tie Point
Manager : 202558329.

 

Processing Areas

This layer has two sub-layers:

Point Cloud Densification Area

Displays on the 2D map the area used to generate the densified point cloud. By default, if the area is defined, it is displayed. Uncheck the Processing Areas

 

 

https://support.pix4d.com/hc/en-us/articles/202558389


box or the Point Cloud Densification Area box to hide the area.

A context menu is available when right clicking on the Point Cloud Densification Area layer.

For more information about the Point Cloud Densification Area: 202557659.

Orthomosaic Area

Displays on the 2D map the area used to generate the orthomosaic. By default, if the area is defined, it is displayed. Uncheck the Processing Areas box or
the Orthomosaic Area box to hide the area.

A context menu is available when right clicking on the Orthomosaic Area layer.

For more information about the Orthomosaic Area: 202557649.
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Access: On the Menu bar, click View > rayCloud.

 

The use of the rayCloud is optional and it can be used to:

Visualize the different elements of the reconstruction (Camera Positions, Reprojections (rays), GCPs, Manual / Automatic Tie Points, Processing Area, Clipping
Box, Densified Point Cloud, Terrain / Objects / other classes of points, 3D Textured Mesh, Objects, Video Animation Trajectories) and their properties.
Visualize point clouds / 2.5 Triangle Meshes using point clouds created in other projects or with other software.
Verify / improve the accuracy of the reconstruction.
Assign points of the point cloud to different classes.
Improve the visual aspect.
Create objects and measure distances (Polylines), surfaces, and volumes (Stockpiles).
Create 3D Fly-trought animations (Video Animation Trajectories).
Export different elements (GCPs, Manual / Automatic Tie Points, Objects, Video Animation Trajectories).
Create point cloud files using points belonging to one or several classes.

When selecting the rayCloud the following elements are displayed on the Main window:

Menu bar entry: The standard menu bar items and an extra item.
Toolbar: The standard toolbar and some extra buttons.
Layers Sidebar: Displayed on the left of the 3D View. Displays the list of layers and sub layers (elements) which are displayed on the 3D View. It allows the user
to edit the display options of existing elements as well as to insert or import elements on the 3D View, and export elements into file.
3D View: Displayed in the Main view. Displays in 3D the diferent elements.
Sidebar: Displayed on the right of the 3D View. Displays different information depending the selected element.
Status bar: Displayed on the bottom right of the Mosaic View. Displays the coordinates when passing the mouse over any element displayed in the 3D View.

 



 

More information:

Video Tutorial: Introducing the rayCloud: 202561469.
Video Tutorial: rayCloud Tutorial: 202561479.
Webinar: Using the rayCloud: 202561629.

 

Status bar

On the bottom right part of the 3D View, the following is displayed:

Selected Coordinate System : Displays the selected coordinate system of the point.
Position: Displays the (X,Y, Z) coordinates in meters / feet of each point of the 3D View when passing the mouse over any element.  When passing the mouse
over the displayed elements, the coordinates change.

Important: It is used the geographic (ellipsoid) projection coordinates in meters / feet, instead of geographic (ellipsoid) coordinates in degrees,
considering the output coordinate system selected.

By default the output coordinate system is the same as for the GCPs if GCPs are used, otherwise it is the same as for the images. If the coordinates
system is WGS84, the output is given in UTM. If less than 3 images are geolocated and less than 3 GCPs are defined, then the output coordinates
system is always "Local".
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https://support.pix4d.com/hc/en-us/articles/202561469
https://support.pix4d.com/hc/en-us/articles/202561479
https://support.pix4d.com/hc/en-us/articles/202561629
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Access: On the Menu bar, click View > rayCloud, and then click rayCloud.

The following options are displayed:

Viewpoint
Perspective/Orthographic
Allow Full 3D Rotation
Change Background
New Polyline
New Surface
New Volume
New Video Animation Trajectory

 

 

Viewpoint

Allows the user to select pre-defined viewpoints for the 3D View. On the rayCloud Menu bar, by clicking Viewpoint, the following options are displayed:

View All: Moves the viewpoint in order to fit all the layers in the 3D View.
Focus on Selection: Moves the viewpoint in order to display in detail the selected element (point, camera).
Top: Moves the viewpoint in such a way that the layers are viewed from the top and fits all the layers in the 3D View.
Front: Moves the viewpoint in such a way that the layers are viewed from the front and fits all the layers in the 3D View.
Back: Moves the viewpoint in such a way that the layers are viewed from the back and fits all the layers in the 3D View.
Left: Moves the viewpoint in such a way that the view looks towards the left part of the layers and fits all the layers in the 3D View.
Right: Moves the viewpoint in such a way that the view looks towards the right of the layers and fits all the layers in the 3D View.
Home: Moves the viewpoint to the default viewpoint when opening the rayCloud and fits all the layers in the 3D View.

 

View All Focus on Selection

 



Top Front

Back Left

Right Home

 

Perspective/Orthographic

Defines the projection used to display the layers in the 3D View. By default the perspective projection is used. It is possible to switch between perspective and
orthographic projection by clicking on the Perspective/Orthographic option of the rayCloud Menu bar.

Perspective projection: Parallel lines don't look parallel and further objects appear smaller. This is what human eyes see.
Orthographic projection: Parallel lines stay parallel. Therefore the size of objects does not depend on the distance. This view mode is recommended for technical
drawing.



Perspective projection vs Orthographic projection

For more information about Perspective/Orthographic projections: 

Wiki Orthographic projection
Wiki Perspective projection

 

Allow Full 3D Rotation

By default the vertical rotation is limted to 180 degrees, this option allows to rotate indefnitely the model.

 

Change Background

Allows to change the color of the background in the 3D View.

The Select Color pop up appears:

The Select Color pop-up has the following sections:

Basic colors: Selects a basic color.
Palette: Selects / modifies a color using the palette.
Color Properties Values: Modifies a color typing the color properties values (Hue, Sat, Val, Red, Green, Blue).
Display of the selected color.
Add color to custom colors: Adds the selected color to custom colors, available for other projects.

And the action buttons:

OK: Confirms the changes.
Cancel: Does not save the changes.

 

http://en.wikipedia.org/wiki/Orthographic_projection
http://en.wikipedia.org/wiki/Perspective_projection


New Polyline

A Polyline Object is a continuous line composed of one or more sub-lines. It is created by specifying the vertices of each line. For more information about the
concept of Polyline: 202559829.

Right click on Objects and clicking New Polyline allows the user to create a new 3D Polyline, i.e. a polyline where each vertex has three coordinates.

For step by step instructions on how to draw a new Polyline: 202560309.

Once a new Polyline is created, the Sidebar displays the following information: 202558219.

 

New Surface

A Surface is an object that can be used to define planar areas such as a road, the roof of a building, etc. It can also be used to correct the DSM and generate a
better orthomosaic on these surfaces.

Right click on Objects and clicking New Surface allows the user to create a new 3D planar Surface, i.e. a surface where each vertex has three coordinates.

For step by step instructions about how to draw a new Surface: 202560269.

Once a new Surface is created, the Sidebar displays following information: 202558219.

https://support.pix4d.com/hc/en-us/articles/202559829
https://support.pix4d.com/hc/en-us/articles/202560309
https://support.pix4d.com/hc/en-us/articles/202560269


 

New Volume

A Volume is an object that can be used for volume calculations. It is defined by a 3D Surface called base. The volume is computed between the base and the
terrain surface.

Right click on Objects and clicking New Volume allows the user to create a new volume by defining the base.

For step by step instructions about how to draw a new volume: 202560319.

Once a New Volume is created, the Sidebar displays the following information: 202558219.

https://support.pix4d.com/hc/en-us/articles/202560319


 

New Video Animation Trajectory

An Animation trajectory is a 3D Fly-trough Animation created as a video.

Right click on Objects and clicking New Video Animation Trajectory allows the user to create a new Video Animation Trajectory by defining the path of the
recording by creating waypoints.

For step by step instructions about how to create a 3D Fly-trough Animation: 202560299.

Once a new Animation Trajectory is created, the Sidebar displays the following information: 202558219.

https://support.pix4d.com/hc/en-us/articles/202560299
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Access: On the Menu bar, click View > rayCloud.

The following Toolbar buttons are displayed:

Standard Toolbar: For more information: 202557839.
Toolbar extra buttons:

 

Toolbar extra buttons

Visualization

 Zoom In: Zooms in the selected view.

 Zoom Out: Zooms out the selected view.

 View All: Moves the viewpoint in order to fit all the layers in the 3D View.

 Focus on Selection: Moves the viewpoint in order to display in detail the selected element (point, camera).

 View from Top: Moves the viewpoint in such a way that the layers are viewed from the top and fits all the layers in the 3D View.

 

Objects

 Create a New Polyline Object: Allows the user to create a new 3D Polyline. For step by step instructions: 202560309.

 Create a New Surface Object: Allows the user to create a new 3D planar Surface. For step by step instructions: 202560269.

 Create a New Volume Object: Allows the user to create a new Stockpile. For step by step instructions: 202560319.

 

https://support.pix4d.com/hc/en-us/articles/202560309
https://support.pix4d.com/hc/en-us/articles/202560269
https://support.pix4d.com/hc/en-us/articles/202560319


 

Densified Point Cloud Editing

Note: The points of the densified point cloud can be edited by assigning them into a different group. For step by step instructions about how to edit
point cloud points with the rayCloud: 202560499.

Edit Densified Point Cloud: Enters / exits the Point Cloud Densification mode, enabling / graying out the editing toolbar buttons below.

 Add Points to Selection: Allows to select areas to be edited.

 Remove Points from Selection:  Allows to unselect areas to be edited.

 Select All: Allows to select all the visible points to be edited.

 Clear Selection: Allows to clear all the areas selected to be edited.

Invert Selection: Converts the selected areas to be edited into unselected and vice versa.

 Allows to select the Points Group to which move assign the selected areas, the options are: 

Unclassified: Selected by default, points that does not belong to any other category, by default all the points are Unclassified.
Deleted: Stores points that will not be used for the step 3. When processing the step 3, only the points belonging to the group Deleted will not be used.
(optional) Terrain: Generated automatically when running the Run Terrain/Object Point Cloud Classification or when the step 2 has been completed while the
Processing option Classify Point Cloud into Terrain/Object Points is selected. It can be created manually. When using the option Generate DTM (beta), only the
points belonging to the group Terrain will be used.
(optional) Objects: Generated automatically when running the Run Terrain/Object Point Cloud Classification or when the step 2 has been completed while the
Processing option Classify Point Cloud into Terrain/Object Points is selected. It can be created manually.
(optional) Others: Any other Group created manually by the user.
New Point Group: Option to create new Point Groups, by clicking New Point Group, a pop-up appears, type the new point goup name and click OK. The new
created group is selected.

 Assigns the selected points to the selected Point Group.

 

Clipping Box

Clip Point Cloud: Applies the Clipping Box in the 3D View and visualizes only the area contained in the Clipping Box.

Edit Cliping Box: Visualizes the Clipping box in the 3D View, visualize the clipping box properties in the Sidebar and allows to edit it in the 3D View and / or the

Sidebar.

Note: For step by step instructions about how use the clipping box in the rayCloud: 204048035.

 

Animation Trajectories

Note: For step by step instructions about how to create a 3D Fly-trough Animation with the rayCloud: 202560299.

 Create a New Video Animation Trajectory: Starts the New Video Animation Trajectory wizard.
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https://support.pix4d.com/hc/en-us/articles/202560499
https://support.pix4d.com/hc/en-us/articles/204048035
https://support.pix4d.com/hc/en-us/articles/202560299
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the Main window.

A layer is a group of objects that can be displayed on the 3D View. The Layers Sidebar contains the following layers:

Cameras: Contains all the cameras of the project. One camera is associated to each image.
Rays: Allows to show / hide the rays between selected points in the model and the cameras where the point has been found. Contains the rays display
properties.
Tie Points: Contains the Manual Tie Points, GCPs and Automatic Tie Points.
Processing Areas: Contains the Point Cloud Densification area.
Point Clouds: Contains point clouds (Densified Point Cloud and loaded external point clouds).
Point Groups: Contians the different group of points (each point of the densified point cloud is assigned to one group).
Triangle Meshes: Contains Triangle Meshes (generated in Pix4D or imported).
Objects: Contains any drawn object: Polylines, Surfaces and Volumes, and Animation Trajectories.

Characteristics:

By clicking on the left arrow of a layer, the sub-layers and layer properties are shown or hidden.
By double clicking on a layer, the sub-layers and layer properties are shown or hidden.
By clicking on the a layer's check box, the corresponding layer is shown or hidden in the 3D View.
The different layer properties can be edited.
Some layers have a context menu that can be accessed by right clicking on the corresponding layer.
The Layers Sidebar can be shown / hidded by dragging and dropping the left side border of the 3D View.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the main window.

The Cameras layer contains the following sub-layers:

Display Properties: Displays properties for all the cameras.
Calibrated Cameras: The cameras that have been used for the reconstruction of the model.
Uncalibrated Cameras: The cameras that have not been used for the reconstruction. These cameras can be:
Cameras that have been disabled by the user.
Cameras for which the optimized position could not be computed during initial processing and that have been discarded from the reconstruction.

 

Display Properties

The Display Properties layer allows to edit the display properties for all the cameras. The following properties can be edited:

Computed position: View/hide the calibrated (optimized) camera position sphere (this property affects only the Calibrated cameras).
Radius: Increases/decreases the computed camera positions' sphere radius (this property affects only the Calibrated cameras).
Color: Selects the computed camera positions' sphere color, the color for the projection lines (between the computed position and the corners of the thumbnails),
and the  color for the thumbnails borders(this property affects only the Calibrated cameras).
Projection: View/hide projection lines between the computed camera positions and the thumbnails (this property affects only the Calibrated cameras).
Thumbnail: View/hide a thumbnail of the original images (this property affects only the Calibrated cameras).
Projection Distance: Increases/decreases the distance between the computed camera positions and the thumbnails (this property affects only the Calibrated
cameras).
Initial Position: View/hide the initial camera position sphere.
Radius: Increases/decreases the initial camera positions sphere radius.
Calibrated Color: Selects the initial camera positions' sphere color for the Calibrated Cameras (cameras used for the reconstruction).
Uncalibrated color: Selects the initial camera positions' sphere color for the Uncalibrated Cameras (cameras not used for the reconstruction).
Projection: View/hide projection lines between the computed camera positions and an hypothetical thumbnails (the thumbnail box appears but empty).
Projection Distance: Increases/decreases the distance between the computed camera positions and the hypothetical thumbnails.

 



Projection Error: View/hide a line between initial and computed camera positions (this property affects only the Calibrated cameras).
Color: Color for the line between initial and computed camera positions (this property affects only the Calibrated cameras).

 

Calibrated Cameras

The Calibrated Cameras layer contains the list of Calibrated Cameras. 

On the left of each camera name, an icon is displayed to indicate that the camera is:

Calibrated: 
Disabled: 

 

Uncalibrated Cameras

The Uncalibrated Cameras layer contains a list of Uncalibrated Cameras. 

On the left of each camera name, an icon is displayed to indicate that the camera is:

Uncalibrated: 
Disabled: 
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the main window.

Note: Even if the layer Rays is selected, if the layer Cameras is not selected, the rays will not be visible.

The Cameras layer contains the following sub-layer:

Display Properties: Displays properties for all the rays.

 

Display Properties

The following properties can be edited:

Computed Ray Color: Selects the ray color for the projection lines between the selected 3D point and the calibrated cameras where the 3D point was visible but
not marked, crossing the thumbnail in the 3D point where the point is found in the original image. 
Marked Ray Color: Selects the ray color for the projection lines between the selected 3D point and the calibrated cameras where the 3D point was marked,
crossing the thumbnail in the point where the 3D point is found in the original image. 
Uncalibrated Ray Color: Selects the ray color for the projection lines between the selected 3D point and the not calibrated cameras.
Show Non Marked Rays: View/hide the rays for calibrated cameras where the 3D point was visible but not marked.
Show Uncalibrated Rays: View/hide the rays for uncalibrated cameras.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the Main window.

The Tie Points layer contains the following sub-layers:

Manual / GCPs: All the Manual Tie Points, 2D GCPs, 3D GCPs, and Check Points of the project.
Automatic: The Automatic Tie Points computed during initial processing. Each Tie Point is visible in at least 3 images.

 

Manual / GCPs

The Manual / GCPs layer has the following structure:

Properties: Displays properties of all Manual Tie Points and GCPs.
Computed Position: View/hide the points optimized position.
Minimum Pixel Size: Defines the size of the points' computed positions on the screen (not the real size of the points with respect to the model). This property
allows the points to be visible both when visualizing the model from very close and from very far. When the zoom level is above the given zoom level defined by the
Minimum size property, the points keep the same size on the screen independently from the zoom level. When zooming in closer to the model, below the zoom
level defined by the Minimum size property, the size of the points on the screen will increase each time  the user zooms in so that the points remain visible even if
the view is close to the model.
Minimum Physical Size: Defines the minimum physical size of the points on the 3D View. This defines the zoom level below which the points need to be
displayed with their real size with respect to the model so that the points remain visible even when zooming in very close to the model.
Marked Color: Cross color of the points' computed positions for points marked on at least 2 images.
Non marked color: Cross color of the points' computed positions for points marked in less than 2 images.
Initial Position: View/hide the points' initial positions (this property affects only the GCPs and Check points).
Minimum Pixel Size: Defines the size of the points' initial positions on the screen (not the real size of the points with respect to the model). This property allows
the points to be visible both when visualizing the model from very close and from very far. When the zoom level is above the given zoom level defined by the
Minimum size property, the points keep the same size on the screen independently from the zoom level. When zooming in closer to the model, below the zoom
level defined by the Minimum size property, the size of the points on the screen will increase each time zooming in so that the closer to the model the view gets,
the points remain visible.

 



Physical Size: Defines the physical minimum size of the points on the 3D View. This defines the zoom level below which the points need to be displayed with its
real size with respect to the model so that the points remain visible even when zooming in very close to the model.
Color: Cross color of the points' initial positions.
Position error: View/hide the line between the points' initial and computed positions (this property affects only the GCPs and Check points).
Color: Color for the line between the points' initial and computed positions (this property affects only the GCPs and Check points).
Show Error Ellipsoid: View/hide the ellipsoid formed by the theoretical error. For more information: 202559139.
Color: Color for the error ellipsoid.
Physical Size Scale: Defines the minimum physical size of the ellipsoid on the 3D View. This defines the zoom level below which the ellipsoid need to be
displayed with their real size with respect to the model so that the ellipsoid remain visible even when zooming in very close to the model.
List of Manual Tie Points, 2D GCPs, 3D GCPs and Check points: Each point has the following sub-element:
Display Properties: This layer allows the user to edit the display properties for the corresponding point. The properties that can be edited are the same than the
properties for all the points.

On the left of each point's name, an icon is displayed that indicates the type of the point. The type can be:

 Manual Tie Point
 2D GCP
 3D GCP
 Check Point

By right clicking on the Manual / GCPs layer, a context menu with the following action appears:

Export Points: Opens the Export pop-up, allowing the user to export Manual Tie Points and/or, export initial and/or computed GCPs position.

Note: If the model does not have GCPs or Manual Tie Points, the option Export Points will be grayed out.

The available formats are:
AutoCad DFX (*.dfx)
ESRI Shapefiles (*.shp)
Keyhole Markup Language (*.kml)
Microstation DGN (*.dgn)

On the top of the Export  pop-up there are 3 check-boxes that allow the user to select what kind of points to export:

Export Initial GCPs position : Exports the initial position of the GCPs.
Export Computed GCPs position: Exports the computed position of the GCPs.
Export Manual Tie Points: Export the Manual Tie Points.

By right clicking on a point layer, a context menu with the following actions appears:

Rename: Rename the point.
Remove: Removes the point.

 

Automatic

This layer displays the Automatic Tie Points that are computed during initial processing. Each Tie Point is visible in at least 3 images. The Automatic layer has
the following sub-element:

 

https://support.pix4d.com/hc/en-us/articles/202559139


Display Properties: Displays properties of the Automatic Tie Points.
Point Size: Size for each point in the 3D View .
Highlight color: Color of a point when hovering over it with the mouse.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the main window.

Warning: 
It is not recommended to include areas not covered by the images: the results in those zones will not be accurate and may affect the results of the
covered area.
When the Point Cloud Densification Area is defined after step 2. Point Cloud Densification has been completed, it only affects the point clouds that are
visualized in the 3D View of the rayCloud and not the results saved on disk. There are 2 ways to save the changes on disk:
On Process > Options.. > Point Cloud, on the Point Cloud Filters section, select the Use Densification Area check box and process Step 2. Point Cloud
Densification. The densified point cloud is generated taking into account the Point Cloud Densification Area. This action will overwrite previously
generated files of Step 2. Point Cloud Densification.
Right click on the densified point cloud and click Export Point Cloud..., on the export point cloud select the formats and path to store the point cloud and
click OK.
The Point Cloud Densification area affects the Automatic Tie Points only in the 3D View of the rayCloud. It does not affect the results of step 1. Initial
Processing.

The Processing Areas layer contains the following sub-layer:

Point Cloud Densification Area: The Point Cloud Densification Area drawn using the Map View or the rayCloud. 

By right clicking on the Processing Areas layer a context menu with the following option appears:

New Point Cloud Densification Area: Allows the user to draw a new Point Cloud Densification Area. For step by step instructions: 202560589.

 

Point Cloud Densification Area

The Point Cloud Densification Area has the following sub-element:

Display Properties: Allows the user to edit the display properties for the Point Cloud Densification Area. The following properties can be edited:

 

 

https://support.pix4d.com/hc/en-us/articles/202560589


Color: Color of the top, bottom, and side planes that define the area.
Vertex Color: Color of the spheres that represent the vertices of the middle plane of the area.
Vertex Radius: Radius of the spheres that represent the vertices of the middle plane of the area.
Segment Color: Color of the lines between the vertices of the planes (bottom, middle, and top planes) of the area.
Line Width: Width of the lines between the vertices of the planes (bottom, middle, and top planes) of the area.

 By right clicking on the Point Cloud Densification Area layer a context menu with the following options appears:

Remove: Allows the user to remove the area.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the Main window.

The Point Cloud layer contains the following sub-layers:

Display Properties: Displays properties for all the point clouds.
Densified Point Cloud: The point cloud that is generated after the Point Cloud Densification.
Other Point Clouds: Any otherexternal point cloud(s) loaded into the project by dragging and drooping a point cloud file.

Note: By default, the different point clouds are not loaded or displayed:
Not loaded point cloud displays the name in Italic, loaded point cloud displays the name in standard format.

By clicking on the point cloud's check box, the corresponding point cloud is shown or hidden in the 3D View.
Once the step 2 is completed, when reopening a project, or when a point cloud has been unloaded:
The point clouds are not loaded in the rayCloud, next time that the point cloud's check box is clicked, the Information i0014 pop-up message appears: 

OK: Loads and displays the mentioned layer in the rayCloud.
Cancel: Closes the pop-up message and does not perform any action.

 

 

 

 



Display Properties

Allows to the user edit the display properties for all the point clouds. The following property can be edited:

Point Size: Size of each point for all the point clouds in the 3D View.

 

Densified Point Cloud

The Densified Point Cloud layer has a sub-layer that displays the name of the available point cloud(s). If the point cloud has been generated by splitting it into
multiple parts, each part is displayed as one layer. On the left of the point cloud name there is an icon indicating that the layer is a point cloud: . 

The loaded point cloud layer has the following sub-element:

Display Properties: Allows to the user edit the display properties for the densified point cloud. The following property can be edited:
Point Size: Size of each point for the densified point cloud in the 3D View.

By clicking on an specific densified point cloud's check box, the corresponding point cloud is shown or hidden in the 3D View.

By right clicking on an specific densified point cloud's name, a context menu with the following action appears:

Load Layer: Visible if the point cloud is not loaded, load the point cloud in the rayCloud.

Unload Layer: Visible if the point cloud is loaded, unload the point cloud from the rayCloud.

Tip: Loaded layers consume RAM and GPU memory, unload layers that are not needed increases the speed using the rayCloud.

Export Point Cloud: Allows to export a Densified Point Cloud of all the selected Point Groups, with the selected properties, in the selected formats and with the
desired path / file name.

Important: If exist a Processing Area, only points withing the processing area are exported.

Useful in cases where:
The point cloud has been modified using the rayCloud (deleted points, changed or created the Processing area).
The intent is export only one / some Point Groups.
Some point cloud format files were not generated (not selected in the processing options).
Change output options: Save / not save colors.

By clicking in Export Point Cloud, the following pop-up appears:

It contains 2 sections:
Exported Data: Allows to configure some parameters for the exporting and allows to select the Point Groups to export.
Save Colors: Selected by default, save/not save the color values for each point of the Point Cloud of the .PLY file.

Note: The .LAS and .LAZ files have always color information. The .XYZ does not have color.

Merge Into One File: Not selected by default. In case that the Point Cloud output files were divided in parts, force to export all parts within the same file by
merging the parts.

 

 

 



Warning: When generating the Densified Point Cloud, if the file is too large and the Computer memory cannot process the full file, it is divided in parts.

When exporting a point cloud and selecting Merge into One file, the software requests less memory than when generating them, however, if the
computer resources are not enough, it may fail.

Export Groups: Allows to select which Point Groups will be used to generate the exported Densified Point Cloud and displays the list. By default all the point
groups are selected. By Clicking on Select, the Select Point Groups pop-up appears:

By default all the points belong to Unclassified or Deleted. 
When any classification has been created (by creating classes and assigning points to the group or by using Terrain/Objects Point Cloud Classification (beta),
more classes appears with their related names.

Press the Control key and left click on all the Point Groups to be selected.
Press the Shift key and left click on the first and last Point Groups to be selected. 

Contains the action buttons:

OK: Selects the marked Point Groups.
Cancel: Cancel the actions and exits the pop-up.

Warning: The exported Densified Point Cloud will contains all the Point Groups selected, by default all the Point Groups are selected. Deleted Points
cannot be exported.

 
Format: Allows to select the different formats on which the point cloud is exported. By default, only LAS is selected, it is possible to select:
LAS
LAZ
PLY
XYZ (it is possible to use as delimiter: Space, Tab, Comma and Semicolon).

And:

File Name: Displays the path and name where the Densified Point Cloud will be stored, by default is the project folder where the densified point clous is stored
after Step 2.
Browse...: Allows to select the path / name where the store the exported densified point cloud.

Warning: If the format file is generated with the same name in the same folder where an existing file exist, it will be replaced with the new densified point
cloud.

OK : Saves the project and export the selected formats with the selected parameters.
Cancel: Closes the pop-up message and do not perform any action. 

 

Other Point Clouds

It is possible to visualize other point clouds by selecting the point cloud file and dragging and dropping it onto the Point Clouds layer. A new sub-layer is added to
the Point Clouds layer with the path to the loaded file as name. The loaded point cloud has the following sub-element:

Properties: Displays properties for the corresponding point cloud.
Point Size: Size of each point for the corresponding point cloud in the 3D View.

The following formats can be loaded:

.las

.laz

 

 

 



Loaded point clouds are displayed in the right position if it is a Pix4Dmapper file or external file using the same coordinate system than the output coordinate
system selected in Pix4Dmapper.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the Main window.

The Point Groups layer contains the following sub-layers:

Unclassified: Selected by default, points that does not belong to any other category, by default all the points are Unclassified.
Deleted: Stores points that will not be used for the step 3. When processing the step 3, only the points belonging to the group Deleted will not be used.
(optional) Terrain: Generated automatically when running the Run Terrain/Object Point Cloud Classification or when the step 2 has been completed while the
Processing option Classify Point Cloud into Terrain/Object Points is selected. It can be created manually. When using the option Generate DTM (beta), only the
points belonging to the group Terrain will be used.
(optional) Objects: Generated automatically when running the Run Terrain/Object Point Cloud Classification or when the step 2 has been completed while the
Processing option Classify Point Cloud into Terrain/Object Points is selected. It can be created manually.
(optional) Others: Any other Group created manually by the user.

By clicking on an specific Point Group check box, the corresponding Point Group is shown or hidden in the 3D View.

By right clicking on an specific Point Group, a context menu with the following action appears:

Rename: Allows to change the Point Group name.
Remove: Deletes the selected Point Group.

For:

Unclassified: Rename and Remove are grayed out.
Deleted: Rename and Remove are grayed out.
(optional) Terrain: Remove is grayed out.
(optional) Objects: Rename and Remove are available.
(optional) Others: Rename and Remove are available.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the Main window.

The Triangle Meshes layer can generates a 3D Textured Mesh (if is not generated) and displays it. It can display as well a 2.5D Triangle Mesh of any point cloud
file that has been loaded by dragging and dropping it on the Triangle Meshes layer. 

By default, the 3D Textured Mesh (if generated) is not loaded or displayed. If it has been generated, by selecting it, it will be loaded and displayed. If it has not
been generated, when selecting it, it will be generated (only the .p4b output generated by default and using the options selected in the options: 202557799),
loaded and displayed. It will appear with the name:
Mesh_Projectname_simplified_3d_mesh
By clicking on the triangle mesh's check box, the corresponding triangle mesh is shown or hidden in the 3D View.

The following formats can be dragged and dropped:

Warning: DO NOT drag and drop a point cloud to generate the Triangle Mesh while a project is processing: the processing may stop.

.las 

.laz

It displays a 2.5D triangle mesh. Displayed in the right position if it is a Pix4Dmapper file or external file using the same coordinate system than the output
coordinate system selected in Pix4Dmapper.

Once the step 2 is completed, when reopening a project, or when a triangle mesh has been unloaded:

The triangle meshes are not loaded in the rayCloud, next time that the triangle mesh's check box is clicked, the triangle mesh is loaded.

The triangle meshes layer contains the following sub-layers:

Display Properties: Displays properties for all the triangle meshes.
List of triangle meshes: All the triangle meshes loaded in the project.

 

Display Properties

Displays properties for all the triangle meshes.

Allows the user to edit the display properties for all the triangle meshes. The following properties can be edited:

Color: The color of all the triangles of the triangle meshes. The color is only applied to the Monochrome. The default color is gray.
Shader: Specifies the way each triangle of the mesh is colored. The color is related to the 3D position of each triangle. The mesh can be colored in different ways:
Textured: Selected by default for the 3D textured Mesh generated for the project. Not available for other triangle meshes dragged and dropped.The triangles are
colored with the texture file generated when generating the 3D Textured Mesh. 
Monochrome: The triangles are colored with a color-to-black scale that depends on an angle measured with respect to a virtual sun positioned 45 degrees from
the north-east horizon. It uses the color selected above.
Color: The triangles are colored with a RGB scale. The color of a triangle depends on an angle measured with respect to 3 virtual suns that have Red, Green, and
Blue illumination. The color of each triangle is the combination of the light received by the three virtual suns. This shader displays a slope map if the model is
viewed from above. It gives information about the orientation of each surface.
Altitude (Red, Green, Blue): The triangles are colored with a RGB scale. The color of a triangle depends on the altitude of the triangle.
Altitude (Topography): The triangles are colored with a default scale. The color of a triangle depends on the altitude of the triangle.

 

 



Figure 1. Texture

Figure 2. Monochrome



Figure 3. Color

Figure 4. Altitude (Red, Green, Blue)



Figure 5. Altitude (Topography)

 

List of  triangle meshes

By default, the 3D Textured Mesh (if generated) is not loaded or displayed. If it has been generated, by selecting it, it will be loaded and displayed. If it has not
been generated, when selecting it, it will be generated (only the .p4b output generated by default and using the options selected in the options: 202557799),
loaded and displayed. It will appear with the name:
Mesh_Projectname_simplified_3d_mesh

By right clicking on an specific triangle mesh's name, a context menu with the following action appears:

Load Layer: Visible if the triangle mesh is not loaded, load the triangle mesh in the rayCloud.
Unload Layer: Visible if the triangle mesh loaded, unload the triangle mesh from the rayCloud.

Each triangle mesh layer has the following sub-element:

Displays Properties: Displays properties for the corresponding triangle mesh and only apply to the corresponding triangle mesh. The same properties are available
for all triangle meshes.

On the left of the triangle mesh name, there is an icon indicating that the layer is a triangle mesh: 
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Layers Sidebar is displayed on the left of the Main window.

The Objects layer contains the following sub-layers:

Display Properties: Displays properties for all Objects.
Polylines: Contains the list of polylines added to the project. A Polyline object is a continuous line composed of one or more sub-lines. It is created by specifying
the vertices of each line. For more information about the concept of polyline: 202559829.
Surfaces: Contains the list of surfaces added to the project. A Surface object can be used to define planar areas such as a road, the roof of a building, etc. It can
also be used to correct the DSM and generate a better orthomosaic on these surfaces.
Volumes: Contains the list of volumes added to the project. It can be used for volume calculation. It is defined by a 3D surface called a base. The volume is
computed between the base and the terrain surface.
Animation Trajectories: Contains the list of Animation Trajectories added to the project. The animation Trajectories consist of waypoints that define the path for
an imaginary camera that records the scene.

 

https://support.pix4d.com/hc/en-us/articles/202559829


Figure 1. Polyline object

Figure 2. Surface object



Figure 3. Volume object

Figure 4. Animation Trajectory

  

Objects

By right clicking on the Objects layer, a context menu with the following options appears:

New Polyline: Allows the user to draw a new polyline. For step by step instructions: 202560309.

https://support.pix4d.com/hc/en-us/articles/202560309


New Surface: Allows the user to draw a new surface. For step by step instructions: 202560269.
New Volume: Allows the user to draw a new volume. For step by step instructions: 202560319.
New Video Animation Trajectory: Allows the user to create a new Animation Trajectory. For step by step instructions: 202560299.
Export All Objects: Opens the Export pop-up that allows the user to export the corresponding components from the objects Polyline, Surface and Volume
into a file.

Important: 
A Polyline is composed of lines and vertices to which manual tie points are associated.
A Surface is composed of surfaces (formed by triangles) and vertices to which manual tie points are associated.
A Volume is composed of a surfaces (formed by triangles), volume meshes (composed by meshes) and vertices to which manual tie points are
associated.
When creating objects, the vertices create manual tie points except for Animation Trajectories where no manual tie point are created.
An Animation Trajectory is composed of waypoints.

The following file formats can be selected for export:
AutoCad DFX (*.dfx).
ESRI Shapefiles (*.shp).
Keyhole Markup Language (*.kml).
Microstation DGN (*.dgn).

The type of components to export can be selected. Depending on the existing objects, only some types of components are available. The following
components can be exported:

Export Vertices: Exports the vertices of the Polylines, Surfaces and Volumes.
Export Lines: Exports the lines of the Polylines.
Export Surfaces: Exports the surface meshes of the Surfaces and Volumes.
Export Meshes: Exports the volume meshes of the Volumes.

Remove All Objects: Deletes all the objects Polyline, Surface and Volume.

Important: 
The options New Polyline, New Surface, and New Volume are enabled only if at least one Point Cloud is loaded in the 3D View.
The options Export All Objects and Remove All Objects are enabled only if at least one object has been drawn.
The option Remove All Objects do not delete the manual tie points generated when drawing the objects (when drawing an object, the vertices
create manual tie points) and do not delete the Animation Trajectories.

 

Display Properties

The Properties layer allows the user to edit the display properties for all the objects Polyline, Surface, Volume and Animation Trajectories. The following properties
can be edited:

Note: Not all the objects have all the listed Display Properties, when changing the Display Properties of an Object, it affects all the objects where the
property exists.

Vertex Color: Color of the spheres that represent the vertices of the objects.
Vertex Radius: Radius of the spheres that represent the vertices of the objects.
Line Color: Color of the lines between the vertices of the objects.
Line Width: Width of the line defining the polyline, the surface area and the base area of the volume.
Base: View/hide the base of a surface (this property only affects Surface and Volume objects).
Color: Color of the base of a surface (this property only affects Surface and Volume objects).
Shader: Specifies the way each triangle of the base surface is colored (this property only affects Surface and Volume objects). The color is related to the 3D
position of each triangle. 2 ways of coloring the triangles are available:
Monochrome: Selected by default. The triangles are colored with a color-to-black scale depending on the angle with respect to a virtual sun positioned in the
north-east at 45 degrees from the horizon. It uses the color selected above.
RGB exposition: The triangles are colored with a RGB scale. The color of a triangle depends on the angle with respect to 3 virtual suns with Red, Green, and
Blue illumination. The color of each triangle is the combination of the light received by the 3 virtual suns. This shader gives a slope map if the model is looked at
from top. It gives information about the orientation of each surface.

Terrain: View/hide the triangles defining the terrain. These triangles are generated using the base surface and the points above and below that surface (this
property only affects Volume objects).
Color: Color of the triangles defining the terrain. These triangles are generated using the base surface and the points above and below that surface (this
property only affects Volume objects).
Shader: Specifies the way each triangle defining the terrain is colored (this property only affects Surface and Volume objects). The color is related to the 3D
position of each triangle. 2 ways of coloring the triangles are available:
Monochrome: Selected by default. The triangles are colored with a color-to-black scale depending on the angle with respect to a virtual sun positioned in the
north-east at 45 degrees from the horizon. It uses the color selected above.
RGB exposition: The triangles are colored with a RGB scale. The color of a triangle depends on the angle with respect to 3 virtual suns with Red, Green, and
Blue illumination. The color of each triangle is the combination of the light received by the 3 virtual suns. This shader gives a slope map if the model is looked
at from top. It gives information about the orientation of each surface.

 

 

 

 

https://support.pix4d.com/hc/en-us/articles/202560269
https://support.pix4d.com/hc/en-us/articles/202560319
https://support.pix4d.com/hc/en-us/articles/202560299


Polylines

Contains the list of polylines added to the project. A Polyline object is a continuous line composed of one or more sub-lines. It is created by specifying the
vertices of each line. For more information about the concept of Polyline: 202559829.

 By right clicking on the Polylines sub-layer, a context menu with the following options appears:

New Polyline: Allows the user to draw a new polyline. For step by step instructions: 202560309.
Export All Polylines: Opens the Export pop-up that allows the user to export the corresponding components from the polyline into a file.

Important: A Polyline is composed of lines and vertices to which manual tie points are associated.

The following file formats can be selected for export:
AutoCad DFX (*.dfx).
ESRI Shapefiles (*.shp).
Keyhole Markup Language (*.kml).
Microstation DGN (*.dgn).

The type of components to export can be selected. The following components can be exported:

Export Vertices: Exports the vertices of the the Polylines.
Export Lines: Exports the lines of the the Polylines.

Important: 
The option New Polyline is enabled only if at least one Point Cloud is loaded in the 3D View.
The option Export All Polylines is enabled only if at least one Polyline has been drawn.

 

Surfaces

Contains the list of surfaces added to the project. A Surface object can be used to define planar areas such as a road, the roof of a building, etc. It can also be
used to correct the DSM and generate a better orthomosaic on these surfaces.

By right clicking on the Surfaces sub-layer, a context menu with the following options appears:

New Surface: Allows the user to draw a new surface. For step by step instructions: 202560269.
Export All Surfaces: Opens the Save objects pop-up that allows the user to export the corresponding components from the surface into a file.

Important: A Surface is composed of surfaces meshes, lines, and vertices to which manual tie points are associated.

The following file formats can be selected for export:
AutoCad DFX (*.dfx).
ESRI Shapefiles (*.shp).
Keyhole Markup Language (*.kml).
Microstation DGN (*.dgn).

The type of components to export can be selected. The following components can be exported:

Export Vertices: Exports the vertices of the Surfaces.
Export Surfaces: Exports the surface meshes of the Surfaces.

Important: 
The option New Surface is enabled only if at least one Point Cloud is loaded in the 3D View.
The options Export All Surfaces is enabled only if at least one Surface has been drawn.

 

Volumes

Contains the list of volumes added to the project. It can be used for volume calculation. It is defined by a 3D surface called a base. The volume is computed
between the base and the terrain surface.

By right clicking on the Volumes sub-layer, a context menu with the following options appears:

New Volume: Allows the user to draw a new volume. For step by step instructions: 202560319.
Import Volume: Opens the Import Volume pop-up that allows the user to import Volumes created previously with Pix4Dmapper for the same area of study or
created manually.

Important: 
To import a volume created previously with Pix4Dmapper, it has to be a .shp file that contains surfaces (name_surfaces.shp) or vertices
(name_vertices.shp).
To import a volume created with an external software, it has to be a .shp file that contains a 3D polygon (surface) or 3D vertices.
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Contains the sections:

Navigation window: Used to search for and select the file to be imported.
File name: Displays the name of the selected file to be imported.
Files of type:  Displays the possible formats accepted for the input file: Shape files (*.shp) are accepted.

And the action buttons:

Open: Imports the selected file.
Cancel: Does not import the Volume and exits the pop-up.
Help: Opens the Pix4Dmapper help.

Export All Volumes: Opens the Export pop-up that allows the user to export the corresponding components from the volume into a file.

Important: A Volume is composed of volume meshes, lines, and vertices to which manual tie points are associated.

The following file formats can be selected for export:
AutoCad DFX (*.dfx).
ESRI Shapefiles (*.shp).
Keyhole Markup Language (*.kml).
Microstation DGN (*.dgn).

The type of components to export can be selected. The following components can be exported:

Export Vertices: Exports the vertices of the Volumes.
Export Surfaces: Exports the surface meshes of the Volumes.
Export Meshes: Exports the volume meshes of the Volumes.

Important: 
The option New Volume is enabled only if at least one Point Cloud is loaded in the 3D View.
The options Export All Volumes is enabled only if at least one Volume has been drawn.

 

List of objects

Each object layer has the following sub-element:

Display Properties: Displays properties of the corresponding objects. The properties that can be edited are not the same for all the objects.

Note: Changing the Display Properties of the selected object, the changes affects only to the selected object.

On the left of the object name, there is an icon indicating the type of the object:

 Polyline
 Surface
 Volume

 

 

 



By right clicking on a specific object's layer, a context menu with the following options appears:

Insert Vertices: Insert vertices on the line between existing vertices of the object.
Append Vertices: Insert vertices after the last vertex inserted for the object.
Rename: Rename the object.
Export: Opens the Save objects pop-up that allows the user to export the corresponding components from the selected object into a file.

Important: 
A Polyline is composed of lines and vertices to which manual tie points are associated.
A Surface is composed of a surface mesh and vertices to which manual tie points are associated.
A Volume is composed of a surface mesh, volume meshes and vertices to which manual tie points are associated.

The following file formats can be selected for export:
AutoCad DFX (*.dfx).
ESRI Shapefiles (*.shp).
Keyhole Markup Language (*.kml).
Microstation DGN (*.dgn).

The type of components to export can be selected. Depending on the object types, not all type of components are available. The following components can
be exported:

For a Polyline it is possible to:

Export Vertices: Exports the vertices of the the Polyline.
Export Lines: Exports the lines of the the Polyline.

For a Surface it is possible to:
Export Vertices: Exports the vertices of the Surface.
Export Surfaces: Exports the surface mesh of the Surface.

For a Volume it is possible to:

Export Vertices: Exports the vertices of the Volume.
Export Surfaces: Exports the surface mesh of the Volume.
Export Meshes: Exports the volume mesh of the Volume.
Remove: Removes the selected object.

Important:  
The option Remove do not delete the manual tie points generated when drawing the object (when drawing an object Polyline, Surface or Volume,
the vertices create manual tie points).

 

Animation Trajectories

Contains the list of Animation Trajectories added to the project. The animation Trajectories consist of waypoints that define the path for an imaginary camera that
records the scene.

 By right clicking on the Animation Trajectories sub-layer, a context menu with the following options appears:

New Video Animation Trajectory: Allows the user to create a new Animation Trajectory. For step by step instructions: 202560299.
Import...: Opens the Import Video Animation Trajectory pop-up that allows the user to import Animation Trajectories created previously with Pix4Dmapper for
the same area of study or created manually. 

For step by step instructions about how to import an Animation Trajectory with the rayCloud: 202560569.

 

 

https://support.pix4d.com/hc/en-us/articles/202560299
https://support.pix4d.com/hc/en-us/articles/202560569


Contains the sections:

Navigation window: Used to search for and select the file to be imported.
File name: Displays the name of the selected file to be imported.
Files of type:  Displays the possible formats accepted for the input file: *.csv and *.txt are accepted.

And contains the action buttons:

Open: Imports the selected file.
Cancel: Does not import the animation and exits the pop-up.
Help: Opens the Pix4Dmapper help.

Important: Manually created Animation Trajectories must have the same format and extension than files generated when exporting an Animation
Trajectory with Pix4D.

List of Animation Trajectories

Each object layer has the following sub-element:

Display Properties: Displays properties of the corresponding objects. The properties that can be edited are:
Start Vertex Color: Color of the spheres that represent the first waypoint.
Vertex Color: Color of the spheres that represent the waypoints.
Vertex Radius: Radius of the spheres that represent the waypoints.
Line Color: Color of the lines between waypoints.
Line Width: Width of the line defining the path between waypoints.

Note: Changing the Display Properties of the selected object, the changes affects only to the selected object.

On the left of the object name, there is an icon indicating the type of the object:

 Animation Trajectory

By right clicking on a specific object's layer, a context menu with the following options appears:

Rename: Rename the object.
Remove: Removes the selected object.
Export...: Opens the Export Video Animation Trajectory pop-up that allows the user to export the selected Animation Trajectory.

For step by step instructions about how to export an Animation Trajectory with the rayCloud: 203123429.

Contains the action buttons:

Save: Confirms the path and name to export the animation and opens the Video Animation Trajectory File Parameters pop-up:

 

 

https://support.pix4d.com/hc/en-us/articles/203123429


Contains the option:
Separator Character: Character to be used as separator for the different information for each waypoint / interpolated Point: 
Time [s], Position X, Position Y, Position Z, Rotation X, Rotation Y, Rotation Z.

Note: The default value for separator ";" in Microsoft Excel is readed as Tab and will place each separated text on one column.

Comment Character: Character to be used as first character for the comment lines which include information about the video animation options:
Name, Time computation, Interpolation, Max speed, Duration, Number of points, Distance unit of measure, Angle unit of measure.

Write Interpolated Points [m]: By default it is not selected, then, only the video animation options, the created waypoints and its coordinates are stored. Select
Write Interpolated Points [m] to store as well intermediate points between consecutive waypoints.

By default, the value is 1, and will crate one intermediate point each meter.

Cancel: Does not export the animation and exits the pop-up.
Help: Opens the Pix4Dmapper help.

Important: It is possible to export Animation Trajectories as CSV files which can be opened with any text editor or spread sheets editor.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The 3D View is displayed in the center of the Main window.

The 3D view displays the different objects defining a project, such as cameras, GCPs, etc. Similar objects are grouped together and are displayed on the same
layer. The different layers that are displayed in the 3D View and that are also visible in the Layers Sidebar are:

Cameras: This layer groups all the cameras of the project (calibrated and uncalibrated). One camera is associated to each image of the project. It is defined by its
initial position, (if it is known) optimized position, and orientation.
Rays: They are displayed when clicking on a 3D Point on the 3D Viewer if the Cameras and the Rays layers are visible. The 3D point is projected into all the
calibrated cameras where the point is visible. The rays cut the thumbnails from the cameras at the location where the point is visible in the original images. 
Tie Points: This layer groups all the manual tie points, GPCs, Check points, and Automatic tie points. The Automatic tie points are computed during initial
processing.
Processing Areas: This layer display the Point Cloud Densification Area defined using the Map View or the rayCloud.
Point Clouds: This layer groups all the point clouds. It contains the Densified Point Cloud and dragged and dropped point clouds.
Triangle Meshes: This layer groups the 3D Textured Mesh and triangle meshes generated by triangulating a point cloud that is loaded as a triangle mesh.
Objects: This layer groups all the objects defined by the user. These objects can be Polylines, Surfaces, Volumes and Animation Trajectories.

The layers can be shown/hidden using the Layers Sidebar, which can also be used for changing the display properties (color, size, etc.) of each layer. For more
information about the Layers Sidebar: 202558089.

Important: It is possible to change the Points Density by Press "Alt" + "+" or "AltGr" + "- " in order to increase or decrease the density, "Alt" + "0" reset
the Points Density to default values.

 

Navigating on the 3D View using the mouse

Pan: Left click and move the mouse (a green cross appears representing the focus point for the movement).
Zoom in: Move the scroll wheel forward while positioning the mouse over the point on which to zoom or right click and move the mouse forward (a green line
appears representing the focus point for the zooming).
Zoom out: Move the scroll wheel backwards while positioning the mouse over the point on which to zoom or right click and move the mouse backward (a green
line appears representing the focus point for the zooming).
Rotate: Move the mouse while clicking the scroll wheel or left and right click at the same time (a green circle appears representing the center point of the
rotation).

 

Navigating on the 3D View using the keyboard

Pan: Press the arrows keys to move front back right and left in the plane of the project.
Zoom in : Press "+" to zoom in on the 3D View.
Zoom out: Press "-" to zoom out on the 3D View.
Rotate: Press "4" to rotate leftwards, "6" to rotate rightwards, "8" to rotate upwards and "2" to rotate downwards (the rotation uses the plane on which the model
is placed).

Tip: In order to pan, zoom in, zoom out and rotate in a faster way, press Ctrl with the corresponding keys.

 

Changing the Viewpoint to a predefined viewpoint using the keyboard

Several predefined viewpoints exist such as top view, front view, etc. These predefined viewpoints are accessible using the keyboard and using the Menu
bar rayCloud > Viewpoint. For more information about the available Viewpoints using the menu bar: 202558069. 

View All: Press "C"  to move the viewpoint in order to fit all the layers in the 3D View.
Focus on Selection: Press "F" to move the viewpoint in order to display in detail the selected element (point, camera)
Top: Press "7" to move the viewpoint in such a way that the layers are viewed from the top and fit in the 3D View.
Front: Press "1" to move the viewpoint in such a way that the layers are viewed from the front and fit in the 3D View.
Back: Press "Ctrl" + "1" to move the viewpoint in such a way that the layers are viewed from the back and fit in the 3D View.
Left: Press "3" to move the viewpoint in such a way that the layers are viewed from the left and fit in the 3D View.
Right: Press "Ctrl" + "3" to move the viewpoint in such a way that the layers are viewed from the right and fit in the 3D View.
Home: Press "0" to move the viewpoint to the default viewpoint when opening the rayCloud and fits all the layers in the 3D View.
Change View Type: Press "5" to change the view type from perspective to orthographic or vice versa.

 

 

 

 



  

Layers



Cameras

 By default, the Camera layers are displayed on the 3D View as:

Blue sphere: Initial camera positions (GPS coordinates).
Green sphere: Optimized camera positions.
Red sphere: Initial camera positions (GPS coordinates) for uncalibrated Cameras for which the software could not find optimized positions and that were therefore
not used for the reconstruction.
Pale Red sphere: Initial camera positions (GPS coordinates) for uncalibrated Cameras that were disabled by the user and were not used for the reconstruction.
Green line: Distance between initial and optimized positions.
Green lines: Projection lines between the optimized camera positions and the original image thumbnails.
Yellow squares: Borders of the original image thumbnails.

Cameras



Rays

By default, the rays can have the following colors:
Green rays: The rays that connect the selected 3D point and the calibrated cameras where the 3D point was visible but not marked.
Orange rays: The rays that connect the selected 3D point and the calibrated cameras where the 3D point was marked.
Red ray: The rays that connect  the selected 3D point and the not calibrated cameras.
Light Blue ray: The ray that connects the selected 3D point with the image that is currently selected in the Image View, and on which the point is visible but nor
marked.
Light Purple ray: The ray that connects the selected 3D point with the image that is currently selected in the Image View, and on which the point has not been
marked.

Rays

 Tie Points

 By default, the Tie Points are displayed on the 3D View as:

Green cross: Optimized position of Manual Tie Points, GCPs, Check points, and vertices of the Objects drawn in 3D View that are marked in at least two
images.
Orange cross: Vertices of the Objects drawn in the 3D View that are marked in less than two images.
Blue cross: Original position of GCPs and Check points.
Colored point: Automatic tie point computed at step 1. Initial Processing colored using the original images.



Manual Tie Points

GCPs



Automatic Tie Points

Processing Areas

By default, a Processing Area is displayed on the 3D View as:

Gray spheres: Vertices of the middle plane of the 3D Processing Area.
Gray lines: Lines between the vertices of the planes (bottom, middle, and top planes) of the 3D Processing Area.
Transparent gray planes: Top, bottom, and side planes that form the 3D Processing Area.
Transparent light gray planes: Top, bottom, and side planes that form the 3D Processing Area when hovering over the area in the 3D View.
Transparent Red planes: Top, bottom and side planes that form the 3D Processing Area when selecting the area in the 3D View.

Processing Area: Point Cloud Densification Area



 Point Clouds

By default, the Point Clouds are displayed on the 3D View using the 3D coordinates of their points as computed by Pix4Dmapper.

The coordinates of a given point are displayed on the bottom right part of the main window when the point is selected in the 3D View.

Densified Point Cloud



  Triangle Meshes

By default, the 3D Textured Mesh is displayed using the Texture shader and other triangle meshes are displayed using the Monochrome shader with gray color.

Triangle Meshes

Objects

 By default, the Objects are displayed on the 3D View as:

Green sphere: Object vertices for Polylines, Surfaces and Volumes. Waypoints for Animation Trajectories.
Green Arrow: Orientation of the camera in the waypoint (only for Animation Trajectories).
Blue sphere: First Waypoint in Animation Trajectories (only for Animation Trajectories).
Blue Arrow: Orientation of the camera in the first waypoint (only for Animation Trajectories).
Green surface: Base surface for Surfaces and Volumes.
Green lines: Lines between vertices/waypoints from the same object. For Polylines, Surfaces, Volumes and Animation Trajectories.
Red Terrain: Triangles below and above the base surface and the terrain defined by the Filtered Point Cloud (only for Volumes).



Polylines

Surfaces



Volumes

Trajectory Animation
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Sidebar is displayed on the right of the Main window.

For information about the sidebar's display possibilities: 202558389.

The rayCloud Sidebar displays different information for the element that is currently selected in the 3D View. The elements that can be selected in the 3D View
are:

Clipping box
Cameras
GCPs and Manual Tie Points
Automatic Tie Points
Processing Areas
Point Clouds
Objects: Polylines, Surfaces, Volumes and Animation Trajectories
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https://support.pix4d.com/hc/en-us/articles/202558389
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. In the toolbar, click on the button . The Sidebar is displayed on the right of

the Main Window.
The Clipping Box Properties are displayed and the 3D View displays the Clipping Box.

Note: The Clipping Box, only affects the display, do not affect the results of any output or step 3. DSM and Orthomosaic Generation.

The following information is displayed:

Center X [m]: Relative X coordinate of the center of the Clipping Box.
Y [m]: Relative Y coordinate of the center of the Clipping Box.
Z [m]: Relative Z coordinate of the center of the Clipping Box.
Size X [m]: Size in meters of the X side of the Clipping Box.
Y [m]: Size in meters of the Y side of the Clipping Box.
Z [m]: Size in meters of the Z side of the Clipping Box.
Rotation Z [degree]: Represents the angle between:
The X axis of the model and the X axis of the Clipping Box.
The Y axis of the model and the Y axis of the Clipping Box.

 

 



Rotation 0º Rotation 45º

Below that information there are 2 buttons:

Expand: Creates a new Clipping Box which covers the full model.
Help: Opens the Pix4Dmapper help.

Note: On the toolbar, click  to apply the Clipping Box in the 3D View and visualize only the area contained in the Clipping Box.

For step by step instructions about how to use the new Clipping Box: 204048035.
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https://support.pix4d.com/hc/en-us/articles/204048035
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Sidebar is displayed on the right of the Main window.

The camera information is displayed on the Sidebar when clicking in the 3D View:

Initial camera position (for calibrated and uncalibrated cameras for which the initial position is known).
Calibrated camera position (for calibrated images).
Camera associated image thumbnail (for calibrated images).
The camera information is also displayed when selecting a given camera in the Layers Sidebar.

 The displayed camera information is different for:

Calibrated images
Uncalibrated images

Calibrated images

The following information is displayed in the Selection section:

Camera: Name of the image associated to the selected camera.
Camera model: Camera model associated to the selected camera, including Image size In pixels (width x height), and Bands configuration.
Number of Marked MTPs and GCPs: Number of Manual tie points / GCPs marked on the image.
Number of Automatic Tie Points: Total number of matching keypoints found on the image.
Computed Position [units]: X, Y, Z 3D position of the computed camera.

 

Buttons:

Disable: Disables the image. In order to remove the camera from the reconstruction, the project needs to be reoptimized. This button is shown for enabled
cameras.
Enable: Enables the image. In order to include the camera in the reconstruction, the project needs to be reoptimized. This button is shown for disabled cameras.
Uncalibrate: In order to recalibrate a camera it is necessary to uncalibrate it first. This option should be chosen if the user is not confident about the calibration of
the camera.
Apply annotation (available when the Image Annotation tool is used): Applies the image annotation to the Point Clouds. The effect depends on the actions
completed before and after applying the annotation. For step by step instructions about how to annotate Images: 202560549.

Note: 
The Image annotation does not affect the results obtained when running:
Step 1. Initial Processing
Process > Reoptimize
Process > Rematch and Optimize
If step 2. Point Cloud Densification has been completed:
By using Process > Filter Densified Point Cloud: A new filtered point cloud is generated using the annotations. For more information: 202557779.
By running again Step 2. Point Cloud Densification: A new densified and filtered point clouds including the annotations are generated.

 

 

https://support.pix4d.com/hc/en-us/articles/202560549
https://support.pix4d.com/hc/en-us/articles/202557779


Note: 
For step by step instructions about how to calibrate a camera: 202560189.
For step by step instructions about how to annotate images: 202560549.

 

Image preview: Displays the image associated to the calibrated camera.

Orange cross: Represents the position of an automatic keypoint that has been matched with a keypoints from other images.
Yellow cross: Represents a Manual tie point or a GCP marked on the image.
Right slider: Allows the user to select the minimum number of images with which a keypoint has been matched.

 Zoom in: Zoom in on the image. 

 Zoom out:  Zoom out of the image.

 Image annotation:  Activates the image annotation mode. For step by step instructions about how to annotate Images: 202560549.

Tip: For the selected image:
In order to zoom in/out: Place the mouse over the location on which to zoom, and move the mouse scroll button forwards/backwards.
In order to pan: Place the mouse over the location on which to pan, and press the left mouse button while dragging the mouse.

 

Images section

When double clicking on a cross in the Image preview (automatic/manual tie point or GCP), the Images section displays the images where the point can be found
(including the currently selected image). For more information: 202558459.

 

Uncalibrated images

When selecting an uncalibrated camera, it can be manually calibrated.

The following information is displayed in the Selection section:

Camera: Name of the image associated to the selected camera.
Camera Model: Camera model associated to the selected camera, including Image size In pixels (width x height), and Bands configuration.
Number of Marked MTPs and GCPs: Number of Manual tie points / GCPs marked on the image.
Number of Automatic Tie Points (Inliers/Total): Inliers points and total number of matching keypoints found on the image.
Computed Position [unit]: X, Y, Z 3D position of the computed camera, since there is no computed position, appears as n/a.

 

 

 

https://support.pix4d.com/hc/en-us/articles/202560189
https://support.pix4d.com/hc/en-us/articles/202560549
https://support.pix4d.com/hc/en-us/articles/202560549
https://support.pix4d.com/hc/en-us/articles/202558459


Buttons:

Disable: Disables the image. In order to remove the camera from the reconstruction, the project needs to be reoptimized. This button is shown for enabled
cameras.
Calibrate: Allows the user to calibrate an uncalibrated camera. This button is enabled only if more than 20 Manual Tie Points and Automatic Tie Points are
considered as being inliers.
Close: Exits the manual calibration mode.

Note: For step by step instructions about how to calibrate a camera: 202560189.

 

Image preview: Displays the image associated to the uncalibrated camera.

Red cross: Represents the position of an automatic keypoint that was not matched with keypoints from other images.
Orange crosses: Represents the position of an automatic keypoint which has a high probability of being accurately matched with keypoints of other images.
Yellow crosses: Represents a Manual tie point or a GCP marked on the image.
Right slider: Allows the user to select the minimum number of images with which a keypoint could be matched.

 Zoom in: Zoom in on the image.

 Zoom out: Zoom out of the image.

 Image annotation:  Activates the image annotation mode. For step by step instructions about how to annotate Images: 202560549.

Tip: For the selected image:
In order to zoom in/out: Place the mouse over the location on which to zoom, and move the mouse scroll button forwards/backwards.
In order to pan: Place the mouse over the location on which to pan, and press the left button while dragging the mouse.

 

Tie Points section: Displays in a table information about the Manual Tie Points and GCPs that are marked on the selected image. The table allows the user to
edit some of a point's information by double clicking on the corresponding cell. For detailed information: 202557919.

Apply: When clicking on this button, the new marks or changes for the displayed manual tie points and GCPs are added to the project.

 

Images section

When double clicking on a cross in the Image preview (automatic/manual tie point or GCP), the Images section displays the images where the point can be found
(including the currently selected image). For more information: 202558459.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Sidebar is displayed on the right of the Main Window.
The GCP or Manual Tie Point information is displayed when selecting a given 2D GCP, 3D GCP, Check point or Manual Tie Point in the 3D View.
The GCP or Manual Tie Point information is also displayed when selecting a given 2D GCP, 3D GCP, Check point or Manual Tie Point in the Layers
Sidebar.

 

 The following information is displayed:

Name (type): The name of the point and its type (3D GCP, 2D GCP, Check point, Manual Tie Point)
Sο2 [pixel]: A posteriori variance component of all the marked points for a given 3D point. For more information: 202559199.
Theoretical Error S(X,Y,Z)[units]: Theoretical error estimation. For more information: 202559139.
Maximal Orthogonal Ray Distance D (x,y,z)[units]: Maximal distance from the estimated 3D point and all the rays used to compute that 3D point. The distance is
measured between the 3D point and the point defined by the line perpendicular to the ray passing through the 3D point. For more information: 202559179.
Error to GCP Initial Position [units]: Error in X, Y, Z between the original 3D position and the estimated 3D position.
Computed Position [units]: X, Y, Z 3D position of the 3D GCP, Manual Tie Point or Check point. X, Y position of the 2D GCP.

A table allows the user to edit some of the point's information by double clicking on the corresponding cell. For detailed information: 202557919.

Below the table there are 2 buttons:

Optimize: Allows the user to automatically find the 3D point in the images that have not been marked. This button is activated when the 3D point has been
marked in at least two images.
Apply: This button is active when the image marks have been modified, i.e. when a new image has been marked or when an exiting mark has been updated or
removed. When clicking on this button, the new marks are taken into account and the 3D position of the corresponding point is recomputed.

 

https://support.pix4d.com/hc/en-us/articles/202559199
https://support.pix4d.com/hc/en-us/articles/202559139
https://support.pix4d.com/hc/en-us/articles/202559179
https://support.pix4d.com/hc/en-us/articles/202557919


The Images section: Displays the selected image and the other images where the point can be found. For more information: 202558459.

Important: The zoom level at which GCPs are marked has an influence on the GCP error obtained in the Quality Report. Usually the higher the zoom
level is, the more precisely the GCP is marked. These GCPs will have more influence on the reconstructed model than GCPs marked with a low zoom
level and lower error values are expected for those GCPs.

For example, when GCPs are marked without zooming into the images, the GCP error can be up to 10 times higher than when GCPs are marked by
zooming into the images.
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https://support.pix4d.com/hc/en-us/articles/202558459
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Sidebar is displayed on the right of the Main window.
The Automatic tie points information is displayed when an Automatic tie point is selected in the 3D View.

 

 The following information is displayed:

Automatic Tie Point name: Unique name that identifies the automatic tie point: atp [Number], where Number is unique.
Number of Images Marked In: Number of calibrated images on which the point has been automatically marked (identified as the same 2D keypoint).
Number of Images Visible In: Number of calibrated images on which the 3D automatic tie point has been reprojected (number of calibrated images where the
computed 3D point is visible).
Sο2[pixel]: A posteriori variance component of all the marked points for a given 3D point. For more information: 202559199.
Theoretical Error S(X,Y,Z)[units]: Theoretical error estimation. For more information: 202559139.
Maximal Orthogonal Ray Distance D(X,Y,Z)[units]: Maximal distance from the estimated 3D point and all the rays used to compute that 3D point. The distance is
measured between the 3D point and the point defined by the line perpendicular to the ray passing through the 3D point. For more information: 202559179.
Computed Position [units]: X, Y, Z 3D position of the selected point.

The Images section: Displays the selected image and the other images where the point can be found. For more information: 202558459.
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https://support.pix4d.com/hc/en-us/articles/202559199
https://support.pix4d.com/hc/en-us/articles/202559139
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Sidebar is displayed on the right of the Main window.
The Point Cloud Densification Area information is displayed when the Point Cloud Densification Area is selected in the 3D View.

Warning: 
It is not recommended to include areas not covered by the images: the results in those zones will not be accurate and may affect the results of the
covered area.
When the Point Cloud Densification Area is defined after step 2. Point Cloud Densification has been completed, it only affects the point clouds that are
visualized in the 3D View of the rayCloud and not the results saved on disk. There are 2 ways to save the changes on disk:
On Process > Options.. > Point Cloud, on the Point Cloud Filters section, select the Use Densification Area check box and process Step 2. Point Cloud
Densification. The densified point cloud is generated taking into account the Point Cloud Densification Area. This action will overwrite previously
generated files of Step 2. Point Cloud Densification.
Right click on the densified point cloud and click Export Point Cloud..., on the export point cloud select the formats and path to store the point cloud and
click OK.
The Point Cloud Densification area affects the Automatic Tie Points only in the 3D View of the rayCloud. It does not affect the results of step 1. Initial
Processing.

 

The section Selection displays the following information:

Maximum Altitude[units]: Altitude of the top plane of the Point Cloud Densification Area.
Minimum Altitude[units]: Altitude of the bottom plane of the Point Cloud Densification Area.

Important: Maximum altitude should be higher than Minimum altitude.

Note: The Maximum altitude and Minimum altitude can be edited by:
Selecting the text box and:
Clicking Page Up/Page Down keys: Increase/Decrease the value by 10 units.
Clicking Up Arrow/Down Arrow keys: Increase/Decrease the value by 1 unit.
Clicking Up Arrow/Down Arrow text box buttons: Increase/Decrease the value by 1 unit.
Typing a new number in the text box.

 

 

 

 



Below that information there are two buttons, grayed out by default, enabled once the values for Minimum or Maximum altitude are modified.

Apply: Saves the new values for the Minimum/Maximum altitude and apply the new filters.
Cancel: Does not save the new values for the Minimum/Maximum altitude.
Help: Opens the Pix4Dmapper help.
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Sidebar is displayed on the right of the Main window.
The Point Cloud information is displayed when a point of a point cloud is selected in the 3D View.

 

 The following information is displayed: 

Number of Images Visible In: Number of calibrated images on which the selected point has been reprojected (number of calibrated images where the computed 3D
point is visible).
Computed Position [units]: X, Y, Z 3D position of the selected point in the 3D View.

The Images section: Displays the selected image and the other images where the point can be found. For more information: 202558459.
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https://support.pix4d.com/hc/en-us/articles/202558459
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Access: On the Menu bar, click View > rayCloud to open the rayCloud. The Sidebar is displayed on the right of the Main window.
The objects information is displayed when an object is selected in the 3D View, or when an object is selected in the Layers Sidebar.

 

 There are 4 type of objects:

Polylines
Surfaces
Volumes
Animation Trajectories

Note: A Manual Tie Point is associated to each vertex of the objects. The Sidebar allows the user to mark these manual tie points on the images. Each
vertex that is marked in a least two images is taken into account in the Initial Processing if it is started from new or if the reconstruction is re-optimized.

 

Polylines

 

The following information is displayed:

Object name (object type): The name of the Polyline and its type (Polyline).
Number of Vertices: Number of vertices used to draw the Polyline.
Terrain 3D length[units]: 3D length of the Polyline, taking into account the three coordinates of the vertices. For more information: 202559819.
Projected 2D length[units]: 2D length of the Polyline, taking into account the (X,Y) coordinates of the vertices. For more information: 202559839.

Note: When the polyline is created, beside the measurements appears "error n/a " indicating that the measurement accuracy cannot be
calculated until all the vertices from the polyline are marked on at least 2 images. For step by step instructions: 202560609.

Below that information there are 3 buttons:

Copy to Clipboard: Copy the selected information to the clipboard that can be pasted into a text editor or spreedsheet by opening the destination file and paste.
Apply: This button is active when the image marks for the manual tie points associated to the polyline vertices have been modified, i.e. when a new image has
been marked or when an existing mark has been updated or removed. When clicking on this button, the new marks are taken into account and the 3D position of

 

 

 

https://support.pix4d.com/hc/en-us/articles/202559819
https://support.pix4d.com/hc/en-us/articles/202559839
https://support.pix4d.com/hc/en-us/articles/202560609


the corresponding vertices is recomputed.
Cancel: This button is active when the image marks for the manual tie points associated to the polyline vertices have been modified, i.e. when a new image has
been marked or when an existing mark has been updated, or removed. It cancels the modifications of the image marks.
Help: Opens the Pix4Dmapper help.

The Images section: Displays the images where the object can be found. For more information: 202558459.

For step by step instructions about how to draw a new polyline: 202560309.

 

Surfaces

The following information is displayed:

Object name (object type): The name of the Surface and its type (Surface).
Number of Vertices: Number of vertices used to draw the object.
Terrain 3D Length[units]: 3D length of the line that has been used to draw the Surface taking into account the three coordinates of the vertices. For more
information: 202559819.
Projected 2D Lenght[units]: 2D length of the line that has been used to draw the Surface taking into account the (X,Y) coordinates of the vertices. For more
information: 202559839.
Enclosed 3D Area[units2]: 3D area that is enclosed by this surface, taking into account the three coordinates of the vertices.
Projected 2D Area[units2]: 2D area that is enclosed by this surface, taking into account the (X,Y) coordinates of the vertices.

Note: When the surface is created, beside the measurements appears "error n/a " indicating that the measurement accuracy cannot be
calculated until all the vertices from the surface are marked on at least 2 images. For step by step instructions: 202560609.

Below that information there are 3 buttons:

Copy to Clipboard: Copy the selected information to the clipboard that can be pasted into a text editor or spreedsheet by opening the destination file and paste.
Apply: This button is active when the image marks for the manual tie points associated to the surface vertices have been modified, i.e. when a new image has
been marked or when an existing mark has been updated or removed. When clicking on this button, the new marks are taken into account and the 3D position of
the corresponding vertices is recomputed.
Cancel: This button is active when the image marks for the manual tie points associated to the surface vertices have been modified, i.e. when a new image has
been marked or when an existing mark has been updated or removed. It cancels the modifications of the image marks.
Help: Opens the Pix4Dmapper help.

The Images section: Displays the images where the object can be found. For more information: 202558459.

For step by step instructions about how to draw a new surface: 202560269.

 

 

https://support.pix4d.com/hc/en-us/articles/202558459
https://support.pix4d.com/hc/en-us/articles/202560309
https://support.pix4d.com/hc/en-us/articles/202559819
https://support.pix4d.com/hc/en-us/articles/202559839
https://support.pix4d.com/hc/en-us/articles/202560609
https://support.pix4d.com/hc/en-us/articles/202558459
https://support.pix4d.com/hc/en-us/articles/202560269


Volumes

The following information is displayed:

Object name (object type): The name of the Volume and its type (Volume).
Number of Vertices: Number of vertices used to draw the Volume.
Terrain 3D Length[units]: 3D length of the line that has been used to draw the Volume's base surface taking into account the three coordinates of the vertices. For
more information: 202559819.
Projected 2D Lenght[units]: 2D length of the line that has been used to draw the volume's base surface taking into account the (X,Y) coordinates of the
vertices. For more information: 202559839.
Enclosed 3D Area[units2]: 3D area that is enclosed by the volume's base surface, taking into account the 3 coordinates of the vertices.
Projected 2D Area[units2]: 2D area that is enclosed by the volume's base surface, taking into account the (X,Y) coordinates of the vertices.
Terrain 3D Area[units3]: Area that is defined by all the triangles of the volume's surface. These triangles are computed with respect to the filtered point cloud.
Cut Volume[units3]: Volume that is above the volume base. The volume is measured between the volume's base and the surface defined by the filtered point cloud.
Fill Volume[units3]:  Volume that is below the volume base. The volume is measured between the volume base and the surface defined by the filtered point cloud.
Total Volume[units3]: Total volume, Total Volume = Cut volume + Fill volume.

Note: When the volume is created, beside the measurements (except Cut, Fill, and Total volume) appears "error n/a " indicating that the
measurement accuracy cannot be calculated until all the vertices of the volume are marked on at least 2 images. For step by step
instructions: 202560609.

If step 2. Point Cloud Densification has not been done, besides the Cut, Fill, and Total volume, appears "error n/a " indicating that the filtered
point cloud is required and step 2. has to be run.

Below that information there are 3 buttons:

Copy to Clipboard: Copy the selected information to the clipboard that can be pasted into a text editor or spreedsheet by opening the destination file and paste.
Apply: This button is active when the image marks for the manual tie points associated to the volume vertices have been modified, i.e. when a new image has
been marked or when an existing mark has been updated or removed. When clicking on this button, the new marks are taken into account and the 3D position of
the corresponding vertices is recomputed.
Cancel: This button is active when the image marks for the manual tie points associated to the volume vertices have been modified, i.e. when a new image has
been marked or when an existing mark has been updated or removed. It cancels the modifications of the image marks.
Help: Opens the Pix4Dmapper help.

The Images section: Displays the images where the object can be found. For more information: 202558459.

For step by step instructions about how to draw a new volume: 202560319.
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Animation Trajectories

 

Under Selection in the main frame appears the name of the Animation trajectory and 4 sections:

Waypoints
Video Animation Options
Playback Controls
Video Rendering

And the button:

Help: Opens the Pix4Dmapper help.

 

Waypoints

The following actions can be performed on the table:

Inserting Waypoints: Right Click on any cell and click on one of the followings:
Insert Current Viewpoint as Waypoint Before Selection: Inserts the actual viewpoint in the 3D View as waypoint before the selected row (selected waypoint).
Insert Current Viewpoint as Waypoint After Selection: Inserts the actual viewpoint in the 3D View as waypoint after the selected row (selected waypoint).
Insert Displayed Computed Cameras Position as Waypoint Before Selection: Inserts ALL the cameras that are actually visible in the 3D View as waypoints before
the selected row (selected waypoint) by placing them (if more than one camera is inserted, the order is defined considering the exif information from the cameras).
Insert Displayed Computed Cameras Position as Waypoint After Selection: Inserts ALL the cameras that are actually visible in the 3D View as waypoints after
the selected row (selected waypoint) by placing them (if more than one camera is inserted, the order is defined considering the exif information from the cameras).
Deleting Waypoints: Right Click on any cell, and click on Remove Selected Waypoints.
Editing Values: Double click on the cell and edit the value, Timestamp cannot be edited manually, the values can be changed by changing the Duartion,
 Maximum Speed or selecting/unselecting Use Interpolation.

The table has as many rows as waypoints have the Animation Trajectory. Each row displays information for one waypoint.

Label: Name of the waypoint.
Timestamp [s]. Time at which the animation passes through the waypoint.
X coordinate [units]
Y coordinate [units]
Z coordinate [units]
Rotation in X Axis [degrees]
Rotation in Y Axis [degrees]
Rotation in Z Axis [degrees]



Video Animation Options

This section allows to change the time of the animation and use or not use interpolation between waypoints:

Duration [s]: Total Length in seconds for the animation.
Maximum Speed [m/s]: Maximum speed of the movement of the fly-trough camera in meters/second. The speed is not constant since the software
recognize changes in direction and orientation and reduce the speed in that sectors to allows a smother camera movements.
Use Interpolation: Ensure a smooth transitions between waypoints.

Note: 
If Use Interpolation is NOT selected, the path between waypoints will be straight lines. 
If Use Interpolation is selected, the path between waypoints will be curved lines. The angle of the curve is related to the angle between consecutive
lines.

This section contains 2 action buttons:

Apply: Save the changes done in the sections Waypoints or Video Animation Options.
Cancel: Revert the changes to restore the saved Animation Trajectory.
Help: Opens the Pix4Dmapper help.

 

Playback Controls

This sections allows to display the animation in the 3D View.

 Play animation

 Stop animation

 

Video Rendering

This sections allows to create a video file and set up different video rendering properties:

File Name: Displays the path and name where the video will be rendered and saved.
Format: Video file format. The available options are: MPEG4 and MPEG2.
Frame Rate: Frames per second to be stored in the video. The available options are:  24, 30 and 60 fps.
Resolution: Total width and height of the video in pixels. The available options are:  800x600, 1024x768, 1280x720 and 1920x1080.
Encoding Quality: Defines the pixel size within the video, the higher the encoding quality the higher definition
Show Visible Area: Displays / do not display in the 3D View a frame allowing to see which part of the 3D View fits in the scene to be recorded acording to the
resolution. Elements outside the Visible area will not appears in the recorded video
Pix4Dmapper Logo: When rendering and creating the video, displays/ do not display the Pix4Dmapper logo in the bottom right side of the video.

This section contains 3 action buttons:

Browse... : Opens the Save Video As window which allow to choose the video's folder.
Render: Converts the animation Trajectory into a video, saved in the selected path and using the video properties selected.
Cancel: Enabled while Rendering is in progress, allows to cancel the rendering of an Animation Trajectory into Video.

For step by step instructions about how to create an Animation Trajectory: 202560299.
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Access: On the Menu bar, click View > Mosaic Editor (available only if step 3. DSM and Orthomosaic Generation has been completed).

 

Warning: 
The Mosaic Editor may be used to manually correct artifacts in the Orthomosaic resulting from Step 3. DSM and Orthomosaic and in order to improve its
visual aspect, but it may create another artifacts, since the generation of the orthomosaic with each method is different.
The Orthomosaic generated at step 3. DSM and Orthomosaic Generation uses the Weighted Average algorithm and the processing options
(Use Visibility, Use Color Balancing) selected for the step 3. DSM and Orthomosaic Generation (Process > Options... > DSM and Orthomosaic
Generation > Orthomosaic).
When opening the Mosaic Editor, a different orthomosaic is generated using the Multi-band Blending algorithm, without Color Balancing
and without Visibility. It is displayed for editing and temporarily saved into the .p4s file located in the view_mosaic_editor result folder.
The changes applied in the Mosaic Editor affect the .p4s file, not the mosaic itself resulting from Step 3. DSM and Orthomosaic Generation.
In order to obtain the edited mosaic, the mosaic needs to be blended: 202560289. The orthomosaic resulting from Step 3. DSM and Orthomosaic
Generation will then be overwritten. The new mosaic will use the Multi-band Blend algorithm and it may differ from the mosaic visible in the Mosaic Editor.
When using the Mosaic Editor for blending, the new Orthomosaic is generated using the Multi-band Blending algorithm (without Color Balancing
and without Visibility). The Blending Radius Factor value can be selected. For more information about the Blending Radius Factor: 202557829. 

For more information about the available orthomosaic options / algorithms: 202559429.

For step by step instructions about how to improve the visual aspect of the orthomosaic: 202559909.

Note: The Multi-band Blending method is faster but it generates more artifacts at sharp transitions such as building edges.

By selecting the Mosaic Editor view the following elements are displayed on the Main window:

Menu bar entry: Extra entry displayed on the Menu bar.
Toolbar extra buttons: Displayed on the right part of the Toolbar. These extra buttons are related to the Mosaic Editor.
Mosaic View: Displayed in the Main window. By default the Orthomosaic is displayed. The Mosaic Editor can also be used to visualize the DSM (Elevation).
Mosaic Sidebar: Displayed on the right of the Mosaic View. By default the tools for editing the mosaic are displayed.
Status bar: Displayed on the bottom right of the Mosaic View.  Display the coordinates when passing the mouse over the orthomosaic / DSM.

For more information:

Video Tutorial: Introducing the Mosaic Editor: 202561449.
For step by step instructions related to the use of the Mosaic Editor: 202558709.
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Figure 1. Mosaic Editor with Elevation view

Figure 2. Mosaic Editor with Orthoimage view



 

Menu bar entry

On the Menu bar, by clicking on Mosaic Editor the following options are displayed:

 

View: Shows the view options of the Mosaic View.
Image List: Displays the list of the project's images and allows the user to select which images can be used to edit the mosaic.
Tools: Shows the tools that can be used to edit the mosaic or to visualize the DSM. The selected tools are displayed on the Mosaic Sidebar. 
Load Mosaic: Loads the last saved mosaic. This is useful in case of bad editing. It goes back to the last saved mosaic, and discards the intermediate actions /
editing.

Note: The changes are saved into the .p4s file located in the view_mosaic_editor result folder. The saved changes are only the changes that have
been applied to the mosaic, not the mosaic from Step 3. DSM and Orthomosaic Generation. In order to get the output files for the modified mosaic,
the mosaic needs to be blended.

For step by step instructions about how to set a new blending region and blend the mosaic: 202560289.

Clear Mosaic: Stops loading the project. The loading can be started again by selecting Load Mosaic.
Save Mosaic: Saves the changes applied to the mosaic.

Warning: 
The changes are saved into the .p4s file located in the view_mosaic_editor result folder.
The saved changes are only the changes that have been applied to the edited mosaic, not the mosaic resulting from Step 3. DSM and Orthomosaic
Generation.
In order to obtain the edited mosaic, the mosaic needs to be blended: 202557829. The orthomosaic resulting from Step 3. DSM and Orthomosaic
Generation will then be overwritten. For step by step instructions about how to set a new blending region and blend the mosaic: 202560289.

Auto Save Mosaic: By default deactivated. Automatically saves the changes applied to the mosaic every 5 minutes.
Close: Closes the Mosaic Editor and releases the computer's memory from the mosaic.

 

Toolbar extra buttons

These extra buttons are displayed on the right part of the Toolbar. These extra buttons are related to the Mosaic Editor and can be found as items in the Mosaic
Editor Menu bar entry under the View and Tools sections. For a detailed description about the buttons: 202557609 and 202557819.

 

Mosaic View

By default the Orthoimage view is selected and the mosaic is displayed. If the Elevation view is selected, the DSM is displayed.

When passing the mouse over the orthomosaic / DSM, the Mosaic Status bar displays the coordinates of the hovered point . 

 

Mosaic Sidebar

The Mosaic Sidebar displays the different tools that allow the user to edit the mosaic or to view the DSM. For more details about the tools: 202557819.

 

Status bar
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On the bottom right part of the Mosaic View, the following is displayed:

Selected Coordinate System: Displays the selected coordinate system of the point.
Position: Displays the (X,Y) coordinates in meters / feet of each point of the orthomosaic / DSM. When passing the mouse over the orthomosaic / DSM the
coordinates change.

Important: It is used the geographic (ellipsoid) projection coordinates in meters / feet, instead of geographic (ellipsoid) coordinates in degrees,
considering the output coordinate system selected.

By default the output coordinate system is the same as for the GCPs if GCPs are used, otherwise it is the same as for the images. If the coordinates
system is WGS84, the output is given in UTM.

If less than 3 images are geolocated and less than 3 GCPs are defined, then the output coordinates system is always "Local".

Note: Displays the position for the whole area covered by the Orthomosaic / DSM and the areas without data. When passing the mouse over areas
where there is no reconstruction, the no data altitude value is displayed. By default it is set to -10000. To change the no data altitude value: 202557619.
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Access: On the Menu bar, click Mosaic Editor and select the menu option View (available only if step 3. DSM and Orthomosaic Generation has been
completed).

 

The View options affect the Mosaic View. The following options are available:

Orthomosaic View [Group]
Elevation View
Show Seamlines
Show Mosaic Area
Show Mosaic Tiles
Pan and Zoom
Zoom In
Zoom Out

 

Orthomosaic View [Group]

This option is selected by default.

The Orthomosaic View [Group] displays the mosaic generated using the images that belong to the corresponding group. The default group is group1. For more
information about the image group: 202557949.

The mosaic mesh is displayed on top of the orthomosaic. The mosaic mesh is made of cells, where one image is associated to each cell. The lines delimiting the
cells are called Seamlines. The mosaic is edited by editing the cell's geometry and by assigning another image to each cell.

The Orthomosaic View is used to edit the mosaic mesh and visualize the edited orthomosaic in real time. Once the editing has been completed, the mosaic
needs to be blended in order to generate the new output files for the mosaic. The mosaic mesh and the blended mosaic are edited and processed independently
for each image group.

 



 

Elevation View

The Elevation View displays the DSM using either a gray scale or a RGB color map for the altitude values.



 

Show Seamlines

This option is activated by default. The Seamlines define the cells of the mosaic mesh.



 

Show Mosaic Area

This option is deactivated by default. It is activated when the Blend Mosaic tool is selected. The Mosaic Area is the area for which the edited mosaic is generated.
The Mosaic Area is displayed as a polygon inside a rectangle. 

For more information about how to set the Mosaic Area: 202560289.

https://support.pix4d.com/hc/en-us/articles/202560289


 

Show Mosaic Tiles

This option is deactivated by default. It is activated when the Blend Mosaic tool is selected. It displays the GeoTIFF mosaic tiles that will be generated when
blending the mosaic. When the mosaic area is modified, the mosaic tiles are modified as well.

 



Pan and Zoom

This option is activated by default. It sets the Mosaic View in Pan and Zoom mode. In this mode, the user can pan and zoom into/out of the mosaic using the
mouse as well as by moving the cells vertices (when the Edit Mosaic tool has been selected). The pan option is deactivated when the user inserts a new cell,
adds a vertex on a cell's edge, splits a cell, or draws the blend region. 

The following mouse interactions are available when the Pan and Zoom mode is active:

Left click on the mosaic and move the mouse: Pan the mosaic.
Left click on a cell's vertex and move the mouse: Move the cell's vertex.
Right click on a cell: A context menu is displayed that gives the user access to different actions in order to edit the mosaic (only if the Edit Mosaic tool is
selected):
Previous Available Image: Displays the previously available image in the image list that corresponds to the selected projection.
Next Available Image: Displays the next available image in the image list that corresponds to the selected projection.
Ortho Projection: Displays the currently selected image in ortho projection.
Planar Projection: Displays the currently selected image in planar projection.
Disable Selected Images: Disables the currently selected image and removes it from the Available Images list. This image can no longer be used to edit the
mosaic. 
Right click on a vertex: A context menu is displayed that allows the user to delete the selected vertex by selecting the Remove Selected Vertices (only if the Edit
Mosaic tool is selected).
Moving the mouse scroll forwards: Zoom in on the mosaic.
Moving the mouse scroll backwards: Zoom out of the mosaic.

Tip: Multiple cells or multiple vertices can be selected by pressing the Ctrl key while selecting the cells or vertices.

 

Zoom In

Zoom in on the mosaic.

Zoom Out 

Zoom out of the mosaic.
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Access: On the Menu bar, click Mosaic Editor > Image List (available only if step 3. DSM and Orthomosaic Generation has been completed).

The Image List pop-up allows the user to select which images can be used to edit the mosaic. It has two tabs:

Ortho Images: Displays a list of original images in ortho projection.
Planar Images: displays a list of original images in planar projection.

Note: Only images associated to calibrated cameras are displayed.

Note: 
Ortho projection: The ortho projection preserves distances and can be used for mosaics dedicated to measurement applications.
Planar projection: The planar projection does not preserve distances, but has less distortions than does the Ortho projection on sharp transitions such as
building edges. Therefore it is not recommended to use planar images for mosaics dedicated to measurement applications. Their basic use is to improve
the visual aspect of the orthomosaic.

 

By default all the images are selected. Each image can be independently enabled or grayed out by using the checkbox in the Filename column.

Each tab contains the following action buttons:

Select All: Selects all the images.
Unselect All: Unselects all the images.

The Image List pop-up has the following action buttons:

 

 

 



OK: Applies the changes and reassigns the selected (checked) images to the mosaic cells, while keeping the mesh geometry.
Cancel: Cancels the changes.
Help: Opens Pix4Dmapper help.

Tip: It is recommended to deactivate an image if it cannot be assigned to any cell in the mosaic mesh due to blur, overexposure, or noise.

Note: An image is identified by its filename and an associated short ID. The ID is useful for quickly identifying images on the right side panel using
the Edit mosaic tool. For more information: 202557539.
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Access: On the Menu bar, click Mosaic Editor and select the menu option Tools (available only if step 3. DSM and Orthomosaic Generation has been
completed). The Mosaic Sidebar is displayed on the right of the Main window.

For information about the sidebar's display possibilities: 202558389.

The Tools option displays mosaic editing tools and DSM visualization tools in the Mosaic Sidebar. It also gives the user direct access to some editing tools. The
following tools are available:

Reset Mosaic Mesh: This tool allows the user to create a new mesh to edit the mosaic.
Edit Mosaic: This tool allows the user to edit the mosaic.
Blend Mosaic: This tool allows the user to generate a new orthomosaic.
DSM Color Map: This tool allows the user to change the visualization of the DSM .
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Access: On the Menu bar, click Mosaic Editor, select the menu option Tools and click Reset Mosaic Mesh (available only if step 3. DSM and
Orthomosaic Generation has been completed).

For information about the sidebar's display possibilities: 202558389.

The Mosaic Mesh sidebar is displayed on the right of the Main window and allows the user to create a new mesh for the mosaic. The mosaic mesh is displayed
on top of the mosaic image in the Mosaic View. The mosaic mesh is made of cells, where one image is associated to each cell. The lines delimiting the cells are
called Seamlines. The mosaic is edited by editing the cell's geometry and by assigning another image to each cell.

The Mosaic Mesh sidebar contains 3 sections:

Parameters: Allows to select the geometry parameters of the mesh.
Projection: Allows to select the projection of the images used to initialize the mosaic mesh.
Apply: Allows to apply the changes and to build the mesh.

 

 

 

Parameters

The Mesh section allows the user to define the geometry of the mosaic mesh. 3 options are available:

Triangulation: Builds the mesh using the Voronoi triangulation of the original images centroids.
Rectangular Grid: Builds a m x n grid of rectangles. m and n are by default set to 16 x 24.
Hexagonal Grid: Builds a m x n grid of hexagons. m and n are by default set to 16 x 24.

 

Projection

The Projection section allows the user to define the type of images assigned to each cell. 2 options are available:

Ortho (default): Once the new mosaic mesh is built, an image generated using the ortho projection is assigned to each cell of the mesh. The ortho projection
preserves distances and can be used for mosaics dedicated to measurement applications. 
Planar: Once the new mosaic mesh is built, an image generated using the planar projection is assigned to each cell of the mesh. The planar projection does not
preserve distances, but has less distortions than does the Ortho projection on sharp transitions such as building edges. Therefore it is not recommended to use

 

https://support.pix4d.com/hc/en-us/articles/202558389


planar images for mosaics dedicated to measurement applications. Their basic use is to improve the visual aspect of the orthomosaic.

 

 Apply

Contains 2 action buttons:

Build Mesh: Starts the building of the mosaic mesh.
Help: Opens the Pix4Dmapper help.

Note: Depending on the grid size and number of images, this process may take several minutes.

For step by step instructions about how to edit the mosaic (insert cells, insert vertices, split cells or merge cells): 202560079.

Mesh using Triangulation Mesh using Rectangular Grid Mesh using Hexagonal Grid
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Access: On the Menu bar, click Mosaic Editor, select the menu option Tools and click Edit Mosaic (available only if step 3. DSM and
Orthomosaic Generation has been completed).

For information about the sidebar's display possibilities: 202558389.

The Edit Mosaic tool consists of:

Tools to edit the mosaic mesh: These tools are displayed on the Toolbar and are accessible through the menu: Mosaic Editor > Tools > Edit Mosaic.
Tools to edit the image associated to the currently selected cell: These tools are displayed on the Mosaic Cell sidebar .

 

Tools to edit the mosaic mesh

These tools are displayed on the Toolbar and are accessible through the menu: Mosaic Editor > Tools > Edit Mosaic. The following tools are available:

 Insert Cell: Allows the user to insert a new cell by drawing a polygon on the mosaic.

 Insert Vertices: Allows the user to insert a vertex on a cell's edge.

 Split Cell: Allows the user to split a cell using a path with end points on the cell's edges.

 Merge Cells: Allows the user to merge two or more adjacent cells that are selected.

Tip: Multiple cells or multiple vertices can be selected by pressing the Ctrl key while selecting the cells or vertices.

When these tools are activated, while inserting a cell, inserting a vertex, or splitting a cell, a context menu is available by right clicking on the Mosaic View. The
following actions are available:

 Insert Cell, Insert Vertices, Split Cell: Insert the drawn cell point / vertices or split the cell.

 Undo: Removes the last vertex added.

 Cancel: Cancels the cell insertion, vertex insertion or cell splitting.

When selecting at least two cells, a context menu is available by right clicking on the Mosaic View. The following actions, which affect all the selected cells, are
available:

 Merge Cells: Merges the selected cells together and assigns an image using the ortho projection to the new cell. This option works only if the cells are
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adjacent .

Ortho Projection: Assigns an image using the ortho projection to all the selected cells.

Planar Projection: Assigns an image using the planar projection to all the selected cells.

 Disable Selected Images: Disables the images assigned to all selected cells and removes them from the Available Images list. These images can no

longer be used to edit the mosaic.

 

 When the Edit Mosaic mode is active, the following mouse interactions allow the user to edit the mosaic mesh:

Left click on a cell's vertex and move the mouse: Moves the cell's vertex.
Right click on a cell: A context menu is displayed that gives the user access to different actions in order to edit the mosaic:
Previous Available Image: Displays the previously available image in the image list that corresponds to the selected projection.
Next Available Image: Displays the next available image in the image list that corresponds to the selected projection.
Ortho Projection: Displays the currently selected image in ortho projection.
Planar Projection: Displays the currently selected image in planar projection.
Disable Selected Images: Disables the currently selected image and removes it from the Available Images list. This image can no longer be used to edit the
mosaic.
Right click on a vertex: A context menu is displayed that allows the user to delete the selected vertex by selecting the Remove Selected Vertices. 

 For step by step instructions about how to edit the mosaic (insert cells, insert vertices, split cells or merge cells): 202560079.

 

Tools to edit the image associated to the currently selected cell

These tools are displayed on the Mosaic Cell sidebar that is displayed on the right of the Main window. They allow the user to edit the image associated to the
currently selected cell. The Mosaic Cell sidebar has two sections:

Properties
Available Images

 

Properties

The Properties section is used to edit the properties of the image associated to the currently selected cell. All changes update both the Mosaic View and the
Mosaic Cell sidebar in real time.

The Properties section contains:

Image view: Displays the currently assigned image with an overview of where the cell lies on this image.
Projection: Image projection type used for the selected cell.
Color: Allows the user to change the brightness and contrast of the selected cell.
Highlight: Highlights all the cells with ortho and planar projection on the mosaic, or highlights the area covered by the currently selected image.

The cell can be edited by changing the projection and by adjusting the brightness and contrast of the assigned image.

 

Image view

Displays the currently assigned image with an overview of where the cell lies on this image.

https://support.pix4d.com/hc/en-us/articles/202560079


 

Projection

Two different projections can be used for one image: an ortho projection and a planar projection.

When changing the projection, the Available Images displays only images generated with the selected projection. 

Figure 1. Cell with an ortho projection



Figure 2. Cell with a planar projection

Note: 
Ortho projection: The ortho projection preserves distances and can be used for mosaics dedicated to measurement applications.
Planar projection: The planar projection does not preserve distances, but has less distortions than does the Ortho projection on sharp transitions such as
building edges. Therefore it is not recommended to use planar images for mosaics dedicated to measurement applications. Their basic use is to improve
the visual aspect of the orthomosaic.

Color

The color section allows the user to change the brightness and contrast of the selected cell:

Brightness:

Decrease the brightness of the cell. Overall darker texture.

 Reset the brightness of the cell to its original value.

Increase the brightness of the cell. Overall lighter texture.

Contrast:

Decrease the contrast of the cell. Dark areas become lighter and light areas become darker.

 Reset the contrast of the cell to its original value.

Increase the contrast of the cell. Dark areas become darker and light areas become lighter.

 

Highlight

 



The Highlight section contains two buttons:

Projection: Highlights all the cells with ortho (yellow) and planar (purple) projections on the mosaic. This is useful to quickly distinguish between the ortho and
planar cells of the orthomosaic.
Image: Highlights the area covered by the currently selected image.

Note: This can be useful to check if the image covers the cell completely (in order not to create new artifacts).

Figure 3. Highlight Projection button pressed

 



Figure 4. Highlight Image button pressed

 

Available Images

The Available Images section lists all the images within the selected projection that can be assigned to the selected cell. 

Each image has an ID displayed on a light yellow background (top left).
The assigned image is highlighted with an orange border and it can be modified by selecting a new image from the Available Images list.

When right clicking on a given image, a context menu opens that has the following options:

Disable Image: Disables the image and removes it from the Available Images list. This image cannot be used anymore to edit the mosaic.
Show Image List: Opens the Image List pop-up. For more details about the Image List pop-up: 202557529.
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Access: On the Menu bar, click Mosaic Editor, select the menu option Tools and click Blend Mosaic (available only if step 3. DSM and Orthomosaic
Generation has been completed).

For information about the sidebar's display possibilities: 202558389.

Warning: 
The Mosaic Editor may be used to manually correct artifacts in the Orthomosaic resulting from Step 3. DSM and Orthomosaic and in order to improve its
visual aspect, but it may create another artifacts, since the generation of the orthomosaic with each method is different.
The Orthomosaic generated at step 3. DSM and Orthomosaic Generation uses the Weighted Average algorithm and the processing options
(Use Visibility, Use Color Balancing) selected for the step 3. DSM and Orthomosaic Generation (Process > Options... > DSM and Orthomosaic
Generation > Orthomosaic).
When opening the Mosaic Editor, a different orthomosaic is generated using the Multi-band Blending algorithm, without Color
Balancingand without Visibility. It is displayed for editing and temporarily saved into the .p4s file located in the view_mosaic_editor result folder.
The changes applied in the Mosaic Editor affect the .p4s file, not the mosaic itself resulting from Step 3. DSM and Orthomosaic Generation.
In order to obtain the edited mosaic, the mosaic needs to be blended: 202560289. The orthomosaic resulting from Step 3. DSM and Orthomosaic
Generation will then be overwritten. The new mosaic will use the Multi-band Blend algorithm and it may differ from the mosaic visible in the Mosaic Editor.
When using the Mosaic Editor for blending, the new Orthomosaic is generated using the Multi-band Blending algorithm (without Color Balancing
and without Visibility). The Blending Radius Factor value can be selected. For more information about the Blending Radius Factor: 202557829. 

For more information about the available orthomosaic options / algorithms: 202559429.

The Blend Mosaic tool consists of:

A tool that allows the user to set the Mosaic Area: This tool is displayed on the Toolbar  and is accessible through the menu Mosaic Editor > Tools > Blend

Mosaic. 
Tools to generate the edited mosaic: These tools are displayed on the Mosaic Blending sidebar.  

  

Tool that allows the user to set the Mosaic Area

This tool is displayed on the Toolbar and is accessible through the menu Mosaic Editor > Tools > Blend Mosaic. The Blend region is displayed on top of the
orthomosaic in the Mosaic View.

 Set Mosaic Area: Allows the user to define a region for which the mosaic will be generated.

 When the Set Mosaic Area tool is activated, a context menu is available by right clicking on the Mosaic View after inserting three vertices at least. The following
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actions are available:

 Insert Mosaic Area: Inserts the mosaic area.

 Undo: Removes the last vertex of the mosaic area.

 Cancel: Cancels the drawing of the mosaic area.

 

Tools to generate the edited mosaic

These tools are displayed on the Mosaic Blending Sidebar that appears on the right of the Main window. They allow the user to set parameters for the mosaic
blending. The Mosaic Blending Sidebar has two sections:

Parameters
Apply

 

Parameters

Resolution [cm/pixel]: This value can be modified before blending the new mosaic and indicates the spatial resolution of the orthomosaic.

Note: Increasing the resolution decreases the processing time but also decreases the mosaic spatial resolution.

Blending Radius Factor [0, 1]:  The value can be set between 0 (no blending) and 1 (maximal blending). By default the blending radius factor is set to 0.5.

Note: The higher the blending radius factor, the smoother the mosaic but the longer the processing.

Example: The following examples are computed with a blending radius factor of 0 and 1 respectively. With zero blending, one can see the
transitions between the individual images, while with a larger blending factor the mosaic mesh becomes less visible. Increasing the blending factor
increases the orthomosaic generation time.

 

Mosaic Size [pixels]: Indicates the total size of the orthomosaic in pixels (Horizontal size x Vertical size).
Number of Mosaic Tiles: Indicates the amount of tiles that will be created when blending the mosaic.

 

 Apply

Contains the action buttons:

Blend Mosaic: Generates a new mosaic using the displayed parameters and the selected blending region.
Help: Opens the Pix4Dmapper help.

 

For step by step instructions about how to set a new blending region and how to blend the mosaic: 202560289.

 

 

 

https://support.pix4d.com/hc/en-us/articles/202560289
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Access: On the Menu bar, click Mosaic Editor, select the menu option Tools and click DSM Color Map (available only if step 3. DSM and Orthomosaic
Generation has been completed).

For information about the sidebar's display possibilities: 202558389.

This DSM sidebar is displayed on the right of the Main window and allows the user to modify the visualization of the DSM which is displayed in the Mosaic View.

The DSM sidebar contains 3 sections:

Parameters
Color Map
Apply

 

Parameters

The Parameters section allows the user to change the values considered as minimum altitude, maximum altitude, and altitude with no data. The no data altitude
elevation is represented with a transparent pixel.

It has three options:

Minimum Altitude [m]: By default it displays the minimum altitude of the loaded DSM in meters. The value can be changed by selecting a value between -100 and
5000.
Maximum Altitude [m]: By default displays the maximum altitude of the loaded DSM in meters. The value can be changed by selecting a value between -100 and
8000.
No data Altitude [m]: By default displays the value -10000, which is the altitude value of the pixels that have no information (transparent pixels). This value should
not be edited, but must be between -10000 and 5000.

And the action button:

Reset to Defaults: Resets the values for minimum altitude, maximum altitude, and no data altitude to the default values.

 

https://support.pix4d.com/hc/en-us/articles/202558389


Color Map

The Color Map section has 2 different methods for assigning a color to each elevation value / pixel. 

It has 2 options:

Color:  Displays the elevation with RGB colors. By clicking on the Color drop-down list, the color can be set to Gray scale.
Shading: Applies shading to the DSM. By clicking on the Shading drop-down list, the shading can be turned off by selecting No shading.

This section also has a legend that displays what color corresponds to each altitude.

Figure 1. Color Map with Color and Shading



Figure 2. Color Map with Color and No shading



Figure 3. Color Map with Gray Scale and Shading



Figure 4. Color Map with Gray Scale and Non shading

 

Apply

Contains the action buttons:

Update: Colors the DSM using the selected parameters and color map.
Help: Opens the Pix4Dmapper help.
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Access:On the Menu bar, clickView > Index Calculator(available once step 1. Initial Processinghas been completed).Not available for Oblique projects.

Note:
The DSM is used to generate the Reflectance Maps.
AReflectance Map is generated for each group of images (RGB, NIR, etc), but onlyone DSM isgenerated, regardless of the number of groups.
The Reflectance Maps contain the reflectance values of each pixel which areused to obtain the Index Maps and Index Grids.
The Index Maps and Index Gridsare calculated for some specific band(s) from one or more groups of images. Therefore, information from one or more
Reflectance Maps may be used.
Colored Index Maps are generatedby applying thedefined coloring rules to the Index Maps. They are raster files with RGBvalues.
If a Colored Index Map already exists, creating a newColored Index Map will overwrite the existing one.
Classified Index Maps are generated for each Region by applying the class settings. They are shapefiles showing the classes accordingthe indices
values.
If a ClassifiedIndex Map already exists, creating a newClassified Index Map will overwrite the existing one.

Important:
For information about the files that are generated, under which action and where they are stored:202558739.
All the outputs will be stored in:...\project_name\4_index
For informationabout the project folder structure:202558649.

Warning:Once the Index Calculator has been used and results were produced, all the outputs from the Index Calculator will be DELETED if anyof the
following steps is started: Step 1. Initial Processing,Step 2. Point Cloud Densification,Reoptimize,Rematch and Optimize.

The existing results need to be saved or backed up by the user in order not to be overwritten.

The use of theIndex Calculatoris optional and it can be used to:

Generate an Index Map where the color of each pixel is computed using a formula that combines the different image bands.
Visualize the Index Map using a color mapping.
Provide information and values about the Reflectance Map(s)and Index Map bands.

By selecting theIndex Calculatorview the following elements are displayed on the Main window:

Menu bar entry: Extra entry displayed on the Menu bar.
Toolbar: The standard toolbar and some extra buttons.
Index View: Displayed in the Main window. When opening the Index Calculator for a project for the first time it appears blank. Once at least an Index has been
generated, it displays by default the last index that was displayed before the project was closed.
Index Calculator Sidebar: By default it is displayed on the right of the Index View.Displays information about the Reflectance Map(s), the Index Map, and provides
tools to generate and edit the Index Maps.
Status bar: Displayed on the bottom right of the Mosaic View.Displays thecoordinateswhen passing the mouse over the Reflectance Map/ Index Map.

For more information:

For step by step instructions about how to use the Index Calculator:202558729.

https://support.pix4d.com/hc/en-us/articles/202558739
https://support.pix4d.com/hc/en-us/articles/202558649
https://support.pix4d.com/hc/en-us/articles/202558729


Figure 1. Index Calculator

Menu bar entry

On the Menu bar, by clicking on Index Calculatorthe following option is displayed:

Show Color Scale: By default it is selected. View/hide the the color scale graphic of the Index Map (whose colors are based in the Colored Index Map
histogram)which is displayed on the top right of the Index View.
View All: Zoom out the display the full map in the Index View.

Note:For information about the files that are generated, under which action and where they are stored:202558739.

https://support.pix4d.com/hc/en-us/articles/202558739


Toolbar

The following Toolbar buttons are displayed:

Standard Toolbar: For more information:202557839.
Toolbar extra buttons:

Reflectance map: By default the reflectance map is displayed. Display the reflectance map by selecting the group or hide the map.

Show Index Map: By default, show index map option is checked. The option controls whether the index map generated will be displayed and overlaid on top of the
reflectance map.

Lock Regions: By default the Region is locked. After the regions are drawn:203937289, they will be displayed in the map window. If the Lock Regions option is
checked, the region frame will be locked in the position. Uncheck the Lock Regions option to enable the move or edit of previously drawn regions by dragging the
whole region or a certain vertex.

Index View

When opening the Index Calculator for a project for the first time it appears blank. Once at least an Index has been generated, it displays by default the last index
that was displayed before the project was closed.

Navigating on the Index View using the mouse:

Pan: Right/Left click and move the mouse (a hand icon appears representing the focus pointfor the movement).
Zoom in:Move the scroll wheel forward while positioning the mouse over the Index View.
Zoom out: Move the scroll wheel backwards while positioning the mouse over the Index View.

Index Calculator Sidebar

The side bar displays the information about the Reflectance Map(s) and the Index Map as well as provides tools to generate and edit the Index Maps.

For details about the Index Calculator Sidebar:202558249.

Status bar

On the bottom right part of the Index Calculator, if a Reflectance Map / Index Map was loaded in the Index View, the following information is displayed:

Value: Displays the pixel value of the Index under the current mouse location. When passing the mouse over the Index View, the value changes.
Selected Coordinate System : Displays the selected coordinate system of the point.
Position: Displays the (X,Y) coordinates in meters / feet of each point of the Reflectance Map / Index Map. When passing the mouse over the Reflectance Map/
Index Mapthe coordinates change.



Important:It is usedthe geographic (ellipsoid) projection coordinates in meters / feet, instead of geographic (ellipsoid) coordinates in degrees, considering
the output coordinate system selected.

By default the output coordinate system is the same as for the GCPs if GCPs are used, otherwise it is the same as for the images. If the coordinates
system is WGS84, the output is given in UTM.

If less than 3 images are geolocated and less than 3 GCPs are defined, then the output coordinates system is always Local.

Note:Displays the position for the whole area covered by the Reflectance Map / Index Map and the areas without data.

Index>Interface> Menu View Previous|Next
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Access: On the Menu bar, click View > Index Calculator (available once step 1. Initial Processing has been completed). Not available for Oblique
projects.

The Index Calculator Sidebar is displayed on the right of the Main window. For information about the sidebar's display possibilities: 202558389.

The Index Calculator Sidebar contains the following sections:

1. Reflectance Map: Used to:
Generate the DSM and Reflectance Map(s) used to generate and edit the indices. One DSM is generated for the whole project and one Reflectance Map is
generated per group of images (RGB, NIR, etc.).
Displays information about the Reflectance Map(s) bands and groups.
2. Regions: Used to:
Define specific areas that the index calculation will be applied to. 
3. Index Map: Used to:
Generate, view, edit indices or select the index to be displayed in the Index View.
Displays information about the selected index.
4. Classes: Used to:
Categorize the condition of the regions based on the indices values.
5. Export: Used to:
Displays information about the colors and ranges used to visualize an index. Allows the user to edit them. 
Save the selected index Map using the selected color mapping.

 

https://support.pix4d.com/hc/en-us/articles/202558389


Note: 
The DSM is used to generate the Reflectance Maps.
A Reflectance Map is generated for each group of images (RGB, NIR, etc), but only one DSM is generated, regardless of the number of groups.
The Reflectance Maps contain the reflectance values of each pixel which are used to obtain the Index Maps and Index Grids.
The Index Maps and Index Grids are calculated for some specific band(s) from one or more groups of images. Therefore, information from one or more
Reflectance Maps may be used.
Colored Index Maps are generated by applying the defined coloring rules to the Index Maps. They are raster files with RGB values.
If a Colored Index Map already exists, creating a new Colored Index Map will overwrite the existing one.
Classified Index Maps are generated for each Region by applying the class settings. They are shapefiles showing the classes according the indices
values.
If a Classified Index Map already exists, creating a new Classified Index Map will overwrite the existing one.



Important: 
For information about the files that are generated, under which action and where they are stored: 202558739.
All the outputs will be stored in: ...\project_name\4_index
For information about the project folder structure: 202558649.
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https://support.pix4d.com/hc/en-us/articles/202558649
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Access: On the Menu bar, click View > Index Calculator (available once step 1. Initial Processing has been completed). Not available for Oblique
projects. The Index Calculator Sidebar is displayed on the right of the Main window. For information about the sidebar's display possibilities: 202558389.

On the left part of section 1. Reflectance Map, there is an arrow that allows the user to show/hide the section by clicking on it:

 By default section 1. Reflectance Map is visible.
 Section 1. Reflectance Map is not visible.

The following information is displayed:

Resolution [cm]: By default the Resolution is 50.0 [cm/pixel].

It can be modified and it defines the resolution for the Reflectance Map(s) and the DSM (if not yet generated with step 3). 

Note: Changing the resolution has no influence on the resolution of step 3. DSM and Orthomosaic Generation.

Note: The Reflectance Map(s) generated in Index Calculator uses a combination of the Weighted Average and the Multi-band lending algorithms
(without Visibility). For more information about the available options / algorithms: 202559429.

Important: For more information about the generated files and where they are stored: 202558739.

The section 1. Reflectance Map also displays information for each band from each group of images from the generated Reflectance Map(s). The following
information is displayed:

Band: Name of the band. If more than one group exists and the same band name exists in different groups, the bands are displayed as "Groupname_band."
Min: Minimal pixel value for all the pixels.
Avg: Average pixel value for all the pixels.
Max: Maximal pixel value for all the pixels.
Stdev: Standard deviation of pixel value for all the pixels.
Var: Variance of pixel value for all the pixels.

If the Reflectance Map(s) are not generated, it displays: "Reflectance Map not yet generated."

Reflectance Map not generated Reflectance Map generated 

 

 

 

https://support.pix4d.com/hc/en-us/articles/202558389
https://support.pix4d.com/hc/en-us/articles/202559429
https://support.pix4d.com/hc/en-us/articles/202558739


Note: 
The DSM is used to generate the Reflectance Maps.
A Reflectance Map is generated for each group of images (RGB, NIR, etc), but only one DSM is generated, regardless of the number of groups.
The Reflectance Maps contain the reflectance values of each pixel which are used to obtain the Index Maps and Index Grids.
The Index Maps and Index Grids are calculated for some specific band(s) from one or more groups of images. Therefore, information from one or more
Reflectance Maps may be used.
Colored Index Maps are generated by applying the defined coloring rules to the Index Maps. They are raster files with RGB values.
If a Colored Index Map already exists, creating a new Colored Index Map will overwrite the existing one.
Classified Index Maps are generated for each Region by applying the class settings. They are shapefiles showing the classes according the indices
values.
If a Classified Index Map already exists, creating a new Classified Index Map will overwrite the existing one.
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Access: On the Menu bar, click View > Index Calculator (available once step 1. Initial Processing has been completed). Not available for Oblique
projects. The Index Calculator Sidebar is displayed on the right of the Main window. For information about the sidebar's display possibilities: 202558389.

On the left part of section 2. Regions, there is an arrow that allows the user to show/hide the section by clicking on it:

 By default section 2. Regions is expanded and visible.
 Section 2. Regions is collapsed and hidden.

When section 2. Regions is expanded, users see the following bar:

Whole map: Displayed by default if no regions were created. The full area is displayed and selected.
Draw: To draw a named region in the viewer.
Clear: To clear the selected region in the viewer.
Region List: To add a new region, to delete an existing region, or to edit the name of a region. 
Help: Opens the Pix4Dmapper help. 

Region List...
When the button Region List is clicked, the following pop-up appears:  

 

https://support.pix4d.com/hc/en-us/articles/202558389


Click Add to create a new region.

When a region is added, double-click on unnamed to edit the name of the region. 
Click OK once all the actions are done.



Now the Region List window is closed and users are back to the main interface.
Click on Draw to start drawing the polygon region in the viewer for the selected region name.

 

In the viewer content, left-click to place polygon vertices, and right-click to close the polygon. 

After the region is defined, users can see the area of the regions and the percentage each region occupies among all the regions in the Region List window. 



 

To clear an existing region, users first select the region from the list. 

Then click Clear to remove the previously defined polygon in the viewer.
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Access: On the Menu bar, click View > Index Calculator (available once step 1. Initial Processing has been completed). Not available for oblique
projects. The Index Calculator Sidebar is displayed on the right of the Main window. For information about the sidebar's display possibilities: 202558389.

On the left part of section 3. Index Map, there is an arrow that allows the user to show/hide the section by clicking on it:

 By default section 3. Index Map is visible. 
 Section 3. Index Map is not visible.

An Index Map is a single band image where each pixel value is computed using a mathematical formula combining the bands of the Reflectance Map(s). The
Index Map gives some information about the area captured.

The following information is displayed:

Name: List of available indices. By clicking on the selected index the list of available indices appears.

If the icon shows before the index name is:
 The index exists in the software index database. 

For more information about the Software Index Database List: 202558379.
 The index is created and defined by the user. 

Formula: Displays the formula associated with the selected index. 

Formula Status Icon: If next to the Formula there is:
 The formula is valid.

 The formula is incomplete or contains undefined band names.

 The formula has any syntax error.

Index Status Icon: If next to the Generate button there is
            The index has been generated.

Edit: Grayed out when the selected Index belongs to the database; Enabled when the selected Index was created by the user. 

Opens up the Formulas Editor which allows the user to edit the formula corresponds to the selected Index. 
For detailed information: 202558279.

Index List: Opens up the Index List window which displays the existing indices and allows the user to add, edit, or remove indices. For detailed
information: 202558299.

Grid Resolution [cm]: The default value is 100 [cm/pixel]. This value can be changed in the text box in Options > Index Calculator.

It allows to select the spacing for the Index Grid created when generating the Index Map.

Generate: Generates a single band GeoTiff image. Each pixel's value is computed by applying the formula to the corresponding pixel of the Reflectance Map(s). 

Important: For more information about the generated files and where they are stored: 202558739.

Grayed out if the user defined index formula changes and is not a valid formula.

The section 3. Index Map displays information about the generated Index band. The following information is displayed:

Band: Only one band is displayed: Index.
Min: Minimal pixel value for all the pixels of the Index.
Avg: Average pixel value for all the pixels of the Index.
Max: Maximal pixel value for all the pixels of the Index.
Stdev: Standard deviation of pixel value for all the pixels of the Index.
Var: Variance of pixel value for all the pixels of the Index.

If the selected index has not been generated, it displays: "Index not yet generated."

 

 

https://support.pix4d.com/hc/en-us/articles/202558389
https://support.pix4d.com/hc/en-us/articles/202558379
https://support.pix4d.com/hc/en-us/articles/202558739


 

Index Map not generated  Index Map generated

Note: 
The DSM is used to generate the Reflectance Maps.
A Reflectance Map is generated for each group of images (RGB, NIR, etc), but only one DSM is generated, regardless of the number of groups.
The Reflectance Maps contain the reflectance values of each pixel which are used to obtain the Index Maps and Index Grids.
The Index Maps and Index Grids are calculated for some specific band(s) from one or more groups of images. Therefore, information from one or more
Reflectance Maps may be used.
Colored Index Maps are generated by applying the defined coloring rules to the Index Maps. They are raster files with RGB values.
If a Colored Index Map already exists, creating a new Colored Index Map will overwrite the existing one.
Classified Index Maps are generated for each Region by applying the class settings. They are shapefiles showing the classes according the indices
values.
If a Classified Index Map already exists, creating a new Classified Index Map will overwrite the existing one.
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Access: On the Menu bar, click View > Index Calculator (available once step 1. Initial Processing has been completed). Not available for Oblique
projects. The Index Calculator Sidebar is displayed on the right of the Main window. On section 3. Index Map, click Edit to edit the selected
Index (available for user defined indices).

The Formula Editor pop-up is used to easily edit the formula associated to user defined Indices. The name of the index that is edited is displayed in the Window
title.

It contains 3 sections:

Reflectance Map Band Selection
Operations
Formula

And three action buttons:

OK: Confirms the changes. 
Cancel: Does not save the changes.
Help: Opens the Pix4Dmapper help.

Reflectance Map Band Selection

Displays information for each band from each group of images from the generated Reflectance Map(s).The following information is displayed:

Band: Name of the band . If more than one group exists and the same band name exists in different groups, the bands are displayed as "Groupname_band."
nm: Wavelength for the band in nano-meters.
Min: Minimal pixel value for all the pixels.
Avg: Average pixel value for all the pixels.
Max: Maximal pixel value for all the pixels.
Stdev: Standard deviation of pixel value for all the pixels.
Var: Variance of pixel value for all the pixels.

By clicking a band button, the band name will be automatically inserted in the Formula text box at the current cursor position.

 

Operations

Buttons that allow the user to automatically  insert mathematical operations in the Formula text box at the current cursor position.

The available operations are:

 



Symbol + - * / ^ ( )
Action addition subtraction multiplication division exponentiation open parenthesis close parenthesis

Symbol sqrt log sin cos tan asin acos atan
Action square root natural logarithm sine cosine tangent arcsine arcosine arctangent

 

Formula

 Text box to edit/write the Formula associated to the Index.

 Under the text box appears a message indicating the formula validation status:

Valid formula
Undefined "band_name" band
Incomplete formula
Syntax error

Important: The formulas expression is case sensitive: Distinguish Capital and non-capital letters.
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Access: On the Menu bar, click View > Index Calculator (available once step 1. Initial Processing has been completed). Not available for Oblique
projects.

The Index Calculator Sidebar is displayed on the right of the Main window. On section 3. Index Map, click Index List.

The Index List pop-up is used to:

View the List of Indices and their properties (generated/not generated, origin, Name, Formula).
Edit user defined Indices.
Duplicate Indices. In order to modify an Index from the software index database, it has to be duplicated. The copy will be a user defined Index and can be edited.
Add new user defined Indices.
Remove user defined Indices.
Select an Index.

The section Indices contains the Index table:

 



Status: The first column displays a green check  if the index has been generated and is empty if the index has not been generated. 

Name: Displays:
An icon that shows if:

  The index comes from the software index database. For more information about the Software Index Database List: 202558379.
 The index is an user defined index.

The index name. 
Formula: Displays:
An icon that shows:

If the formula is valid.

If the formula is incomplete or contains undefined band names

If the formula has any syntax error.

The Formula expression. 

And the buttons:

Edit: Enabled for user defined indices. Opens the Formula Editor pop-up allowing the user to edit the currently selected index formula.
Duplicate: Duplicates the selected index with the name: selectedIndex_copy. The duplicated index will be user defined even if it is duplicating an index from
the software index database.
Add: Creates a new user defined index. Opens the Formula Editor pop-up to enter the new formula. By default adds it with the name: unnamed. If the name
already exist an index with the name unnamed, will be created with the name: unnamed2.
Remove: Enabled for user defined indices. Deletes the selected index.

Important: 
User defined indices created for a project will be available for other projects on the same computer. 
When editing a user defined index created with a previous project, the changes will affect previous projects when they are opened again.

Available actions on the table:

Select an Index: By clicking in a cell, the row will be selected and depending on the type of index (from the software database or user defined) some buttons will
be available or grayed out (see above for more information).
Edit Index name: Available only for user defined indices. Double click on a user defined index name and edit it.
Edit Formula: Available only for user defined indices. Double click on a user defined Formula expression and edit it.

Important: The formulas expression is case sensitive: Distinguish Capital and non-capital letters.

The Image List pop-up has as well the following action buttons:

OK: Closes the Index List and the marked index is selected in the Index Name list of the 3. Index Map section of the Index Calculator Sidebar. 
Cancel: Closes the Index List without selecting an index.
Help: Opens the Pix4Dmapper Help.
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https://support.pix4d.com/hc/en-us/articles/202558379
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Access: On the Menu bar, click View > Index Calculator (available once step 1. Initial Processing has been completed). Not available for Oblique
projects. The Index Calculator Sidebar is displayed on the right of the Main window. For information about the sidebar's display possibilities: 202558389.

On the left part of section 4. Classes, there is an arrow that allows the user to show/hide the section by clicking on it:

 By default section 4. Classes is expanded and visible.
 Section 4. Classes is collapsed and hidden.

When section 4. Classes is expanded, users can see the following:

Number of Classes
Enter the desired number of classes. 

Equal Area or Equal Spacing
Choose how the classes will be split based on the index values.

 

https://support.pix4d.com/hc/en-us/articles/202558389


Use Min/Max
Enter the minimum and maximum index values to ignore the values outside this range. By default it is unchecked and the values are the min/max values from the
calculated results.

Rate
Enter the application rate for each class of crops. This rate value should be filled after the on-site scouting is done.

Description
Annotates for each class. These descriptions can be served as notes from the on-site scouting.

Help
Click to go to the related article on Pix4D support website.
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Access:On the Menu bar, click View > Index Calculator(available once step 1. Initial Processinghas been completed).Not available for Oblique
projects.The Index Calculator Sidebaris displayed on the right of the Main window.For information about the sidebar's display possibilities:202558389.

On the left part of section5. Export, there is an arrow that allows the user to show/hide the section by clicking on it:

By default the5. Exportis expanded and visible.
Section5. Exportis collapse and hidden.

When section 5. Export is expanded, the users can see the following:

Classes with Resolution [cm/pixel]

Exports the classes as a .shp file. By default, the resolution is 400 [cm/pixel]. This can be changed in the menu bar, by clicking Process > Options...selecting
the tab Index Calculator, in the section Indices.

One shapefile will be exported for each Region. This file can be imported directly into the tractor displays for later-on field (fertilizer) application.

https://support.pix4d.com/hc/en-us/articles/202558389


Colored Index
This map is generated tovisualize the index values per classes. Each class is colored with the default color panels.

Index>Interface> Menu View>Index Calculator> Index Calculator Sidebar Previous|Next
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Access: On the Menu bar, click Help.

The Help menu has 5 items that can be selected:

Help Contents: Opens Pix4Dmapper help.
Online Support: Opens the Online support site in an Internet window.
Personal Support: Opens the Online form to submit a request to the Support Team in an Internet window.
Settings...: Opens the Settings window that gives the user access to the proxy and camera database settings.
About...: Provides information about the version, license, Terms of service and Privacy policy.

 

Help Contents

The Pix4Dmapper help provides full and detailed information about how to create your projects (with step by step instructions), a complete manual with the
different Pix4Dmapper options and features, and extra articles that are recommended to read and consult in order to fulfill some specific actions on the software.

Online Support

You want to find out about the best practices for UAV mapping and are looking for useful tips and tricks? Our extensive Knowledge base contains numerous
articles with step by step instructions and answers to frequently asked questions as well as news, updates, screencasts, tutorials, and showcases.

Personal Support

Our dedicated support team will help you achieve the best results with personalized advice, tips, and tricks. We believe that supporting you in all stages of your
project, from pre-sales to post-processing, is the best possible way to build a lasting relationship beneficial to both parties.

Contact our dedicated support team for personal support.

 





Important: If you are not logged in, the following page appears:

Type your Userrname and Password and click Log In.

 

Settings...

This option opens the Settings pop-up that gives the user access to the proxy and camera database settings. It has 4 Tabs:

Proxy
Camera database 
Language
Help Improving the Software

Proxy

 



This tab allows the user to set up the internet connection.

The first drop down list allows the user to select how to connect to the proxy:

No Proxy (default): If no proxy server is used.
Use systems settings: Uses the settings of Internet Explorer.
Socks5
Http

The following fields are displayed:

Host: Proxy host name.
Port: Proxy port number.
Username: Proxy user name.
Password: Proxy password.

There are 3 action buttons:

OK: Confirm the changes.
Cancel: Do not save the changes.
Help: Open the Pix4Dmapper help.

In order to enter the proxy settings: 202560089.

Camera database

https://support.pix4d.com/hc/en-us/articles/202560089


This tab allows the user to clear the user camera model database or to import/export it from/to a file. It also displays the Built-in database used.

The camera database tab has 2 sections:

User database: This section has the following action buttons:
Clear: Clears the user camera model database (cameras added or modified by the user).
Import...: Loads a camera database file *.xml with cameras added or modified by the user.
Export...: Exports cameras added or modified by the user to a camera database file *.xml.
Built-in database: Displays the date and the version of the last built-in camera database update.

There are 3 action buttons:

OK: Confirms the changes.
Cancel: Does not save the changes.
Help: Opens the Pix4Dmapper help.

Language
 

Help Improving the Software



 

 

About...

It provides information about the version, license type, license key, license account, Terms of Use and Privacy Policy:

License Type
License Key
License Account: Pix4D user account to which the license is bound.
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http://pix4d.com/terms_use/
http://pix4d.com/privacy/
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The Pix4D Software License is a floating license which allows the user:

Be logged in 2 computers (devices) at the same time. 
Have installed Pix4Dmapper in more than 2 computers.

It is intended to have it installed in:

A desktop machine: Where it can be used for Full processing.
A laptop: Where it can be used for Rapid check while being still in the field.

The license has no limitations in both machines. All features, tools, processing steps can be used by both machines.

For more information about how to download and install the software: 202557299. 

With the floating license it is possible to log out the license on one computer in order to log in on another. It is not needed to uninstall Pix4Dmapper:

In order to Log Out a license on a computer (steps 1 to 4): 202559999.
In order to Log In  the floating license to another computer: 202557299.

 

Index  Previous  |  Next  

https://support.pix4d.com/hc/en-us/articles/202559999
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The following shortcuts are available:

General shortcuts
GCP/Manual Tie Point Manager shortcuts
rayCloud shortcuts
Mosaic Editor shortcuts
 

General shortcuts

Category Action Shortcut Note
Pix4Dmapper Help Open the Pix4Dmapper help F1  
    
Project    New project Ctrl + N  

Open project Ctrl + 0  
Save project Ctrl + S Does not save the changes done in the Mosaic Editor
Save project as Ctrl + Shift + S  
Exit Ctrl + Q  

 

GCP/Manual Tie Point Manager shortcuts

Category Action Shortcut Note
GCP Editor > Preview Remove marked GCP in currently displayed image Del The mouse needs to be over the image

  

rayCloud shortcuts

Category Action Shortcut Note
Layers Sidebar > Tie Points Rename point F2 A point needs to be selected

Remove point Del A point needs to be selected
    
Layers Sidebar > Processing Areas Remove area Del An area needs to be selected
    
Layers Sidebar > Objects Rename object F2 An object needs to be selected

Remove object Del An object needs to be selected
    
3D View > Viewpoints       View All C  

Focus on Selection F An element (point, camera) needs to be selected 
Top 7  
Front 1  
Back Ctrl + 1  
Left 3  
Right Ctrl + 3  
Home 0  

    
3D View > Perspective/Orthographic Switch between perspective and orthographic projection 5  
    
3D View navigation                 Zoom in +  

Zoom in faster Ctrl + "+"  
Zoom out -  
Zoom out faster Ctrl + "-"  
Move forward parallel to the ground plane arrow up  
Move forward parallel to the ground plane faster Ctrl + arrow up  
Move backward parallel to the ground plane arrow down  
Move backward parallel to the ground plane faster Ctrl + arrow down  
Tilt view up Page Up

or 

8

The mouse needs to be over the 3D View

Tilt view up faster Ctrl + Page Up

or 

Ctrl + 8

The mouse needs to be over the 3D View

Tilt view down Page Dn

or

2

The mouse needs to be over the 3D View



Tilt view down faster Ctrl + Page Dn

or 

Ctrl + 2

The mouse needs to be over the 3D View

Rotate the view to the left 4 The mouse needs to be over the 3D View
Rotate the view to the left faster Ctrl + 4 The mouse needs to be over the 3D View
Rotate the view to the right 6 The mouse needs to be over the 3D View
Rotate the view to the right faster Ctrl + 6 The mouse needs to be over the 3D View
Move the view up Home the mouse needs to be over the 3D View
Move the view down End The mouse needs to be over the 3D View

    
Image View Sidebar > Images Focus on selection p  The image needs to be selected

 

Mosaic Editor shortcuts

Category Action ShortcutNote
Image List Show Image List Ctrl +

Shift + I 
 

    
Mosaic    Load Mosaic Ctrl +

Shift + O
 

Clear Mosaic Ctrl +
Shift +
C 

 

Save Mosaic Ctrl + Alt
+ Shift +
S

 

Close Mosaic Editor Ctrl + Alt
+ Shift +
X

 

    
View    Orthoimage View Ctrl + 1 If several mosaics are generated because of multiple image labels, the shortcut number is

incremented by the number of mosaics - 1. For example, if two mosaics are generated, the
orthoimage view shortcut for the second mosaic is Ctrl + 2

Elevation View Ctrl + 2 If several mosaics are generated because of multiple image labels, the shortcut number is
incremented by the number of mosaics - 1. For example, if two mosaics are generated, the
elevation view shortcut is Ctrl + 3

Show Seamlines Ctrl + 3 If several mosaics are generated because of multiple image labels, the shortcut number is
incremented by the number of mosaics - 1. For example, if two mosaics are generated, the
elevation view shortcut is Ctrl + 4

Show Blend Region Ctrl + 4 If several mosaics are generated because of multiple image labels, the shortcut number is
incremented by the number of mosaics - 1. For example, if two mosaics are generated, the
elevation view shortcut is Ctrl + 5

Show Blend Tiles Ctrl + 5 If several mosaics are generated because of multiple image labels, the shortcut number is
incremented by the number of mosaics - 1. For example, if two mosaics are generated, the
elevation view shortcut is Ctrl + 6

    
Tools    Open the Mosaic Tools Sidebar that

allows the user to reset the mosaic
mesh

1  

Open the Mosaic Tools Sidebar that
allows the use to edit the mosaic

2  

Merge the selected Cells M  
Open the Mosaic Tools Sidebar that
allows the user to blend the mosaic

3  

Open the Mosaic Tools Sidebar that
allows the user to change the DSM
color map

4  

    
Cell's
tools    

Display the previous available image in
the image list that corresponds to the
selected projection

Page Up The cell needs to be selected

Display the next available image in the
image list that corresponds to the
selected projection

Page
Down

The cell needs to be selected

Display the currently selected image in
ortho projection

O The cell needs to be selected

Display the currently selected image in
planar projection

P The cell needs to be selected

Disable the selected image Del The cell needs to be selected
    
Cell's
vertices
tools

Remove selected vertices Del The vertices need to be selected

    



Insert Cell  Insert a new cell after having added the
last vertex.

Ins The insert Cell mode needs to be activated and the vertices need to be created / marked

Remove the last inserted vertex while
drawing the new cell

Ctrl + Z The Insert cell mode needs to be activated and at least one vertex needs to be created / marked

Cancel cell insertion Esc The Insert cell mode needs to be activated and at least one vertex needs to be created / marked
    
Insert
Vertices  

Insert new vertices on cell's edges Ins The Insert Vertices mode needs to be activated and the vertex needs to be created / marked
Remove the last inserted vertex Ctrl + Z The Insert Vertices mode needs to be activated and the vertex needs to be created / marked
Cancel vertices insertion Esc The Insert Vertices mode needs to be activated and at least one vertex needs to be created /

marked
    
Split Cell  Split the cell using the drawn path Ins The Split Cell mode needs to be activated and the path needs to be created / marked

Remove the last inserted vertex while
drawing the path to split a cell

Ctrl + Z The Split Cell mode needs to be activated and a vertex needs to be created / marked

Cancel cell splitting Esc The Split Cell mode needs to be activated and at least one vertex needs to be created / marked
    
Multiple cell
editing   

Merge Cells M Multiple cells need to be selected by pressing the Ctrl key while selecting the cells 
Assign images using Ortho Projection O Multiple cells need to be selected by pressing the Ctrl key while selecting the cells 
Assign images using Planar Projection P Multiple cells need to be selected by pressing the Ctrl key while selecting the cells 
Disable Selected Images Del Multiple cells need to be selected by pressing the Ctrl key while selecting the cells 
Select all cells Ctrl + A  

    
Setting the
Blending
Region  

Insert the drawn blending region Ins The Set Blending Region mode needs to be activated and the blending area to be created / marked
Remove the last vertex while drawing
the blending region

Ctrl + Z The Set Blending Region mode needs to be activated and at least one vertex of the blending area to
be created / marked

Cancel the drawing of the blending
region

Esc The Set Blending Region mode needs to be activated and at least one vertex of the blending area to
be created / marked
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